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a:
The usual drive identifiation for a floppy disk drive.    See also drive identification.



About box
A dialog box that provides version and copyright information about CompuServe 3.



abstract
See file abstract.



access
To start up a service or software program, or to reach a menu or file.



Address Book
Storage area on your computer where you can keep names, addresses, and other important information 
about your regular Internet and CSi Mail correspondents.



ALT key
The key labelled ALT on the IBM PC and many compatible computers.    In terminal emulation, this key is 
combined with others to transmit ALT commands.



ALT key command
The combination of the ALT key and another key to transmit an instruction to your computer.        



Alternate connection settings
The set of connection settings that you designate to be used in the event that you are unable to connect 
to CSi using the Current connection settings.    You can designate only one Alternate set per Current set.



baud rate
Signals transmitted per second over a communications link. In Connection Settings, you can select any 
baud rate your modem supports.



binary
Files stored in binary format, such as executable files, word processor files, spreadsheet files, and so 
forth.



browse
To explore the hierarchy of CSi services, peruse the hierarchy of messages and library files in a Forum 
area, or scan news stories in the Executive News Service.



browser
Software tool for reading hypertext documents on the Internet World Wide Web.    See also hypertext and 
World Wide Web.



bulletin
Late-breaking news concerning a Forum service and community.



button
See command button.



c:
The usual drive identifiation for a hard disk drive.    See also drive identification.



choose
To activate a command on a menu.    For example, you might choose a command to make a menu, 
window, or dialog box appear, and then select among the options offered.    See also select.



click
To select an icon, a button, a list item, or some other object on your screen by depressing and then 
immediately releasing the button on the left side of your mouse while the mouse pointer is situated on the 
object.    See also click-and-hold and double-click.



click-and-hold
To select a screen object by depressing the left button on your mouse while the mouse pointer is situated 
at the object and then keep the button depressed while you move (or otherwise act upon) the object.    
See also click and double-click.



command
A choice on a pull-down menu or an instruction you enter while in terminal emulation.



command button
A rectangular button in a dialog that initiates the indicated action, such as the OK button, the Cancel 
button, and the Help button.



common directory
The directory (we suggest C:\CSERVE) that contains files for use by all CompuServe communications 
software so that such programs can access the same Address Book, Filing Cabinet, connection settings, 
and so on.



communications network
The combinations of lines, satellites, and machines that enable computers to exchange information.



\CSERVE, C:\CSERVE
The directory or folder suggested by CompuServe for installation of CompuServe software.    If you install 
CompuServe 3 in C:\CSERVE, you can easily install other CompuServe communications software in C:\
CSERVE as well and thus use the same Address Book, Filing Cabinet, connection settings, and so on.



CompuServe Directory
A guide to Forum areas and other services on CSi.    Access the directory from the Help menu and search 
for services by description or name.



CSi Mail
Electronic mail system for CSi members. CSi Mail permits message exchange between CSi members 
and members of many other electronic mail services, such as Deutsche Bundespost and Internet.



CompuServe Ribbon.
The row of colorful buttons that appear at the top of your screen.    Most buttons represent menu 
commands, such as the Go and Address Book commands.    See also menu bar and Toolbar.



connect time
The amount of time you are connected to CSi.



Control key command
The combination of the Control key plus a letter key.    These keys are sometimes used to control the flow 
of    text in some terminal emulation services.



Conference Center
See Electronic Conference Center.



CUSIP number
A unique, standardized identification number assigned to a security issue or company.



conference
A ‘live' electronic conversation that you can participate in or observe, including casual chats, scheduled 
meetings, and guest lectures.



conference room
Where a Forum conference takes place.    Each Forum area has several conference rooms.



contribute
To copy a file from disk storage on your computer to a Forum library on CSi (upload).



database
Online repository of information.    You can search databases such as Business Database Plus and 
Computer Database Plus to scan abstracts, read the full text of published materials, and download 
documents.



decompress
To expand an archive file created by a compression utility program, such as PKZIP or Stuffit.



default
Option that is set (or enabled) for you automatically.    Defaults streamline your activities because the 
computer uses what is already pre-set.    You can always change a default, though.



desktop
Onscreen area that organizes and arranges materials according to a distinctive look and feel.    For 
example, Forum areas, Chat rooms, and the News desk are distinctive desktops with their own special 
resources.



device driver, driver
A program that provides the means for controlling a device, such as a printer or a disk drive, that is 
attached to a computer.



dial PPP
See PPP.



dialing prefix
The series of modem commands that precede a telephone number to be dialed.    One common sequence
is ATDT, where AT (attention) prepares the modem to take some action, D (dial) indicates what action, 
and T (tone) defines which of several ways the action is to be taken.



dialing postfix
The modem command following a telephone number to be dialed, indicating that the number is complete. 
One common dialing postfix is ^M, which is the modem equivalent of a carriage return.



dialog, dialog box
Window on your screen where you supply specific instructions.    You might do this by typing information in
a text box, clicking a checkbox, and so forth.



direction keys
Keys (on your keyboard) with arrows on them.    They allow you to scroll up and down or left and right 
within a dialog.    See also scroll.



directory
A subdivision of disk files, usually by type and/or topic.    Your hard drive has a directory, called the root 
directory, which provides pointers to all the disk's files.    You can create additional directories, which are 
subdirectories to the root directory.    Directories can also be referred to as folders in some systems.



Disconnect
A command that disengages the communications link betwen you and CSi, yet leaves CompuServe 3 
running.    See also Leave and log off.



display
To transmit text or other graphic representations to your computer's screen.



double-click
To select a list item or other “object” on the screen by quickly pressing and releasing the left button on 
your mouse twice in succession while the mouse pointer is situated on the screen object.    Double-
clicking typically selects both the object and a default action.    See also click and click-and-hold.



download
See retrieve.



drag-and-drop
To copy or move a list item or other screen object from one window (or other region on your screen) to 
another by pressing the left button on your mouse while the mouse pointer is situated at the object, and 
then holding the button down while you move the mouse, finally releasing the button when the object is in 
its new location.



drive identification
The designation for a disk drive, typically a letter.    This identification tells your disk operating system 
which drive to access.



Electronic Conference Center
An online area where you can learn about and attend conferences, often involving invited guests and 
celebrities.



ENS
See Executive News Service



enter
To transmit instructions or information by typing them and pressing the return key.    In terminal emulation, 
you enter information in response to prompts.



execute
To perform a command or a program.



Executive News Service
A comprehensive collection of various news wires, reporting up-to-the-minute news, sports, and financial 
information.    ENS includes a powerful story search feature, which intercepts stories about designated 
subjects and clips or keeps them for you in up to three personal electronic folders.



Exit
The command on the File menu that terminates your CompuServe 3 session.    If you are connected to 
CSi when you choose Exit, you will be disconnected automatically.



extension
See file extension.



extract
See decompress.



FAQ
Internet acronym for frequently asked questions.    Lists of FAQs and answers are provided in each of 
CSi's Internet services.



file
A collection of related information.    A file may contain a set of records, lines of text, or program 
instructions.



file abstract
A summary of a file in a Forum library containing information such as description and size.



file extension
Part of a file identification, often used to indicate what kind of data a file contains.    When present, the 
extension can be any combination of up to three letters and digits, and it must be separated from the file 
name by a period (.).



file name
Required portion of a file identification.    The name of a file in a Forum library on CSi can be up to six 
characters long.    The first character must be a letter, and the remainder can be any combination of 
letters, numbers and hyphens (-).    Also used to refer collectively to the complete file identification for a 
file if a file extension is used.



File Transfer Protocol (FTP)
Software tool for transferring files between computers on the Internet.    You can use FTP to retrieve a file 
from a remote host computer.



Filing Cabinet
Storage area on your computer that you use to store and organize messages and other documents that 
you retrieve from CSi.



Forum area
A special interest group for CSi members.    Hundreds of Forum areas exist on CSi.    Forums have 
message boards, data libraries, and conference rooms where special seminars and meetings take place.



Friends List
This is your record of names and CSi Mail addresses of your Chat and Forum friends.



FTP
See File Transfer Protocol.



full text
Whole and uncut document.    Several databases offer access to full-text articles that you can read or 
retrieve (download) to your computer.



full-text search
A database search that finds any article containing a designated keyword.    See also keyword.



graphical menu
Expanded version of a CSi list menu that includes graphic images and buttons you can click to access 
related areas.



host computer
Any mainframe computer to which your computer must be connected in order to access host-based 
services.



hypertext
Method of presenting information where certain terms are linked to other documents.    Selecting one of 
these terms displays the linked document, which may be text, graphics, or almost any kind of information 
related to the term.    See also browser and World Wide Web.



icon
A graphical representation of a service or command.



initialize
To begin operating a program.    On your computer, initialization procedures may include copying 
necessary files to your hard drive and then proceeding to the appropriate subdirectory.



Internet
A collection of millions of computers on many public and private networks, which function as a single 
global network.



invite
To ask one or more people to join a private group conversation in a Chat room or a Forum Conference 
room.



JPEG
Joint Photographic Experts Group.    Standards group that defined a file format and image compression 
format called JPEG.    This format is widely used on CSi.    It uses a 24 bit lossy compression algorithm 
that actually removes some of the graphic information upon compression.    A significant amount of 
information can be removed without a noticeable loss in image quality.    This compression is based on the
premise that the human eye cannot detect this lost information.



library
A Forum area's reference section, ideal for long-term storage of lengthy, structured documents or 
software programs contributed by Forum members for Forum members.



lobby
The initial entrance to a Chat or Forum area.



local
Relating only to your computer, to distinguish it from another computer that you are communicating with.   



log off
To disconnect from CSi.



log on
To connect to CSi.



keyword
A portion of a word, a whole word, or a phrase that guides your search through a database, a Forum 
library, or the Executive News Service.    All available topics and files are selected based on the spelling of
keywords, regardless of their case.



Leave
The command that terminates a CSi service without disconnecting from CSi.    See also Disconnect.



log file
A file where you record your dialogue with CSi in a terminal emulation service.    Also, a file that records 
the ongoing conversation in a Conference room, Chat room, or conference in the Conference Center.



Mail
See CSi Mail.



mailing list
You can combine one or more of your Address Book entries into categories called mailing lists.    Then you
can cause a message to be sent to all members of a mailing list by simply addressing the message to that
name.



map
See message map.



mark
To select an item in a list for a later action.    For example, while browsing in a Forum library, you can mark
files that interest you and retrieve them later.    A marked item is sometimes denoted by an icon placed 
beside the item when marked.    In your CompuServe 3 software, the Retrieve Later button is used to 
mark items for later retrieval.



menu bar
Horizontal bar at the top of the screen showing the major groups of functions offered by CompuServe 3.    
See also CompuServe Ribbon.



message
Online version of a letter.    You can exchange messages with Forum members, CSi members, and 
subscribers to many electronic mail services.    You can print your messages, read them online, or retrieve
them to the Filing Cabinet.    See also CSi Mail.



message board  
The place where Forum messages are posted.



message map.
A diagram of the relationships among messages in a Forum topic.    In a Forum area, one message often 
inspires several responses, and the conversation continues from there, forming a message thread.    A 
message map tracks who started the conversation and who picked it up afterward.



message number
Each forum message has a unique number assigned to it which identifies it from all other messages.



modem
A device that converts the digital information produced by a computer into analog form for transmission 
over a communications link, and converts the analog information received from a communications link 
into digital form for processing by a computer.



modem failure pattern
The message sent to your computer by your modem when it is unable to extablish a connection with a 
remote computer system.



modem success pattern
The messaage sent to your computer by your modem when it has established a connection with a remote
computer system.



monitor
A video display unit attached to your computer, so named because it provides a means for you to observe
(monitor) the information you exchange with the computer processor.



multiplayer games
Online games that can be played simultaneously by different people in different places.



navigation
Moving around CSi.    You can use any combination of menus and commands to navigate on CSi.    See 
also navigation commands.



navigation commands
The commands you can use to navigate, or move about, on CSi.



network
An interconnected set of computers that can communicate with each other.    It is best to consider the 
network as a separate entity that lies between your computer and a remote computer system.
See communications network.



news clipping folder
Temporary clipping folder that automatically collects timely stories about major events and issues.



Newsgroups
See USENET Newsgroups.



nickname
A name that identifies you in a Chat room or a Forum area.    You can change your nickname anytime.



notice
Bulletin for Forum members from a Forum administrator (Sysop).    Also referred to as an announcement 
or news flash.



observe
To listen to the conversation in a Chat room or Forum conference room without anyone knowing you are 
there.    This may be done while you are participating in another conversation.



offline
Not connected to CSi.



online
Connected to CSi through a communications network.    Also used to refer to areas that reside on CSi 
(and not on your computer), such as your CSi mailbox.



operating system
The organized collection of programs and data that controls the operation of the computer, such as 
Windows.    The operating system provides the link between you (or the programs you install) and the 
computer's hardware.



option button
Small, round button in a dialog box that allows you to designate specific preferences. Option buttons in a 
group are mutually exclusive.



password
Personalized secret code word required to log on (connect) to CSi. You can change your password as 
often as you'd like. Never tell anyone your password



path
The logical location of a file in your computer's disk storage.    Every file is actually part of a directory, 
which may in turn be part of another directory, and so on up to the root directory, which is the top directory
for a disk.



path specification
The disk and/or directory designation(s) that may be required to completely identify a file.    Also known as
the pathname.



Favorite Places
An area where you keep track of the services you access most frequently; you can add or delete services 
at will.    When you select a service from your Favorite Places, you go directly to that service.



Personal Address
A CSi Mail address that you can use instead of your member ID number.    A good Personal Address, such
as some variation of your name, should be easy for people to remember when they want to send you 
messages.    A Personal Address can have from two to 32 characters, including letters, numbers, and 
underscore characters (_), but no spaces or any other special characters.    At least one character must 
be a letter, and no character can be repeated more tan four times in succession.



PowerSearch
Advanced tool for searching Ziff databases, which enables you to choose a search method and provide 
search terms to streamline your search.    See also QuickSearch.



preferences
Options that enable you to customize various aspects of your CompuServe 3 software.



press
To depress one or more keys simultaneously.    You can initiate some actions by pressing the Alt key or 
Control key and another key at the same time.    See also type.



private group
A group in a Forum conference room or Chat room that consists only of those members invited to 
participate.



profile
A file containing information on each Chat member, usually including their nickname and general 
interests.    You decide whether you wish to establish a profile for yourself.



prompt
Request for specific instructions or information.    A prompt often requires you to enter a response in order 
to continue.    Terminal emulation uses prompts to operate.    See also terminal emulation.



protocol
Set of rules governing computer-to-computer communication.



query
Sometimes used to refer to a search term or combination of terms that you use to search for particular 
items.      



QuickSearch
Search tool available in several CSi services where you can provide search terms to streamline your 
search.    See also PowerSearch.



random-access memory (RAM)
The main memory of a computer system, which holds both the operating system and any currently loaded
application programs.    RAM is so called because stored information is accessed at random, which 
means that the computer takes the same amount of time to reach any one information unit (on average), 
regardless of the order in which the units are stored.



retries or redial attempts
Number of times your modem will try to connect to CSi if your first try isn't successful.



retrieve
To copy a file from a Forum library on CSi to disk storage on your computer (download).



return key
Carriage return key.    This key is sometimes actually called the Enter key or return key on your keyboard.



ribbon
See CompuServe Ribbon.



right-click
To point to an item with your mouse and then click the button on the right.    Right-clicking is an easy way 
to review available actions in certain windows, such as editing options when composing or editing a Mail 
or Forum message.



root directory
The main or top-level directory for a disk.    The root directory can list files and/or other subordinate-level 
directories.    These directories may in turn list any combination of files and their own subdirectories.



screen
The surface of any display device.    Also, a collection of output data organized for presentation at one 
time on such a device.



scroll
To move horizontally or vertically through a list, article, or other text document.    See also direction keys.



section
An area of a message board in a Forum area.    Also an individual library in a Forum area.    Each forum 
has several sections, each of which focuses on some more specific aspect of the Forum area's overall 
area of interest.



select
To pick one or more items from a list.    See also choose.



session
The whole sequence of activities performed when you use CSi -- from logging on to CSi through logging 
off.    Also, the general term for the whole sequence of activities from starting the CompuServe 3 software 
to exiting it or from accessing an individual CSi service to leaving it.



shift-click
To point your mouse at an item, and hold down the Shift key while you click the left mouse button.



Special Events
A free service that reports current and upcoming special offers, promotions, or opportunities available on 
CSi.



status line
The line that appears at the bottom of your screen while you are using CompuServe 3.    It displays 
various types of information.



stop bit
A bit that marks the end of each character (byte) transmitted.



subdirectory
Any directory subordinate to (listed by directory name in) the root directory, in any such subordinate 
directory, and so forth.



sysop
System operator, a forum member who is in charge of the forum and can answer questions about the 
Forum and resolve most problems you encounter.



TCP/IP
Transmission Control Protocol/Internet Protocol is the standard Internet protocol that enables computers 
of different kinds to communicate.



telnet
Software tool that enables you to log on to remote computers on the Internet.    With telnet, you can 
access public files and datebases and run applications on remote computers.    You can also access CSi 
from any Internet host.



terminal
Any device that enables you to interact with a remote computer system.    So named because it is usually 
at the terminus or end of a communications network.



Terminal Emulation
The mode in which your computer emulates a terminal. Some services require that you use them in 
terminal emulation, where you navigate with textual commands instead of windows.



terminal log
See log file.



text
The contents of a message or a readable file.



thread
A group of Forum messages with a common subject and a common genealogy. Also called a topic.



ticker file
General term for a file containing multiple ticker symbols and/or CUSIP numbers.    You might want to 
create a ticker file in your financial file area to use as an efficient means to generate financial reports on 
multiple issues.



topic
A group of Forum messages with a common subject and a common genealogy; a thread of connected 
messages.    Also the subject of such a group or thread.



type
To depress a series of keys in succession.    See also press.



unstuff
See decompress.



upload
See contribute.



USENET Newsgroups
Internet bulletin-board system where messages are grouped hierarchically under topic headings.



Member ID
CSi account identification number. Your Member ID number is your electronic mailing address and is 
listed beside your name in the Member Directory.    76846,731 is an example of a Member ID.



view
To read a document or display a graphics file.



What's New
An online service that provides the latest news and information about topics of interest to CSi members.    
What's New also provides access to a searchable archive of What's New articles.



World Wide Web
Hypertext-based tool for browsing the Internet. Using a Web browser, you can move around the Internet 
via hypertext links.    See also hypertext and browser.



Address type
The type of address you're sending mail to, for example, CompuServe, AOL, Internet, FAX machine.



Mailbox
A special area on CSi where your mail is collected until you retrieve (download) it to your computer.



Recipient list
The list of the people to whom a mail message is addressed.    Each person who will receive a copy of 
your message is called a recipient.



Address format
The order in which you enter a recipient's addressing information. To send Internet mail, the address 
format is the address type, colon, name, “at” sign, domain name and extension. For example, 
internet:jdoe@compuserve.com. 



Information service
A provider of information about one or more areas of interest.    When we refer to an information service, 
we usually mean an online information service. CSi is the world's most comprehensive online information 
service, with more than 3000 areas of interest including business, education and entertainment 
information services and products.



LAN
Acronym for Local Area Network, or two or more computers networked together by cables, satellite or 
phone lines.



menu
In a general sense, a list or row of choices, options or commands.    More specifically, one of several 
words displayed in a row just below the title in the upper left-hand corner of the CompuServe window.    
You click such words to view a list of related actions (commands).    You then click a command to initiate 
its function.    File and Edit are examples of menus.



Notebook
A small computer that can be easily carried around, also called a laptop computer.



Connected
To be connected means that your computer has established contact with one or more other computers, 
enabling you to share mail and files.



Port
The connectors on the back of your computer where you connect devices such as the mouse, keyboard, 
printer and modem.



Invitation
If someone else on CSi wants to chat with you, they issue an invitation. You can accept or decline an 
invitation.



Toolbar
The row of pictures or icons at the top of a window that let you perform various actions, Toolbars usually 
duplicate commands found in the menus, but can be quicker to use.



Folder
An electronic folder, like a physical one, is a place you create to store information.    Used in the Filing 
Cabinet and many news services.    Also refers to a directory on some systems.



Checkbox
Checkboxes control individual choices that are either turned on or off. When the choice is turned on, the 
box has a checkmark inside it. To turn a choice off or on, click in the checkbox.



Option
A choice or feature available to you. 



Tab
Tabs help you quickly get to where you want to be and also show you only the commands you need to 
see at that time.



Pulldown listbox
A box on the screen that shows the most common choice, but also contains an arrow pointing down. You 
can click on this arrow to see a list of more choices.



Highlight
To highlight a choice means to select it, usually by clicking on the item or dragging the mouse pointer 
across it. The color of the item changes to show that it's highlighted.



Tracking
Monitoring member activities in Chat.    You can track who else is coming and going, which rooms they are
entering and leaving, and so forth.



Unmark
If a checkbox for a choice has an X in it, that choice is “on.” To turn it off, click in the check box and the X 
will go away.



Member
Anyone who has a CSi Member ID. 



Window
Windows are the boxes on your computer screen that organize programs and commands. To make 
something happen, you simply click on an icon or picture in a window rather than typing in commands.



Chat
To communicate with others online, except that you type instead of talking.



Paste
To paste something like text or a picture is to place it in its new location. Usually the second half of a Cut 
and Paste or Copy and Paste operation.



Copy to
To create a copy of an item and put it in a new location. You can select a file on your hard drive and copy 
it to a diskette.



MAPI
Messaging Application Program Interface; enables mail and messages to be exchanged across various 
platforms and applications.



Winsock
WinSock is short for Windows Sockets; the WinSock is the interface between TCP/IP (Transmission 
Control Protocol/Internet Protocol), and Windows. 



Dial Type
Indicates whether your computer has to dial a number to connect to CSi. This will usually be “Manual”; 
select Direct only if your computer is hard-wired to another computer system which provides the 
connection for you.



Prohibited List
A list of people you specify that you don't want to receive invitations to chat from.    You can block 
someone temporarily or permanently.



Parent message
The first or root message in a topic thread.



Sibling message
One of several messages in a thread, usually a reply or response to the Parent message.



Child message
Usually a reply or response to the first, or Parent, message in a topic thread. 



Participate
To actively take part in a discussion; to ask questions or offer comments, as opposed to merely observing 
or “lurking.”



Room
A place in one of CSi's Forum areas where people can go to have a conversation among themselves or 
discuss a topic that is not of interest to everyone else in the Forum area. For example, maybe you're in 
the Gardening Forum area and realize that three of you are from the same hometown. The three of you 
can go to a room to discuss old times.



Explore
To look around CSi to discover new and fun things to do online. Exploring is safe -- you won't incur extra 
charges unless you agree to.



View mode
When you're in a library in a Forum area, you can view or look at a file before you retrieve or download it.



Incoming Message Folder
A folder in your Filing Cabinet; the place on your computer that mail messages are copied to when you 
retrieve them.



Outgoing Message Folder
A folder in your Filing Cabinet; the place on your computer that mail messages are stored in until you 
connect to CSi and send them.



PNG
Portable Network Graphics. An extensible file format for both 8 or 24 bit    lossless, portable, well-
compressed storage of raster images. PNG provides a patent-free replacement for the GIF format and 
can also replace many common uses of TIFF format. Indexed-color, grayscale and truecolor images are 
supported, plus an optional alpha channel.



Waiting Messages
These are messages sent to you in Forum areas, usually a response to a question you've asked or 
comment you made. You can get directly to these without having to read all the other messages in that 
Forum area.



Attach
When you send a mail message, you can include or attach files such as articles or pictures.



PPP
Point-to-Point Protocol.    A communications protocol that enables you to connect to the Internet using a 
telephone line.



URL
Uniform Resource Locator, or the address of a Web page on the Internet.



Multi-tasking
To do more than one thing at a time; for example, you can be retrieving (downloading) files while reading 
mail.



Signup
The process of joining or becoming a member of CSi.



Clipboard
A temporary storage place within Windows; when you cut or copy text or a picture, it goes on the 
Clipboard until you paste it somewhere else. You can store one thing at a time on the Clipboard.



Font
The shape and style of letters and numbers. Two common fonts are Arial and Times New Roman.



Carrier Detect
A step in establishing communications involving the exchange of signals to ensure you have telephone 
line access.



Access Number 
This is the telephone number you dial to connect to CSi, depending upon where in the world you are.



Comm Port
The plug on the back of your computer used for communications, usually where your telephone line plugs
in to your modem.



side button
One of the large, colorful, rectangular, graphic buttons that are displayed along the left side of the 
CompuServe window for many desktops.    You click a side button to reference a corresponding window 
(page) or task. 



top tab
The top, flipper part of certain windows (pages) that are displayed in the center of the CompuServe 
window.    Each top tab identifies a distinct page.    You click a top tab to view or access that page.    



menu
Collection of related actions (commands).    Menu names are displayed in the upper left-hand corner of 
the CompuServe window (above the Page box).    You click a menu name to view the menu.    You then 
click a command to initiate its function.    File and Edit are examples of menus.



GIF
Graphics Interchange Format, a graphics format featuring 8 bit color lossless compression and providing 
interchange between many platforms.    GIF was developed by CompuServe, and has been widely 
adopted in the on-line industry.      GIF is one of the formats that CompuServe 3 uses to display graphics 
online. A mechanism to specify one color to act transparent is frequently invoked. GIF files are currently 
used to display weather maps and stock charts and have the potential for other uses in the future.    There
are also many forum libraries that contain a wide variety of GIF files contributed by CSi members.



PIC
Pegasus Imaging Corp. PIC is a proprietary JPEG file created by Pegasus Imaging Corporation.    This 
JPEG file is built with a BMP header which contains color palettes, comments, and other information 
about the file.    See JPEG or Go Pegasus for more information.



KQP
Konica Quality Photo.    A Pegasus Imaging Corp. PIC JPEG file created by Konica Quality Photo for the 
PC PictureShow application.    PC PictureShow is a film scanning process which places a digitized roll of 
film onto a diskette.    See PIC, JPEG or Go Pegasus for more information.



RVU
Rapid View.    A standard progressive JPEG file created by Pegasus Imaging Corporation.    These files 
are viewable by any progressive JPEG viewer. However, the RVU file may contain proprietary information
only seen with a Pegasus decompressor or viewer utility.    See JPEG, Progressive JPEG or Go Pegasus 
for more information.



Progressive JPEG
Progressively viewable Joint Photographic Experts Group.    See JPEG.    This format allows for an initial 
view of an image, giving the user a significantly degraded but good preliminary representation while the 
remaining image detail is received and viewed in succeeding passes.



bcc
Blind carbon copy recipient.    A bcc recipient will receive a copy of a Mail message without being listed in 
any visible Recipient List.



Configuring the Windows NT Dial-up Remote Access Service (RAS Dialer)

Instructions for Windows NT 3.5.1 
Instructions for Windows NT 4.0 



Configuring the Windows NT 3.5.1 Dial-Up Remote Access Service (RAS Dialer)

Assuming you have not previously added RAS: 

1 In the Control Panel, double-click the Network icon. 

2 In the Network Settings window, click the Add Software button.

3 Select Remote Access Service from the pop-up list in the Network Software window. 

4 Provide a path to your NT distribution (disks, CD, or network location).    RAS will then install, and the 
Remote Access Program Group will appear. 

5 Then in the Add Port window, you'll see a list of all ports available to Windows NT RAS.    Choose the 
port you will use. (RAS will offer to detect the modem connected to the port you selected. Choose OK 
to auto-detect the modem. NT will show the modem detected; select OK.    Occasionally, NT may offer
a choice of several modems to pick from; this will only occur if RAS cannot distinguish between 2 or 
more modems with similar characteristics.) 

6 In the Configure Port window, the detected modem will be highlighted. In the Port Usage section, 
choose "Dial out only". 

RAS is now installed. The next step is to configure it to dial CSi. 

Editing SWITCH.INF

1 Using a text editor such as Notepad or Edit, add the following section to the bottom of your 
SWITCH.INF file (normally located at \WINNT\system32\ras\switch.inf): 

===========================================

[CompuServe]
COMMAND=<cr>
OK=<match>"e:"
ERROR_NO_CARRIER=<match>"NO CARRIER"
LOOP=<ignore>
COMMAND=+<cr>
OK=<match>"Host Name"
ERROR_NO_CARRIER=<match>"NO CARRIER"
LOOP=<ignore>
COMMAND=CIS<cr>
OK=<match>"User ID:"
ERROR_NO_CARRIER=<match>"NO CARRIER"
LOOP=<ignore>
COMMAND=#######,####/GO:PPPCONNECT<cr>
OK=<match>":"
ERROR_NO_CARRIER=<match>"NO CARRIER"
LOOP=<ignore>
COMMAND=PASSWORD<cr>
CONNECT=<ignore>

2 Be sure to put in your actual CSi member ID [123456,1234] and your CSi password [XXXX0XXXXX] 
in place of ######,#### and PASSWORD. 



3 Save the file. 

Editing the RAS phonebook 

1 Go to the Remote Access Program Group and double-click the Remote Access icon. In the resulting 
window, click Add. 

You will be presented with an Add Phone Book Entry window.
 
2 Name the new entry whatever you want (probably "CompuServe" or something similar). 

3 Enter the phone number of your local CompuServe dial-up site, plus any modifiers needed (such as 9
to reach an outside line or *70 to disable call waiting). 

4 Leave the Description field blank (optional). 

5 Make sure that "Authenticate using current name and password" is not marked. 

6 Select the correct COM port for your modem. 

7 Click the Modem button. Choose the correct port speed. Mark "Enable hardware flow control," 
"Enable modem error control," and "Enable modem compression." Do not mark "Enter modem 
commands manually." Click OK. 

Note:    If your modem uses Rockwell Protocol Interface (RPI) technology, CompuServe 3 may have 
problems establishing and maintaining modem connections and displaying Web pages.    The best way to 
resolve theseproblems is to contact your modem manufacturer and make sure that your modem is using 
up-to-date software.

8 Select the Network option. Choose PPP, and mark "TCP/IP" and "Request LCP extension". 

9 Click the "TCP/IP Settings" button. Choose "Server Assigned IP address" and "Use specific name 
server addresses." Then enter in DNS 149.174.211.5 and DNS Backup 149.174.213.5. Mark both 
"Use VJ header compression" and "Use default gateway on remote host". 

10 Select the Security option. Make sure "Accept any authentication including clear text" is selected. In 
the "Terminal or Script" section, select CompuServe in the pop-up menu for "After Dialing". (The 
CompuServe option will only be available if you made the necessary changes to SWITCH.INF) 

11 Click OK. 

Return to the Remote Access window. You will now see a new setting for CompuServe. Simply select Dial
to connect to CSi.



Configuring the Windows NT 4.0 Dial-Up Remote Access Service (RAS Dialer)

Unless otherwise noted all settings or selections not specifically mentioned should be left at their default 
entries. 

1 Go to Start|Settings|Control Panel and double-click on the Network icon. Then choose the Services 
tab. If Remote Access Service is not on the list, add it by choosing the Add button. 

Note: You must have Administrator privileges to install RAS. TCP/IP and other necessary components 
should be installed along with RAS. If they are not, you do not have Administrator privileges and should 
consult your manual or VAR.

2 Go to Start|Programs|Accessories|Dial-up Networking and choose the New button. 

3 In the New Phonebook Entry Wizard window enter CompuServe for the name and choose Next. 

4 In the Server window mark the top two boxes and choose Next. 

5 In the Phone Number window enter the local phone number that you dial to connect to CSi and then 
choose Next. Enter any Alternate numbers by choosing Alternate. 

6 In the New Phonebook Entry Wizard window choose Finish

Note: If this is the first time you have made a Dial-Up Networking entry you will have a few more screens, 
just click on the Next button for each one. 

7 On the Dial-up Networking window choose More, then select Edit entry and modem properties. You 
can also choose Create shortcut to entry on this menu to place a shortcut icon on your desktop. 

8 The Edit Phonebook Entry, Basic tab lists basic information about the Entry. You can also Select the 
Alternates button to enter alternate phone numbers to dial. Selecting the Configure button will allow 
you to set some modem properties.

9 After clicking the Alternates button you can enter in additional phone numbers to dial.

10 After clicking the Configure button you can edit some of the modem properties including error 
correction, flow control, data compression, port speed and the modem speaker.

11 Click on the Server tab and check TCP/IP, unmark IPX/SPX and NetBEUI. Software compression and
PPP LCP extensions checked.

12 On the Server tab and select the TCP/IP Settings button. On the PPP TCP/IP Settings window set IP 
Address for "Server assigned". Then enter 149.174.211.5 in the Primary DNS field and 149.174.213.5
in the Secondary DNS field. Leave Wins all zeros, check both boxes at the bottom and then click OK. 

13 Click on the Script tab and, from the pop-up list, choose cis.scp.

14 Select the Before Dialing button and make sure that "None" is marked and click OK.

15 Select the Security tab and mark "Use any authentication including clear text" or "Accept only 
encrypted authentication". The Unsave password button will unsave your password so that you can 
re-enter your password if necessary (see step 22).

16 Settings on the X.25 tab should be blank.    Then click OK.

17 From the More button menu select User Preferences.



18 On the Dialing tab put a check in the box next to the Location listed in the Auto-dial by location box. If 
you set the Idle seconds before hangup to 10 seconds, Dial-up Networking will disconnect the 
connection if left idle. You can also set the number of retries and whether or not Dial-Up Networking 
redials if the connection is lost.

19 On the Callback tab, mark "No, skip callback" .

20 On the Appearance tab there are various options that can be set. All of the options should be 
checked.

21 On the Phonebook tab, mark "The System Phonebook".

22 Select Dial in the Dial-up Networking window. The first time you connect you will be asked to enter 
your CSi User ID number (with the comma) in the User Name field and your Password in the 
Password field. Leave the Domain field empty and check Save password if you want to save the 
password. If you need to change your password you would need to click the Unsave password button
on the Security tab(step 15).

23 Click on OK to dial. Do not disturb the After Dial Terminal window but watch the log in and if you get 
"?? LOGINE - Invalid entry - try again" after the Password: prompt that means your password is 
incorrect. 

24 On the Taskbar, there will be the Dial-up Network icon in the SysTray. If you right click on this icon you
can hang up the connection or select Open Dial-up Monitor to get information about your connection, 
including the DCE connection speed (bps) and your IP address (Details button). 

25 In CompuServe 3.0.2, from the Access pull-down menu, select Preferences. Under the Connection 
type the Winsock should be set for Default WINSOCK.



Upgrading to CompuServe 3 from CIM

CompuServe 3 has been designed to be graphically engaging and easy to use.

Please click a topic to learn more about CompuServe 3.

Topics
Introduction 
New Features 
Commands and Menus 
Converting Your Filing Cabinet 
Uninstalling CompuServe 3 



Introduction

Here are some of the major differences between WinCIM 2.0.1 and CompuServe 3:

Most desktops in CompuServe 3 have colorful side buttons (side tabs) that run along the left side 
of the screen.    If you click a side button, one or more pages (windows) with top tabs will be displayed in 
the center of your screen.    Simply click the assorted top tabs to view or access those pages.    Just about 
anything you would want to do is located on those pages.

The Filing Cabinets in WinCIM 2.0.1 and CompuServe 3 are not compatible. You cannot read 
documents filed in the CompuServe 3 Filing Cabinet with WinCIM 2.0.1 or earlier versions.    Similarly, you
cannot read messages filed in your WinCIM 2.0.1 Filing Cabinet without first converting them to the new 
CompuServe 3 format.    (Consult the Converting Your Filing Cabinet upgrading topic for more 
information.)

CompuServe 3 has a fully-integrated Web Browser to make viewing Web pages easier than ever. 
Your screen will look a little different when you are using the Web Browser.    (You can always return to the
CompuServe 3 Home Desktop from a Web page by clicking the Main Menu button along the top of your 
Web Browser window.)

CompuServe 3 has a Toolbar (Ribbon), but many of the buttons are new.    You can learn what 
each button does by positioning your arrow cursor over the button and then pausing for a second or two.   
(The name of the button will appear in a tiny window.)

The Forum Desktop, News Desktop, and Chat Desktop, do not have Toolboxes (palettes) to 
represent frequently-used commands.    Such commands are now grouped and appear on a desktop-
specific menu, such as the Forum menu (for the Forum Desktop).

CompuServe 3 still has a menu bar, but many of the commands in WinCIM 2.0.1 have been 
renamed, removed and added to new menus, or eliminated completely in CompuServe 3.    There are 
also a number of new commands in CompuServe 3 that were not present in WinCIM 2.0.1.    

The Explore Services window (menu) has been changed to a Table of Contents page.    (Click the 
Main Menu side button on the Home Desktop, and then click the Table of Contents button to go there.)

CB has been renamed Chat.

CompuServe 3 has a Learn About area for each of the major desktops to help you gain familiarity 
without having to leave the product.    (Click the Learn About side button to access the Learn About area.)



New Features

Here are just a few of the new features you will find in CompuServe 3:

A New, Multimedia User Interface
Multimedia components, like high-performance progressive graphics rendering and a sound player are 
provided or integrated into the software.    And with the CompuServe Viewer, you can participate (send 
comments) in multimedia Moderated Conferences in the Conference Center.

Learn About Feature
Explore Learn About to find out how to accomplish your tasks in our redesigned product.    Available on 
most desktops, this feature is especially helpful if you're new to CompuServe.

New, Integrated Web Browsers
The Microsoft Internet Explorer will be available at installation for Windows 3.1, Windows ‘95, Windows 
NT, and Macintosh users.

Web-Like CompuServe Browser Desktop
The new CompuServe Browser enables you to navigate in a fashion similar to a Web session.    Just use 
the forward and back arrows to move between menus.

Multi-Task Processing
Now you can queue multiple tasks in background and move on to others.    And the new the To-Do List 
helps you to manage group processing of send and receive tasks.

Personalized, Customizable Features
You now can customize the Toolbar, look at information your way in sortable lists, and track services 
you've visited in the new Page pop-up menu.



Commands and Menus

Many of the commands in WinCIM 2.0.1 have been renamed, removed and added to new menus, or 
eliminated completely in CompuServe 3.

There are also a number of new commands in CompuServe 3 that were not present in WinCIM 2.0.1.

File Menu

There are now specific commands for creating a text file (New Text File), a Mail message (New 
Mail Message), and a Forum message (New Forum Message), 

Save As has been removed from the File menu.

A new command called Add to Favorite Places enables you to define a new Favorite Place.

There are now commands that enable you to access your Address Book (Address Book) and 
Filing Cabinet (Filing Cabinet), as well as your To-Do List (To-Do List).

A new command called Filing Cabinet Utilities enables you to search for items in your Filing 
Cabinet, as well as rebuild your existing Filing Cabinet indexes.

Connect and Disconnect have been combined into one command, and have been moved from 
the File menu to the Access menu.

Edit Menu

Copy to and Fixed Font have been removed.

Access Menu

The Access menu is a new menu, but the commands on it are ones you are already familiar with from 
WinCIM, such as the Favorite Places, Find, and Go commands.

Services Menu

Favorite Places, Find, and Go have been moved to the Access menu.

Explore, Special Events, and Executive News have been removed.

Internet Browser has been changed to Internet.

News Headline has been changed to Latest News.

Quotes has been changed to Stock Quotes.

Portfolio has been changed to Financial Portfolio.

Weather has been changed to Latest Weather.

CB Simulator has been changed to Chat.



There are three additional commands (Table of Contents, Member Services, and Forums and 
Communities).

Mail Menu

Search New Mail, Member Directory, In Basket, and Out Basket have been removed.

Create/Send Mail has been changed to Create New Mail.

Send/Receive All Mail has been changed to Send/Retrieve All Mail.

Filing Cabinet has been moved to the File menu.

Create Forum Messages has been changed to New Forum Message and has been moved to 
the File menu.

Special Menu

The Special menu in WinCIM 2.0.1 has been eliminated.

Session Settings are now known as Connection preferences.    (Choose Preferences from the 
Access menu.)

Connection Info has been changed to Connection Status and moved to the Access menu.

Preferences are now found on the Access menu.

Terminal Emulation has been changed to Terminal Emulator and moved to the Access menu.

Rebuild Cabinet Indexes and Forum Database have been removed.

Window Menu

Cascade, Tile, Arrange Icons, and Close All have been removed.

Windows on Top is a new command.

Help Menu

CompuServe Directory has been moved to the Access menu.

Upgrading to CompuServe 3 from CIM and What's New in CompuServe 3 are new 
commands.

Forum Desktop

Messages Menu



Create Message has been changed to Create Forum Message and has been moved to the 
Forum menu.

Search Messages has been moved to the Forum menu.    (Choose Search from the Forum 
menu.)

Get Waiting has been changed to Get Waiting Messages and has been moved to the Forum 
menu.

Browse Messages, Retrieve Marked, Freshen Messages, In Basket, Out Basket, Filing 
Cabinet, Address Book, Notice, and Descriptions have been removed.

Set Date has been changed to See More Messages and has been moved to the Forum menu.

Library Menu

Browse Library, Retrieve Marked, Notice, and Descriptions have been removed.

Search Library has been changed to Search Files and has been moved to the Forum menu.    
(Choose Search from the Forum menu.)

Contribute has been changed to Contribute Library File and has been moved to the Forum 
menu.

Conference Menu

Enter Room has been changed to Rooms List and has been moved to the Forum menu.

Who's Here has been changed to Who's Here List and has been moved to the Forum menu.

Set Nickname has been changed to Change Nickname and has been moved to the Forum 
menu.

Ignore has been changed to Modify Prohibited List and has been moved to the Forum menu.

Invite, Notice, and Descriptions have been removed.

Special Menu

Notices, Forum Options, Join Forum, Connection Info, Preferences, and Toolbox have been
removed.

Search Membership has been changed to Search Members and has been moved to the Forum
menu.    (Choose Search from the Forum menu.)

Change Member Entry has been changed to Change Member Profile and has been moved to 
the Forum menu.

News Desktop



Stories Menu

Select Folder, Retrieve Marked Stories, Create Folder, Update Folder, Delete Folder, and 
Notices have all been removed.

Special Menu

Connection Info, Preferences, Toolbox, In-Basket, Out-Basket, Filing Cabinet, and Address 
Book have all been removed.

CB Simulator is now called Chat

Channels Menu

Channels! has been changed to Rooms List and has been moved to the Chat menu. 

People Menu

Who's Here has been changed to Who's Here List and has been moved to the Chat menu.

Invite and Friends have been removed.

Squelch has been changed to Modify Prohibited List and has been moved to the Chat menu.

Special Menu

Record Channel, Record Group, Change Handle, Set Function Keys, Bulletin, Connection 
Info, Preferences, Toolbox, In-Basket, Out-Basket, Filing Cabinet, and Address Book have been 
removed.



Converting Your Filing Cabinet

CompuServe 3 uses a new Filing Cabinet format.    Here is a summary of what you need to know about it:

The Filing Cabinets in 2.0.1 and CompuServe 3 are not compatible. You cannot read documents 
filed in the CompuServe 3 Filing Cabinet with WinCIM 2.0.1 or earlier versions.    Similarly, you cannot 
read messages filed in your WinCIM 2.0.1 Filing Cabinet without first converting them to the new 
CompuServe 3 format.

If you install CompuServe 3 into your common (\CSERVE) CompuServe software directory 
(where WinCIM currently resides), the contents of your WinCIM Filing Cabinet will be converted 
automatically to the new CompuServe 3 format. (This automatic conversion of your Filing Cabinet 
happens only the first time you install CompuServe 3.) 

The conversion process does not harm your old Filing Cabinet messages, but simply makes a 
copy of them and then converts the copies to the new Filing Cabinet format. 

If you need to convert your WinCIM Filing Cabinet to CompuServe 3 format and you have already
installed CompuServe 3, you can use the Filing Cabinet Conversion Utility that comes with CompuServe 
3.    (You will find the Filing Cabinet Conversion Utility in your CompuServe 3 program folder.)

The Filing Cabinet Conversion Utility has several options that you can set if you do not want to 
use the default options:

Delete original Filing Cabinet checkbox indicates whether you want to delete the old Filing Cabinet 
entries after importing them into the CompuServe 3 Filing Cabinet.    This will help conserve space on 
your hard drive.    (You should make sure you have backed up your old Filing Cabinet before importing
it in this way.)

Log transactions to text file checkbox indicates whether a text file of activities that occur during the 
conversion process should be generated.    (The resulting text file will be placed in the CompuServe 3 
Filing Cabinet.)

Index items upon completion checkbox indicates whether the CompuServe 3 Filing Cabinet should 
be re-indexed upon completion of the conversion process.    (This is necessary if you wish to be able 
to perform full-text searches on the contents of your CompuServe 3 Filing Cabinet.)

Duplicate Records options enable you to control how records should be handled if they exist in both 
Filing Cabinets.    For example, such duplicate records could occur if you attempt to import (convert) 
the same Filing Cabinet twice.

Prompt option will cause the Filing Cabinet Conversion Utility to prompt you as to whether a detected
duplicate record should be added or skipped.

Add All option will cause the Filing Cabinet Conversion Utility to add, but not overwrite, records if they
already exist in the target (CompuServe 3) Filing Cabinet.    (This will result in multiple copies of the 
same entry in the CompuServe 3 Filing Cabinet.)

Skip All option will cause the Filing Cabinet Conversion Utility to ignore duplicate records.



Uninstalling CompuServe 3

Should you ever want to uninstall CompuServe 3, you can do so easily by using the Uninstall program 
that comes with CompuServe 3.

(You will find the Uninstall program in your CompuServe 3 program folder.)



What's New in CompuServe 3

A New, Multimedia User Interface
Multimedia components, like high-performance progressive graphics rendering and a sound player are 
provided or integrated into the software.    And with the CompuServe Viewer, you can participate (send 
comments) in multimedia Moderated Conferences in the Conference Center.

Learn About Feature
Explore Learn About to find out how to accomplish your tasks in our redesigned product.    Available on 
most desktops, this feature is especially helpful if you're new to CompuServe.

New, Integrated Web Browsers
The Microsoft Internet Explorer will be available at installation for Windows 3.1, Windows ‘95, Windows 
NT, and Macintosh users.

Web-Like CompuServe Browser Desktop
The new CompuServe Browser enables you to navigate in a fashion similar to a Web session.    Just use 
the forward and back arrows to move between menus.

Multi-Task Processing
Now you can queue multiple tasks in background and move on to others.    And the new the To-Do List 
helps you to manage group processing of send and receive tasks.

Personalized, Customizable Features
You now can customize the Toolbar, look at information your way in sortable lists, and track services 
you've visited in the new Page pop-up menu.

To get the latest information about your CompuServe 3 software, go to the CompuServe Support 
Forum.



Assistance Page

The Member Assistance page enables you to learn access phone numbers for connecting to CSi, review 
information related to your CSi account, and contact CompuServe Customer Service.

Related help topics
Accessing a Service 
Setting Connection Preferences

List of CompuServe Offices
Argentina 
Australia/New Zealand 
Austria 
Chile 
Colombia 
France 
Germany 
Hong Kong 
Hungary 
Israel 
Japan 
Mexico 
Singapore 
South Africa 
South Korea 
Switzerland 
Taiwan 
United Kingdom 
United States/Canada 
Venezuela 
Other Countries



Actual F1 Dialogs begin here. 
Uppercase # footnotes are the links to the .H file.
Lowercase # footnotes are for the above “test section” for Sample F1 Help Pages only.
Remove test section links before turning files over for safekeeping.
Also remove “abc” sections following.



Mail Center 



 

Read Page

The Read page lists your incoming Mail and enables you to process it.    

To get your Mail, click Get Mail.    Your CSi mailbox will be cleared out in the process, ensuring that you 
continue to get only new Mail messages whenever you click Get Mail.    (You can change the behavior of 
the Get Mail button in your Mail preferences.)

If you want to retrieve (download) more than one listed message, simply select each one before you click 
Open.    (Hold down the Ctrl key on your keyboard while clicking a message to select it.)

What you see on your screen

Get Mail button lists your incoming Mail. The Get Mail button is initially set to retrieve (download) Mail 
from your online mailbox to your computer.    However, you can have the Get Mail button take you to your 
mailbox without retrieving your incoming Mail by marking the View Mail online before retrieving checkbox 
in your Mail Preferences. 

Open button displays a highlighted message.

File It opens your Filing Cabinet so that you can save a highlighted message.

Delete button deletes a highlighted message.

Subject, From, Date, Size, and Options column headings (in the Incoming Messages list) sort your 
incoming Mail.

Related help topics
Setting Mail Preferences
What is a Mailbox? 



Create Page

The Create page enables you to create and process your outgoing Mail.

If you have outgoing messages, they will be listed here automatically.

If you want to send more than one listed message, simply select each one before you click Send.    (Hold 
down the Ctrl key on your keyboard while clicking a message to select it.)

What you see on your screen

New button brings up a window where you can create a Mail message.

Open button displays a highlighted message so that you can review or modify it.

Send button sends a highlighted message, then removes that message from the list.

Send All button sends all outgoing messages.

Delete button removes a highlighted message without sending it.

Subject, To, Date, Size, and Options column headings (in the Outgoing Messages list) sort your 
outgoing Mail.

Related help topics
Reviewing or Editing Outgoing Messages
Sorting Outgoing Messages



Search Page

The Search Page enables you to search for Mail messages via subject, sender name, date range, 
general keyword, retrieval history, and so forth, from the Mail Center.

Define your search using the boxes beside Find.    If a box has a down arrow, click the down arrow to see 
a menu of choices, and then click the choice you want.    If a box does not have a down arrow, simply click
the box, and then type your information.

You can click More to narrow your search.

What you see on your screen

The More and Less buttons control the depth of your search interests.

More button displays additional search terms so that you can narrow your search.    (The More button 
becomes the Less button.)

Less button hides your search interests.    (The Less button becomes the More button.)

Find boxes enable you to specify the information required for your search.    Click the arrows to see a 
menu of choices, and then click the choice you want. (Use the boxes to make a sentence describing what
you want to search for.) 

Search button begins the search.

You will see the following search terms only if you click the More button.

Submitted between dates enable you to confine your search to the date range you select.    Click the 
arrows to change the dates. 

In Folders box enables you to confine your search to particular folders.    To select a folder to be 
searched, mark the corresponding checkbox. 

All button selects all folders in the In Folders box.

None button unselects all folders in the In Folders box.

You can also search for Mail messages stored in your Filing Cabinet by accessing the Filing Cabinet.

Related help topics
Forwarding an Incoming Message 
Replying to an Incoming Message 
Searching for Items in the Filing Cabinet



Search Page

The Search Page enables you to search for Mail messages via subject, sender name, date range, 
general keyword, retrieval history, and so forth.

Define your search using the boxes beside Find.    If a box has a down arrow, click the down arrow to see 
a menu of choices, and then click the choice you want.    If a box does not have a down arrow, simply click
the box, and then type your information.    

You can click Less to hide your search interests.

What you see on your screen

The More and Less buttons control the depth of your search interests.

More button displays additional search terms so that you can narrow your search.    (The More button 
becomes the Less button.)

Less button hides your search interests.    (The Less button becomes the More button.)

Find boxes enable you to specify the information required for your search.    Click the arrows to see a 
menu of choices, and then click the choice you want. (Use the boxes to make a sentence describing what
you want to search for.) 

Search button begins the search.

You will see the following search terms only if you click the More button.

Submitted between dates enable you to confine your search to the date range you select.    Click the 
arrows to change the dates. 

In Folders box enables you to confine your search to particular folders.    To select a folder to be 
searched, mark the corresponding checkbox. 

All button selects all folders in the In Folders box.

None button unselects all folders in the In Folders box.

You can also search for Mail messages stored in your Filing Cabinet by accessing the Filing Cabinet.

Related help topics
Forwarding an Incoming Message 
Replying to an Incoming Message 
Searching for Items in the Filing Cabinet



Address Book

The Address Book page (window) lists the contents of your Address Book.    You can create, change, and 
delete Address Book entries.

Your Address Book saves you time when addressing your CSi Mail messages because you can select 
your message recipients without having to retype names and electronic mailing addresses.

You can also easily add to your Address Book the names and addresses of people who send Mail to you 
by clicking the Add Addresses button (in the Read Mail window) while reading a message.

What you see on your screen

Add Entry button opens a window where you can make a new entry in your Address Book.

Open button displays detailed information about a highlighted entry so that you can review or modify it.

Create Message button enables you to create a Mail message.

Delete button removes a highlighted entry from your Address Book.

Name, Address Type, and Address column headings sort the Address Book entries.

Related help topics
Changing an Address Book Entry 
Making an Address Book Entry 



Online Mail Search Window

The Online Mail Search window lists the results of a Mail search.

You can open and delete listed messages.

What you see on your screen

Open button displays a highlighted message in the Search Results box.

File it button opens your Filing Cabinet so that you can copy a highlighted message in the Search Results
box to the Filing Cabinet

Delete button removes a highlighted message from the Search Results box.

Stop button immediately halts your search.

Undelete button restores the last message you deleted.

Subject, From, Date, Size, and Options column headings (in the Online Messages list) sort your 
messages.

Related help topics
Saving Message Addresses 
Setting Mail Preferences



Define Mailing List Window

The Define Mailing List window enables you to create a Mailing List using existing individual entries in 
your Address Book.    

If you attempt to add someone to the Mailing List who is not currently listed in your Address Book, you will
be asked if you want to add the person to your Address Book.

What you see on your screen

Mailing List name: Specify a name for the group entry.

Name box records a recipient's name.

Address box records a recipient's electronic Mail address.

Add to List button adds the individual address to the Mailing List.

Name, Address Type, and Address column headings in the Mailing List box sort the Mailing List 
addresses.

Change button copies a highlighted name and address in the Mailing List box to another window so that 
you can change the information.

Remove button removes a highlighted member from the Mailing List Members box.

Address Book button opens your Address Book.

Related help topics
Making a Mailing List Entry 



Read Mail Window

The Read Mail window displays a Mail message.    You can file (save) or delete the message, forward the 
message to someone else, or send a reply to the author or one or more persons who received the original
message.

If you want to include some of all of the original message in your reply, before clicking Reply, first select 
the text you want so that it is highlighted.    Then, when you click Reply, the highlighted text will be copied 
to your reply message within quotation marks, preceded by an introductory phrase mentioning the author 
of the text.

If you are at your CSi mailbox (online) and want to forward (without retrieving) a message that has files 
attached to it, you must still retrieve (save) the attached files before you will be able to forward them.

What you see on your screen

 button displays the previous message in the list.

 button displays the next message in the list.

Reply button enables you to send a reply message to the author of the message.

Reply All button enables you to send a reply to all message recipients.

Forward button enables you to send the message along with your comments to one or more people. 

File It button opens your Filing Cabinet so that you can copy the message to a folder of your choice. 

Delete button closes the message and marks it for deletion.

To lists all the message recipients.

Add Address button opens a window where you can add any address associated with the message to 
your Address Book.

If the Mail message is a file, you will also see the following buttons:

Open button displays (opens) the file for you.    (You cannot open binary files from the Read Mail window.)

Save button enables you to save the file to your computer. 

Related help topics
Forwarding an Incoming Message 
Replying to an Incoming Message 



Online Mail Window

The Online Mail window lists the contents of your online mailbox so that you can process it without having
to retrieve (download) it to your computer.    

You are online (connected to CSi) whenever you see this window.

What you see on your screen

Open button displays a highlighted message in the Online Messages list.

File It button opens your Filing Cabinet so that you can copy a highlighted message.

File Later button enables you to add a highlighted item to your To-Do List for later filing.

Delete button removes a highlighted message from the Online Messages list.

Undelete button enables you to restore (undelete) messages that you have recently deleted.    You can 
undelete messages only one message at a time.

Subject, From, Date, Size and Options column headings (in the Online Messages list) sort your online 
messages.

Related help topics
Retrieving Mailbox Messages 
What is a Mailbox? 



Define Address Type Window

The Define Address Type window records the type of Address Book entry you want to make.    

Click Individual Address to define an entry for just one person (Jack Smith, Sally Doe, Li Pond).    

Click Group Mailing List to define an group entry of multiple individual addresses (Computer Pals, Softball
Team, Stock Club.)    A Mail message sent to a Mailing List address goes to everyone in the group.

Related help topics
Accessing the Define Address Type
Changing an Address Book Entry 



Create Mail Window

The Create Mail window enables you to create and process a Mail message.    (You can also paste your 
message from a file.)    

Your message must have a subject.

If you begin to type a name in the Name box that matches a name in your Address Book, the Name and 
Address boxes will be filled in automatically upon recognition of the match.

If you want to send the message to more than one person, click Recipients and create a Recipient List for
the message.

If you want to send one or more files with your message, click Attach File and specify (attach) them.

What you see on your screen

Send button sends the message, connecting you to CSi if you are currently offline.

Send Later button does not actually send the message, but instead places the message in the Outgoing 
Messages list to be sent later. (You can send it from there whenever you like.)

File It button opens your Filing cabient so that you can store the message.

Name, Address, and Subject boxes record your recipient and subject information.

Recipients button enables you to build a Recipient List for your message.

Options button opens a window where you can specify various sending options for the message.

Attach File button opens a window where you can specify a file to accompany the message.

Related help topics
Addressing a Mail Message 
Sending a Mail Message 



Message Recipients Window

The Message Recipients window enables you to build or edit a Recipients List for your message.    Each 
person in the Recipients List will receive a copy of the Mail message when sent.

If you begin to type a name in the Name box that matches a name in your Address Book, the Name and 
Address boxes will be filled in automatically upon recognition of the match.    If a name is not in your 
Address Book, a window will be displayed asking if you would like to add it to your Address Book.

For each recipient your specify, be sure to click the appropriate recipient type:

To: indicates that the recipient is a major recipient.

cc: indicates that the recipient will receive a public carbon copy of the message.

bcc: indicates that the recipient will receive a private (blind) carbon copy of the message.    (Only 
the sender and recipient will know about it.)

What you see on your screen

To: option designates the selected name and address as a primary recipient.    You can have multiple 
primary recipients.

cc: option designates the selected name and address as a carbon copy recipient.    Carbon copy 
recipients receive a copy of the message and their names are visible in in the Recipients List.

bcc: option designates the selected name and address as a blind copy recipient.    Such recipients 
receive a copy of the message, but their names are not visible in the Recipient List.

Name box records the message recipient's name.

Address box records the message recipient's electronic mailing address.

Add to List button adds the information in Name and Address boxes, as well as the selected recipient 
option (To, cc, or bcc) to the Recipients List.

Change button enables you to modify a highlighted entry in the Recipients list.    (The highlighted entry 
will appear in the Name and Address boxes where you can change or review them.)    You can also 
change the recipient option (To, cc, or bcc).

Remove button enables you to delete a highlighted entry from the Recipients list.

Recipients box lists names and addresses of recipients you have specified.

Address Book button opens your Address Book so that you can select recipients from it.

Name and Address buttons (within the Recipients box) sort the recipient entries.

Related help topics
Accessing the Address Book
Requesting a Return Receipt 



Mail Page

The Mail page (within the Preferences window) enables you to customize your Mail sessions.    

You can request whether to file (save) sent messages, as well as whether to view Mail directly from your 
online mailbox, and whether to delete Mail from your online mailbox once retrieved.

What you see on your screen

Keep a copy of all sent mail in checkbox indicates whether copies of Mail messages that you send will 
be filed (saved) automatically in your Filing Cabinet.

Select Folder button opens your Filing Cabinet so that you can specify a folder for your copies of sent 
Mail messages.    (The Select Folder button is a valid option only if you mark the Keep a copy of all sent 
mail in checkbox.)

Immediately show recipient dialog checkbox indicates whether you will immediately see the Message 
Recipients window each time you compose a message.

Automatically add new addresses to Address Book checkbox indicates whether you will be prompted 
to add an entry to your Address Book each time you add an unrecorded address to the Recipient List 
when creating a Mail message.

View mail online before retrieving checkbox indicates whether incoming Mail will be retrieved 
(downloaded) from your mailbox (online) to your computer automatically when you click Get Mail at the 
Mail Center Read page, or whether you will instead view incoming Mail at your mailbox (without 
automatically retrieving it.)    If you mark this checkbox your incoming Mail will be displayed in a separate 
window instead of on the Mail Center Read page when you click Get Mail.

Delete Mail from online mailbox when retrieved checkbox indicates whether CompuServe 3 will delete 
Mail from your mailbox after you retrieve it (file it) to your computer when you are at your online mailbox.   
(This checkbox is available only if you have also marked the View mail online before retrieving checkbox.)

Related help topics
Auto-Filing Sent Mail 
Requesting a Return Receipt 



Set Mail Options Window

The Set Message Options window enables you to assign various sending options to a Mail message, 
such as whether to assign an urgency status to the message, whether to specify a particular release or 
expiration date, whether to request a notification when the recipient actually opens the message, and 
whether the message text should be reformatted when sent.

What you see on your screen

Indicate message is urgent checkbox assigns the highest priority to your message.    Recipients will see 
such status before opening the message.

Notify me when message is received checkbox causes a message to be sent to you the first time each 
recipient opens your message.

Recipients can see the Recipient List checkbox indicates whether those people who receive your 
message will be able to see the names of others who also received the message.

Reformat text to window option assures that your message will fit comfortably within the size of the 
recipient's message window, wrapping to window dimensions as appropriate.

Send exactly as shown option assures that the spacing and paragraph layouts of your message will not 
be changed when the message is sent.

Release Date checkbox causes your message to be sent on the date that you specify in the date box to 
the right.    Click the arrows to change the dates.

Expiration Date checkbox causes your message to be deleted from the recipient mailbox on the date 
that you specify in the date box to the right, provided the recipient does not retrieve (download) it first.    
Click the arrows to change the dates.    

Related help topics
Assigning Urgency Status 
Setting Mail Preferences



Add Entries to Address Book Window

The Add Entries to Address Book window lists all the addresses associated with an opened message so 
that you can add one or more of them to your Address Book.

What you see on your screen

Names box enables you to select a listed name to add. 

Detail information displays address information, as well as comments associated with the highlighted 
name, for you to review or modify.

Add button adds the highlighted name and associated information to your Address Book.

Done button closes the Address Book Window.

Related help topics
Saving Message Addresses 



Attach Files Window

The Attach Files window lists all files currently attached to a message that you are creating.    

You can add files to the list, as well as remove files from the list.

What you see on your screen

Add To List button opens a window where you can specify a file to send with the message.

Remove button removes a highlighted file from the list of attached files in the Files Attached box.

File type box displays the type of file that is highlighted.    Click the arrow to select a different type.

Files Attached box shows the attached files.

Related help topics
Attaching a File to a Mail Message
Setting Mail Preferences



Define Address Book Entry Window
Change Address Book Entry Window

The Define Address Book Entry window and the Change Address Book Entry window are the same.    
Both are forms for recording detailed information about an Address Book entry.    If the entry is new, the 
form is blank or partially (name and address) filled in.    If the entry already exists, the form is partially or 
completelt filled in (comments are optional).

If you want to compose a message to someone who is recorded in your Address Book, close the window, 
click the Create top tab, and then click New.

What you see on your screen

Name box records the name of the Address Book entry.

Address type box indicates the various address types. (Click the down arrow button, and then click the 
address type you want.)    The Define Address Book Entry window might change slightly to reflect the 
address type you select.    For example, some address types, such as Deutsche Bundespost, require that 
you provide additional information.

Comments box records any comments you wish to associate with the entry.

Your address might require one or more of the following components:

answerback
Optional component of Telex and TWX address formats.    Do not specify an answerback unless you are 
sure that it is correct.

country
Standard X.400 code for the country where the mail service is located.

given name
First name of the recipient.

mail id
Recipient's unique mail service address.

organization
Organization through which the recipient receives messages.

private domain
Private domain of the recipient's organization (if there is one).

surname
Last name of the recipient.

system name
Three-letter code assigned to a private CompuServe Mail system.

state
The state, province, or other government subdivision.



username
Recipient's username.

workgroup
Recipient's MHS workgroup, as registered with the CompuServe Mail Hub.

post office
Recipient's cc:Mail post office as registered with the CompuServe Mail Hub.

Related help topics
Accessing the Address Book
Making an Address Book Entry 
Creating a Mail Message 
Sending a Mail Message 



Select Entry from Address Book Window

The Select Entry from Address Book window enables you to select one or more addresses from your 
Address Book for a Mailing List that you are creating.

You can select multiple addresses.    (Hold down the Ctrl key on your keyboard while clicking the 
addresses you want.)

Before an address can become part of a Mailing List, it must be entered in your Address Book as an 
individual address entry.

Name, Address Type, and Address column headings sort the entries.

Related help topics
Creating a Mail Message 
Sending a Mail Message 



Online Mail Search Window

The Online Mail Search window lists the results of a Mail search.

You can open and delete listed messages.

What you see on your screen

Open button displays a highlighted message in the Search Results box.

File it button opens your Filing Cabinet so that you can copy a highlighted message in the Search Results
box to the Filing Cabinet

Delete button removes a highlighted message from the Search Results box.

Stop button immediately halts your search.

Undelete button restores the last message you deleted.

Subject, From, Date, Size, and Options column headings (in the Online Messages list) sort your 
messages.

Related help topics
Listing Your Mail Messages 
Saving Message Addresses 



Forum Areas



Welcome Page

The Welcome page is your starting place in a Forum area or in the Conference Center, displaying a 
colorful Logo and the date of your last visit.    

Depending on the time of your visit, you might see one or more buttons along the top of the Welcome 
page, which you can click for additional information.

What you see on your screen

Get Waiting Messages button displays Message Topics containing messages addressed to you, but 
which you have not yet read.

Read News Flash button displays important news about the area.

Join Conferences in Progress button displays a list of ongoing conferences that you can participate 
(send comments) in or observe (watch).

Related help topics
Posting a Message 
What is a Forum Area?



Welcome Message Window

The Welcome Message window displays a note of welcome if you are new to the area.    

You can specify the name by which you want to be known, as well as any interests you want to share with
others.

What you see on your screen

Type the name you want to use box records the name you want to be known by while in the area.

Interests box records your interests.

Join button enables you to become a Forum member.    (There is no cost involved with joining a Forum 
area.)

Leave button closes the Welcome Message window and exits the area (but leaves you connected to 
CSi).

You can learn other Forum members' interests by viewing their Member Profiles at the Who's Here page.  
(Click the Forum Conference side button, and then click the Who's Here top tab to get to the Who's Here 
page.)

Related help topics
Posting a Message 
What is a Forum Area?



Members Page

The Members page (or Membership Search window) enables you to find other members.

Define your search using the boxes beside Find members.    If a box has a down arrow, click the down 
arrow to see a menu of choices, and then click the choice you want.    If a box does not have a down 
arrow, simply click the box, and then type your information.    

You can click More to narrow your search.

What you see on your screen

The More and Less buttons control the depth of your search terms.

More button displays additional search terms so that you can narrow your search.    (The More button 
becomes the Less button.)

Less button hides your search terms.    (The Less button becomes the More button.)

Find members boxes enable you to specify the information required for your search.    Click the arrows to
see a menu of choices, and then click the choice you want. (Use the boxes to make a sentence 
describing what you want to search for.) 

Search button begins the search.

You will see the following search terms only if you click the More button.

Member ID box records the Member ID number of the member you want to find.

Interests box records an interest keyword.    You can specify more than one keyword if you separate each
keyword by a space.    (Your search will find only entries with all the keywords you specify.)

Related help topics
Posting a Message 
What is a Forum Area?



Members Page

The Members page (or Membership Search window) enables you to find other Forum members.

Define your search using the boxes beside Find members.    If a box has a down arrow, click the down 
arrow to see a menu of choices, and then click the choice you want.    If a box does not have a down 
arrow, simply click the box, and then type your information.

You can click Less to hide your search interests.

What you see on your screen

The More and Less buttons control the depth of your search terms.

More button displays additional search terms so that you can narrow your search.    (The More button 
becomes the Less button.)

Less button hides your search terms.    (The Less button becomes the More button.)

Find members boxes enable you to specify the information required for your search.    Click the arrows to
see a menu of choices, and then click the choice you want. (Use the boxes to make a sentence 
describing what you want to search for.) 

Search button begins the search.

You will see the following search terms only if you click the More button.

Member ID box records the Member ID number of the member you want to find.

Interests box records an interest keyword.    You can specify more than one keyword if you separate each
keyword by a space.    (Your search will find only entries with all the keywords you specify.)

Related help topics
Learning About CSi Members 
Posting a Message 
What is a Forum Area?



Read Waiting Messages Window

The Read Waiting Messages window lists all the Message Topics containing Forum messages that have 
been sent specifically to you, but which you have not yet read.

If you open a topic, your waiting message in that topic is displayed.    

If you have more than one waiting message in a topic, each waiting message is listed.

You can click the Map button to find additional waiting messages for a topic.

What you see on your screen

Open button displays a waiting message in a highlighted Message Topic.

File It button opens the Filing Cabinet so that you can store a highlighted topic.

File Later enables you to add a highlighted item to your To-Do List for later filing.

Map button displays the message relationships for a highlighted topic so that you can select (click) 
additional messages in the topic that you want to read.

Related help topics
Replying to a Message 
Searching for a Message 



Announce Page

The Announce page lists one or more Announcements that you might want to open (read).

Related help topics
Posting a Message 
Setting Your Forum Area Preferences 
What is a Forum Area?



Read Announcement Window

The Read Announcement window displays important information about the Forum area that you can file 
(save) for later retrieval.    (Choose Save As from the File menu.)

What you see on your screen

Contents of: box displays the current Announcement name and lets you select other Announcements. 
(Click the down arrow button, and then click an Announcement.)

Related help topics
Setting Your Forum Area Preferences 
What is a Forum Area?



Message search for Window

The Message search for window lists the messages or Message Topics found as a result of a Message 
Boards search.

You can open and file (save) the listed messages or Message Topics.    

If you are viewing a list of individual messages or if you open an individual message, you can access 
related mesages within the Message Topic by clicking the Map button.

What you see on your screen

Open button displays a highlighted message (if you are looking at a list of messages) or opens a 
highlighted topic (if you are looking at a list of topics).

File It button opens the Filing Cabinet so that you can file (save) the highlighted message or Message 
Topic for later viewing. 

File Later enables you to add a highlighted item to your To-Do List for later retrieval.

Map button shows the relationships between messages in a topic.

Stop button halts the ongoing search.    When the search is complete this button is replaced by the Map 
button.

Related help topics
Browsing Forum Messages 
Searching for a File 



Read Page

The Read page lists the Message Sections in a Forum area.    

You can sort the listed Message Sections by clicking the Section Name, Topic and Messages column 
headings.

If you open a section, the list of Message Sections is replaced by a list of Message Topics within that 
particular section.

What you see on your screen

You will see a different arrangement of buttons depending on whether you are viewing a list of Message 
Sections or a list of Message Topics.

If you are viewing a list of Message Sections you will see the following buttons and other screen 
elements:

Open button lists topics in a highlighted section.

Description button displays a Description of a highlighted section.

File It button opens the Filing Cabinet so that you can store a highlighted entry.

File Later button enables you to add a highlighted item to your To-Do List for later filing.

Section Name, Topics, and Messages column headings (in the Message Sections list) sort the Message
Sections.

If you are viewing a list of Message Topics you will see the following buttons and other screen elements:

Open button lists topics in a highlighted section.

Map button shows the relationships among messages in a highlighted topic.

File It button opens the Filing Cabinet so that you can store a highlighted entry.

File Later button enables you to add a highlighted item to your To-Do List for later filing.

Topic list for section: box enables you to list topics in other sections.    (Click the down arrow button, and
then click a section.)

Go Back button redisplays the initial list of Message Sections.

Topic and Messages column headings sort the Section Topics.

Related help topics
Browsing Forum Messages 
Searching for a Message 



Read Page

The Read page lists the topics in a Message Section

You can sort the listed Message Topics by clicking the Topic and Messages column headings.

If you want to redisplay the original list of Message Sections, click Go Back.

If you want to view the topics in another Message Section, select the section from the box beside Topic 
list for sections.    (Click the down arrow button, and then click a section that you want to view.)

What you see on your screen

You will see a different arrangement of buttons depending on whether you are viewing a list of Message 
Sections or a list of Message Topics.

If you are viewing a list of Message Sections you will see the following buttons and other screen 
elements:

Open button lists topics in a highlighted section.

Description button displays a Description of a highlighted section.

File It button opens the Filing Cabinet so that you can store a highlighted entry.

File Later button enables you to add a highlighted item to your To-Do List for later filing.

Section Name, Topics, and Messages column headings (in the Message Sections list) sort the Message
Sections.

If you are viewing a list of Message Topics you will see the following buttons and other screen elements:

Open button lists topics in a highlighted section.

Map button shows the relationships between a highlighted message and other messages in the topic.

File It button opens the Filing Cabinet so that you can store a highlighted entry.

File Later button enables you to add a highlighted item to your To-Do List for later filing.

Topic list for section: box enables you to list topics in other sections.    (Click the down arrow button, and
then click a section.)

Go Back button redisplays the initial list of Message Sections.

Topic and Messages column headings sort the Section Topics.

Related help topics
Browsing Forum Messages 
Searching for a Message 



Read Forum Message Window

The Read Forum Message window displays a Forum message.

You can send a reply to the author of the message, file (save) the message in your Filing Cabinet, and 
view a message map depicting how all the messages in the topic are related.    

You can click the assorted  and 

 buttons to display related messages and Message Topics. You can also press the Enter key on your 
keyboard to advance to the next message in the topic.    If you are unsure about how the next and 
previous messages are related to the current message, click the Map button to view a diagram that shows
message relationships within the topic.

If you want to include some or all of the original message in your reply, first select the text you want 
(before clicking Reply) so that it is highlighted.    Then, when you click Reply, the highlighted text will be 
copied to your reply message within quotation marks, preceded by an introductory phrase mentioning the 
author of the text.

If you want to add the name and address of the message’s author or recipient to your Address Book, click
the Add Address button.

What you see on your screen

 button above Topics displays the previous Message Topic in the list.    (You can also press SHIFT + 
ALT + LEFT ARROW on your keyboard.)

 button above Topics displays the next Message Topic in the list.    (You can also press SHIFT + ALT + 
RIGHT ARROW on your keyboard.)

 button above Messages displays the previous message in the topic.    (You can also press ALT + 
LEFT ARROW on your keyboard.)

 button above Messages displays the next message in the topic.    (You can also press the Enter key 
on your keyboard to advance to the next message, as well as ALT + RIGHT ARROW on your keyboard)

 button above Parent displays the parent message of the 
current message, and then changes (toggles) to a Return button.    The Return button then returns you to 



the child message and changes back to the original arrow button.    (You can also press ALT + UP 
ARROW on your keyboard to display the parent message, and then ALT + DOWN ARROW on your 
keyboard to return to the original, or child, message.)

Reply button displays a window where you can compose and send a reply message.

File It button enables you to save the current message in your Filing Cabinet.

Map button shows the relationships between the message and other messages in the topic.

Delete button removes the message from the Forum Area.    You can only delete online messages that 
are to or from you.

Add Address button lets you add the message sender's address to your Address Book.

Related help topics
Creating a Message 
Replying to a Message 



Map Message Topic Window

The Map Message Topic window shows the relationships between messages in a topic so that you can 
find and open a specific message.

The number of messages in the map is initially what can be accessed in the thread (topic).    From a 
Message Section this would be the number of messages in the Message Topic posted after the last 
message you read in your last visit.    If you are searching for a message, this would be determined by 
your starting date range.

If you click the Map All button, the message map is updated to show all message relationships within the 
topic.    To read a listed message, simply click the message and then click the Open button.

If you see a checkmark, it identifies the message from which you referenced the message map.

Related help topics
Browsing Forum Messages
Replying to a Message 



Create Page

The Create page lists your outgoing Forum messages — those messages which you have composed but 
not yet sent.

You can review, send, and delete listed messages, as well as create new messages.    You can also edit 
messages that you open.

If you want to send more than one listed message, simply select each one before you click Send.    (Hold 
down the Ctrl key on your keyboard while clicking a message to select it.)

What you see on your screen

New button opens a window where you can create and send a Forum message. 

Open button displays a highlighted message so that you can review and change it.

Send button sends a highlighted message and removes it from the Outgoing Messages list.

Send All button sends all messages and removes them from the Outgoing Messages list.

Delete button removes a highlighted message from the Outgoing Messages list.

Topic, To, and Date column headings sort your Outgoing Messages.

Related help topics
Creating a Message 
Replying to a Message 



Create Forum Message Window

The Create Forum Message window enables you to create, send, and file (save) a new message.

To address your Forum message, type the appropriate name and address information or click the 
Recipient button.    If you click the Recipient button and the Forum member to whom you want to send the 
message is listed in your Address Book, you can select the name from the ensuing window.

What you see on your screen

 button displays the previous message in the list.

 button displays the next message in the list.

Send button posts your message in the Forum area and section specified, connecting you to CSi 
automatically if you are currently offline.

Send Later button does not actually send the message, but instead places the message in the Outgoing 
Messages list on the Send page, as well as in your To-Do List.    (You can send it from there whenever 
you like.)

File It button opens the Filing Cabinet so that you can store the message there.

Name box records the recipient name.    If a name you are typing matches one recorded in your Address 
Book, the name will be filled in automatically for you as soon as the match is recognized. 

If you want the message to be available for all Forum members to read, type ALL.    

If you want the message to be visible only to the Forum sysop, type *SYSOP.    

If you want the message to be sent to the attention of the Forum sysop, but also available for all 
Forum member to read, type SYSOP (without the asterisk).

Address box records the recipient address.    (If you want to send your message to ALL, *SYSOP, or 
SYSOP, leave the Address box blank.)

Recipient button opens a window where you can select or specify a recipient.

Options button opens a window where you can specify how your message will be sent. 

Topic box records the topic for your message.

Select Forum and Select Section buttons open windows where you can select the Forum area and 
Forum section to which your message will be sent.

Related help topics
Replying to a Message 



Send To Window

The Send To window enables you to select an address from your Address Book for a Forum message you
are creating.

If you want the message to be available for all Forum members to read, click All.    

If you want the message to be sent to the attention of the Forum sysop, but also available for all 
Forum members to read, click Forum manager (SYSOP) publicly.

If you want the message to be visible only to the Forum sysop, click Forum manager (*SYSOP) 
privately.

If you want to select an address from your Address Book, click Individual, and then click an 
address from the list.    

Related help topics
Creating a Message



Message Options Window

The Message Options window enables you to specify how you want to send your Forum message.

Click the appropriate Message type.    You can send the message as a public message for all Forum 
members to see, as a private Forum message that only the recipient will be able to read, or as a CSi Mail 
message that will be sent to the recipient's CSi mailbox rather than posted on the Forum Message 
Boards.

(Some Forum areas do not allow private Forum messages.)

Related help topics
Posting a Message 
Setting Your Forum Area Preferences 



Search Page

The Search page enables you to search for specific messages in a Forum area.

Define your search using the boxes beside Find messages.    If a box has a down arrow, click the down 
arrow to see a menu of choices, and then click the choice you want.    If a box does not have a down 
arrow, simply click the box, and then type your information.

You can click More to narrow your search.

What you see on your screen

The More and Less buttons control the depth of your search terms.

More button displays additional search terms so that you can narrow your search.    (The More button 
becomes the Less button.)

Less button hides your search terms.    (The Less button becomes the More button.)

Find messages boxes enable you to specify the information required for your search.    Click the arrows 
to see a menu of choices, and then click the choice you want. (Use the boxes to make a sentence 
describing what you want to search for.) 

Search button begins the search.

You will see the following search terms only if you click the More button.

Submitted since area enables you to confine your search to all messages submitted since the date 
shown.    Click the arrows to change the dates. 

In Sections box enables you to confine your search to particular sections.    To select a section to be 
searched, mark its corresponding checkbox. 

All Sections button selects all sections in the list.

None button unselects all sections in the list.

You can also search for Forum messages stored in your Filing Cabinet by accessing the Filing Cabinet.

Related help topics
Browsing Forum Messages
Searching for a Message 
Searching for Items in the Filing Cabinet



Search Page

The Search page enables you to search for specific messages in a Forum area.

Define your search using the boxes beside Find.    If a box has a down arrow, click the down arrow to see 
a menu of choices, and then click the choice you want.    If a box does not have a down arrow, simply click
the box, and then type your information.

You can click Less to hide your search interests.

What you see on your screen

The More and Less buttons control the depth of your search terms.

More button displays additional search terms so that you can narrow your search.    (The More button 
becomes the Less button.)

Less button hides your search terms.    (The Less button becomes the More button.)

Find messages boxes enable you to specify the information required for your search.    Click the arrows 
to see a menu of choices, and then click the choice you want. (Use the boxes to make a sentence 
describing what you want to search for.) 

Search button begins the search.

You will see the following search terms only if you click the More button.

Submitted since area enables you to confine your search to the date range you select.    Click the arrows
to change the dates. 

In Sections box enables you to confine your search to particular sections.    To select a section to be 
searched, mark its corresponding checkbox. 

All Sections button selects all sections in the list.

None button unselects all sections in the list.

You can also search for Forum messages stored in your Filing Cabinet by accessing the Filing Cabinet.

Related help topics
Browsing Forum Messages
Searching for a Message 
Searching for Items in the Filing Cabinet



Read Page

The Read page lists the Library Sections in a Forum area.    

If you open a section, the list of Library Sections is replaced by a list of files within that particular section.

What you see on your screen

You will see a different arrangement or buttons depending on whether you are viewing a list of Library 
Sections or a list of files within a Library Section.

If you are viewing a list of Library Sections you will see the following buttons and other screen elements:

Open button lists topics in a highlighted section.

Description button displays a Description of a highlighted section.

If you are viewing a list of individual files you will see the following buttons and other screen elements:

Open button displays a highlighted file, provided it is a text file or graphics file.    Binary files must be 
retrieved (downloaded) before being opened.

Description button displays a Description of a highlighted file.

Retrieve button lets you save the highlighted file to your computer.

Retrieve Later enables you to add a highlighted item to your To-Do List for later retrieval.

Files in section: box enables you to display files for other sections. (Click the down arrow button, and 
then click a section.)

Go Back button redisplays the initial list of Library Sections.

Title, File Name, Date, Size, and Accesses buttons sort the listed files.

Related help topics
Browsing Forum Libraries 
Viewing a File 



Read Page

The Read page lists the Files in a Forum Library Section.

You can sort the listed files by clicking the Title, File Name, Date, Size, and Accesses column headings.

If you want to retrieve (download) more than one listed file, simply select each one before you click 
Retrieve.    (Hold down the Ctrl key on your keyboard while clicking a file to select it.)

If you want to redisplay the original list of File Sections, click Go Back.    (You might have to use the 
horizontal scroll bar to be able to see the Go Back button.)

If you want to view the topics in another File Section, select the section from the box beside Files in 
section.    (Click the down arrow, and then click a section from the ensuing list.)

What you see on your screen

You will see a different arrangement or buttons depending on whether you are viewing a list of Library 
Sections or a list of files within a Library Section.

If you are viewing a list of Library Sections you will see the following buttons and other screen elements:

Open button lists topics in a highlighted section.

Description button displays a Description of a highlighted section.

If you are viewing a list of individual files you will see the following buttons and other screen elements:

Open button displays a highlighted file, provided it is a text file or graphics file.    Binary files must be 
retrieved (downloaded) before being opened.

Description button displays a Description of a highlighted file.

Retrieve button lets you save the highlighted file to your computer.

Retrieve Later enables you to add a highlighted item to your To-Do List for later retrieval.

Files in section: box enables you to display files for other sections. (Click the down arrow button, and 
then click a section.)

Go Back button redisplays the initial list of Library Sections.

Title, File Name, Date, Size, and Accesses buttons sort the listed files.

Related help topics
Browsing Forum Libraries 
Viewing a File 



File Description Window

The File Description window displays information about a file so that you can evaluate whether or not you 
might want to retrieve (download) it.

You can learn who contributed (uploaded) the file, as well as keywords you might use to find related files 
in other File Libraries.

What you see on your screen

 button displays the previous file in the list.

 button displays the next file in the list.

Open button displays the highlighted file, provided it is a text file, graphics file, or other    file that can be 
so displayed.    (Binary files must be retrieved (downloaded) before being opened.)

Retrieve button lets you save (download) the highlighted file to your hard drive.

Retrieve Later enables you to add a highlighted item to your To-Do List for later retrieval.

Delete button removes the highlighted file from the Forum Area.    You can only delete files that you 
contribute (upload).

Related help topics
Understanding File Types 
Viewing a File 



View File Window

The View File window displays a GIF or other graphic file.

The File and Image menus in the upper left-hand corner of the View File window enable you to save and 
print the file, as well as resize the displayed image.

If you prefer, you can also have a small window ask you whether you want to save the graphic when you 
attempt to close the View File window.    (This preference is controlled by the Prompt to save opened 
graphics checkbox in your General preferences.)

Related help topics
Browsing Forum Libraries 
Searching for a File 



Progress Indicator Window

The Progress Indicator window displays the progress of one or more files you are retrieving 
(downloading) to your computer or contributing (uploading) to CSi.

If a process fails, that particular task is removed from your To-Do List.    To resubmit the task, click Try 
Again.    (If you want to add the task to the To-Do List to process it later, click Try Again Later instead.)

If you want to conclude your CSi session after the last file has been processed, mark the Disconnect 
when done checkbox.

Related help topics
Searching for a File 
Viewing a File 



Create Page

The Create page lists all the files that you have prepared to send (contribute) to a Library Section.

You can send the files according to your preferred order, review and delete the Contribute File Requests 
for the listed files, read File Descriptions, and make new Contribute File Requests.

If you want to send more than one listed file, simply select each one before you click Send.    (Hold down 
the Ctrl key on your keyboard while clicking a message to select it.)

What you see on your screen

New button opens a window where you can indicate a new file to contribute (upload).

Open button enables you to view the highlighted file in its native format.

Description button displays the Contribute File Request information for a highlighted file.

Send button contributes (uploads) the highlighted file to the library. 

Delete button removes the highlighted file from the list.    (It does not delete the file from your computer.)

Title, File Name, Size, and Section Name column headings (in the Outgoing Files list) sort your 
Contribute File Requests.

Related help topics
Contributing a File 
Understanding File Types 



Contribute File Request Window

The Contribute File Request window records information about a file you want to contribute (upload) to a 
Library Section.

Upon completion of this request, you can send (contribute) the file immediately, or you can wait and send 
it later.

What you see on your screen

Send button contributes (uploads) the file to the library.

Send Later button adds the Contribute File Request to the Outgoing Files list on the File Libraries Send 
page, where you can process it according to your preferred timing. (You can send it from there whenever 
you like.)

Local file name box indicates and records the file name (and path).

Select File button displays a window where you can select (open) the file you want to contribute (upload).

Forum file name box indicates the name you want your file to be known by once in the Forum library.

File type box indicates the type of file you are contributing, such as binary or text.    Click the down arrow, 
and then click the type.

Title box indicates the title for the submission.

Keywords box indicates the search terms upon which other members will be able to find your file as a 
result of a file search.    Be sure to separate search terms (keywords) with a single space.

Select Section button enables you to select another Forum Section for your Contribute File Request.

The large box at the bottom of the Contribute File Request window is for your comments about the file, 
perhaps how it should be used, whether it should be treated a special way, and so forth.

Related help topics
Contributing a File 
Understanding File Types 



Search Page

The Search page enables you to search the Library Sections for particular files.

Define your search using the boxes beside Find files.    If a box has a down arrow, click the down arrow to 
see a menu of choices, and then click the choice you want.    If a box does not have a down arrow, simply 
click the box, and then type your information.

You can click More to narrow your search.

What you see on your screen

The More and Less buttons control the depth of your search terms.

More button displays additional search terms so that you can narrow your search.    (The More button 
becomes the Less button.)

Less button hides your search terms.    (The Less button becomes the More button.)

Find files boxes enable you to specify the information required for your search.    Click the arrows to see 
a menu of choices, and then click the choice you want. (Use the boxes to make a sentence describing 
what you want to search for.) 

Search button begins the search.

You will see the following search terms only if you click the More button.

Submitted between boxes enable you to confine your search to a date range you select (click the arrows
to change the date).

Contributed by box records the Member ID number of the individual who contributed (uploaded) the file.

With extension box records the extension of the file you are looking for.

In sections list enables you to confine your search to particular sections.

All button selects all folders in the In Sections list.

None button unselects all folders in the In Sections list.

Related help topics
Marking a File
Searching for a File 



Search Page

The Search page enables you to search the Library Sections for particular files.

Define your search using the boxes beside Find file.    If a box has a down arrow, click the down arrow to 
see a menu of choices, and then click the choice you want.    If a box does not have a down arrow, simply 
click the box, and then type your information.

You can click Less to hide your search interests.

What you see on your screen

The More and Less buttons control the depth of your search terms.

More button displays additional search terms so that you can narrow your search.    (The More button 
becomes the Less button.)

Less button hides your search terms.    (The Less button becomes the More button.)

Find files boxes enable you to specify the information required for your search.    Click the arrows to see 
a menu of choices, and then click the choice you want. (Use the boxes to make a sentence describing 
what you want to search for.) 

Search button begins the search.

You will see the following search terms only if you click the More button.

Submitted between boxes enable you to confine your search to a date range you select (click the arrows
to change the date).

Contributed by box records the Member ID number of the individual who contributed (uploaded) the file.

With extension box records the extension of the file you are looking for.

In sections list enables you to confine your search to particular sections.

All button selects all folders in the In Sections list.

None button unselects all folders in the In Sections list.

Related help topics
Marking a File
Searching for a File 



File Search Result Page

The File Search Result page displays all the files found as a result of a file search.

You can open text files and some graphics file, view Descriptions for all listed files, and retrieve 
(download) one or more files.

If you want to retrieve more than one listed file, simply select each one before you click Retrieve or 
Retrieve Later.    (Hold down the Ctrl key on your keyboard while clicking a file to select it.)

If you want to halt the search for any reason, click Stop.

A tiny icon appears to the left of each file to indicate its type, such as text or graphics. 

What you see on your screen

Open button displays a highlighted file, provided it is text or graphics.    Binary files must    be retrieved 
(downloaded) before being opened.

Description button displays the descriptive information about a highlighted file.

Retrieve button retrieves (downloads) a highlighted file to your computer.

Retrieve Later button adds the retrieval request to your To-Do List, to be processed at a later time.

Delete button removes the file from the list of files.

Stop button ends the current search.

Related help topics
Searching for a File 



Public Rooms Page

The Public Rooms page lists the Public Rooms and how many people are in each one.    

You can join a conversation (participate) or just listen (observe).    You can participate in one room and 
observe another room at the same time too.

All rooms have a tiny icon beside them in the list.    If you are participating in or observing a Public Room, 
a different icon will be placed beside the room in the list.

What you see on your screen

Participate button lets you join in the conversation in the highlighted room.

Observe button lets you read the conversations in the highlighted room without being able to send 
comments.

Room and Members Present column headings (in the Rooms list) sort the Public Rooms. 

Related help topics
Participating in a Conference



Who's Here Page

The Who's Here page lists the names and Member ID numbers of all the people in the area (all Public 
Rooms).    

You can read Member Profiles, add members to your Friends List, and initiate Private and Group Chats.    

If you prefer, you can view only those members who are in your Friends list.    You can also sort the list by 
clicking the Name, Member ID, Room, and Location column headings.

If you want to select multiple members, hold down the Ctrl key on your keyboard while clicking the various
nicknames.

What you see on your screen

Start Private Chat button invites the highlighted people to each join a private conversation (Private Chat) 
with you.

Group Invitation button Invites all highlighted people to join a Group Chat with you.

Member Profile button displays a highlighted person's interests and other member-related information.

Make a Friend button enables you to add a highlighted person to your Friends List.

Nickname, Member ID, Room, and Location column headings (in the Who's Who list) sort the members
listed.

Show friends only checkbox displays only the people you've placed on your Friends List.

Related help topics
Reviewing Your Profile 
Creating a Friends List



Invitations Page

The Invitations page lists all the Group Invitations that have been sent to you while in the area.

You can participate (send comments) in only one Group Chat at a time.    

If you exit a Group Chat, you cannot reenter the group unless you receive a new Group Invitation.

You can sort the Group Invitations by clicking the Name, Member ID, and Received column headings.

What you see on your screen

Participate button lets you join in the Group Chat with the highlighted person.

Member Profile button displays a highlighted person's interests and other member-related information.

Delete button removes the highlighted invitation.

Nickname, Member ID, and Received column headings (in the Group Invitations list) sort the invitations.

Related help topics
Ignoring Invitations 
Setting Your Forum Area Preferences 



Friends Page

The Friends page maintains a list of your Forum area friends -- those people with whom you enjoy 
conversing.    

You can remove people from the list any time.    You can add people to the list only when they are present.

To learn which of your friends are currently in the Forum area, access the Who's Here page, and then 
mark the Show only friends checkbox.

You can sort the Current Friends list by clicking the column headings in the Current Friends list.

What you see on your screen

New button enables you to add a new person to the list.

Member Profile button displays a highlighted person's interests and other member-related information.

Delete button removes a highlighted person from your Friends List.

Nickname and Member ID column headings (in the Current Friends list) sort your friends.

Related help topics
Setting Your Forum Area Preferences 



See More Messages Window

The See More Messages window controls which messages are available to you during your Forum 
session.

What you see on your screen

Created after option enables you define the set of messages as those posted after a given date and time.
(Click the arrows and type the information in the respective boxes.)

Whose message number is higher than option enables you to define the set of messages as those 
whose message number is higher than the number specified in the corresponding box.    (Type the 
desired number in the box.)

Reset messages displayed on my next visit checkbox indicates whether you want to keep these 
settings for your next Forum session.

Related help topics
Browsing Forum Messages 
Searching for a Message 



Forums Page

The Forums page (within the Preferences window) enables you to customize your Forum sessions.    

You can specify the name you want to go by in a Forum area, whether to automatically file (save) copies 
of messages that you send, and more.

What you see on your screen

Automatically file sent messages checkbox indicates that the Forum messages you send will also be 
filed in the Filing Cabinet.

Select Folder button enables you to indicate the folder where Forum messages that you send are to be 
filed.

Set Conferencing Preferences button lets you customize your conference activity in Forum Areas.

Retrieve Forum Logos checkox indicates whether you want CompuServe 3 to automatically retrieve 
(download) any Forum Logos to your computer the first time you access a Forum area. 

Forums visited box displays the Forum areas in which you are currently a member.

Delete button removes a highlighted Forum area from the Forums visited box.

Name to use while conferencing box records the name by which other people will know you when you 
participate (send comments) in a conference (chat).

Related help topics
Auto-Filing Sent Forum Messages
Choosing Your Forum Conference Nickname
Setting Your Forum Area Preferences



File Abstracts Window

The File Abstracts window displays a description of a file in a Forum library to help you decide whether 
you want the file.

Related help topics
Finding a File 
Understanding File Types 



Conference Center Desktop



Public Rooms Page

The Public Rooms page lists the conference rooms and how many people are in each one.    

You can join a conversation (participate) or just listen (observe).    You can participate in one room and 
observe another room at the same time too.

All rooms have a tiny icon beside them in the list.    If you are participating in or observing a Public Room, 
a different icon will be placed beside the room in the list.

What you see on your screen

Participate button lets you join in the conversation in the highlighted room.

Observe button lets you read the conversations in the highlighted room.

Related help topics
Ignoring Invitations 
Voting in a Conference



Who's Here Page

The Who's Here page lists the names and Member ID numbers of all the people in the Conference Center
(all Public Rooms).    

You can read Member Profiles, add members to your Friends List, and initiate Private and Group Chats.    

If you prefer, you can view only those members who are in your Friends list.    You can also sort the list by 
clicking the Name, Member ID, Room, and Location column headings.

If you want to select multiple members, hold down the Ctrl key on your keyboard while clicking the various
nicknames.

What you see on your screen

Member Profile button displays a highlighted person's interests and other member-related information.

Group Invitation button invites all highlighted people to join a Group Chat with you.

Start Private Chat button invites the highlighted people to each join a private conversation (Private Chat) 
with you.    Each private conversation is in a separate window.

Show friends only checkbox displays only the people you've placed on the Friends List.

Related help topics
Ignoring Invitations 
Voting in a Conference
Creating a Friends List



Invitations Page

The Invitations page lists all the Group Invitations that have been sent to you while in the Conference 
Center.

You can participate (send comments) in only one Group Chat at a time.    

If you exit a Group Chat, you cannot reenter the group unless you receive a new Group Invitation.

You can sort the Group Invitations by clicking the Name, Member ID, and Received column headings.

What you see on your screen

Participate button lets you join in the Group Chat with the highlighted person.

Member Profile button displays a highlighted person's interests and other member-related information.

Delete button removes the highlighted invitation.

Related help topics
Ignoring Invitations 
Voting in a Conference



Friends Page

The Friends page maintains a list of your Conference Center friends.    You can remove people from the 
list anytime.    You can add people to the list only when they are present.

Friends are those people with whom you enjoy chatting.

To learn which of your friends are currently in the Conference Center, access the Who's Here page, and 
then mark the Show only friends checkbox.

You can sort the Current friends list by clicking the Name, Member ID, and Room, and Location column 
headings.

What you see on your screen

Add button enables you to add a new person to the list.

Member Profile button displays a highlighted person's interests and other member-related information.

Related help topics
Ignoring Invitations 
Voting in a Conference
Creating a Friends List



Lobby Page

The Lobby page welcomes you to the Conference Center Desktop.

The Conference Center Desktop enables you to participate (send comments) in and observe (watch) 
online conferences.

What you see on your screen

Announcement button displays Announcements relevant to the Chat community.

Related help topics
Ignoring Invitations 
Voting in a Conference



Read Announcement Window

The Read Announcement window displays important Conference Center information.

You can file (save) the Announcement in your Filing Cabinet for later reviewing.

What you see on your screen

File It button opens the Filing Cabinet so you can store the Announcement for later viewing.

File menu enables you to print the Announcement.

Related help topics
Ignoring Invitations 
Voting in a Conference



Set Conferencing Preferences

The Set Conferencing Preferences window enables you to customize how you interact in a Forum 
conference.

Set Conferencing preferences enable you to customize your Forum conferences.    You can specify 
preferences related to your Prohibited List, recording conversations (chats), ignoring invitations, and 
retrieving graphics and sound files.

What you see on your screen

The Record conversations area influences your ability to make a conference transcript (log file).

Record chat text checkbox indicates whether you wish to automatically record (log) your ongoing 
conferences.

Add new text to the room's log file checkbox indicates whether you wish for your ongoing conferences 
to be appended to a single chat log (transcript) file.

The Add prohibited members to list area controls how long a person will stay on the Prohibited List once 
you add a name to it.

Permanently option excludes the person indefinitely by adding him or her to the Prohibited Members List 
as permanent

For today only option excludes the person only for the current session by adding them to the Prohibited 
Members List as temporary

Ask me option displays a window where you can confirm that you want the person added to the 
Prohibited Members List as permanent

The Ignore invitations for area enables you to prevent invitations from displaying on your screen.

Private chats checkbox indicates whether you wish to block (prevent) invitations to chat one-on-one with 
someone (Private Chat).

Groups checkbox indicates whether you wish to block (prevent) invitations to chat in a group (Group 
Chat).

The Retrieve area controls your level of interaction in a conference.

Graphics files checkbox indicates whether you want to be able to receieve grahics files that might be 
sent to you while in Chat.

Sound files checkbox indicates whether you want to be able to receieve sound files that might be sent to 
you while in Chat.
 
Save all retrieved files checkbox indicates whether you want to save any graphics files or sound files 
that are sent to you while in Chat.

Related help topics



Setting Chat Preferences



Chat Rooms 



Public Rooms Page

The Public Rooms page welcomes you to the Chat Desktop, displaying your nickname (if you have one), 
and enables you to read the latest Chat Announcements.

The Chat Desktop enables you to participate (send comments) in and observe (watch) chats 
(conversations) in Public Rooms, invite friends to participate in a Group Chat, and chat privately (one-on-
one) in a Private Chat.

What you see on your screen

Read Announcements button displays Announcements relevant to the Chat community.

Related help topics
Listing All Available Public Rooms
What is Chat?



Define Nickname Window

The Define Nickname window (or Change Nickname window) enables you to provide or change the 
nickname you want to use.

The text box records the name by which other people will know you during your Chat session.    If you do 
not currently have a nickname, your User ID number will be displayed in the text box.

A nickname cannot be obscene or offensive to the average person.

If you want to make the nickname you provide permanent, mark the Always use this nickname checkbox.  
(You will only see this checkbox upon arriving at the Chat desktop.)

If you are in Chat you can redisplay this window by choosing Change Nickname from the Chat menu.    
You can also review, provide, or change nickname information for your Chat sessions at the Chat page. 
(Choose Preferences from the Access menu, and then click the Chat top tab to get there.)

Related help topics
Nickname Rules
What is Chat?



Read Announcements Window

The Read Announcements window displays important Chat information.

You can file (save) the Announcement for future review.    Choose the Save As command from the File 
menu.

Related help topics
Listing All Available Public Rooms
Participating in a Public Chat
What is Chat?



Welcome Page

The Welcome page lists the Public Rooms and how many people are in each one.    

You can join a conversation (participate) or just listen (observe).    You can participate in one room and 
observe another room at the same time too.

All rooms have a tiny icon beside them in the list.    If you are participating in or observing a Public Room, 
a different icon will be placed beside the room in the list.

What you see on your screen

Participate button displays the conversation in the highlighted room, enabling you to send comments to 
other participants if you wish.

Observe button displays the conversation in the highlighted room, enabling you to observe (watch) the 
conversation, but without participating.    (No one else knows you are observing.)

Related help topics
Observing a Chat without Contributing
Participating in a Public Chat



Chat Window

The Chat window displays an online conversation, or chat, underway in a Public Room.    

You can participate in the conversation by typing a comment in the Send box, and then clicking Send.

You can also learn who else is participating in the room, as well as make a transcript file of the ongoing 
conversation.

What you see on your screen

Who's Here button displays the nicknames and Member ID numbers of people participating in the room.

Record Text button saves the ongoing conversation in a transcript file on your computer.    You will be 
given the option of creating and naming your transcript file or appending the conversation to an existing 
transcript file.    The Record Text button changes to Stop Recording when you click it.    (Click the Stop 
Recording button to conclude recording.) The name of the transcript file will be shown on the status bar.

Send button posts any text in the box as a comment.

Related help topics
Concluding a Public Chat
Logging a Public Chat



Who's Here Window

The Who's Here window displays the nicknames and Member ID numbers of people participating in a 
public or Group Chat.    If a person leaves the chat (conversation), his or her nickname and Member ID 
number instantly disappear from the list.

You can also read Member Profiles, add members to your Friends list, and initiate Private and Group 
Chats.

The Who's Here window will not tell you whether anyone is simply observing the chat.

What you see on your screen

Private Chat button sends a Private Invitation to a highlighted member in the Current Members list asking
if the person would like to participate in a private conversation (Private Chat) with only you.

Group Invitation button sends a Group Invitation to a highlighted member in the Current Members list 
asking if the person would like to participate in a Group Chat with you and other members to whom you 
send Group Invitations. If you want to invite more than one member, simply select each one before you 
click Group Invitation.    (Hold down the Ctrl key on your keyboard while clicking a nickname to select it.)

Member Profile button displays summary information about a person, such as where the person is 
connecting to CSi from, as well as interests or hobbies the person wants you to know about.

Make Friend button enables you to add one or more highlighted members to your personalized Friends 
List.

Nickname and Member ID column headers sort the listed members.

Related help topics
Listing All Available Public Rooms
Setting up a Group Chat
Setting up a Private Chat
Creating a Friends List



Observe Window

The Observe window enables you to view a conversation in a Public Room without anyone knowing you 
are there.

You cannot participate (send comments) in a conversation that you are observing.    You can observe only
one room at a time.

You can observe (watch) the conversation in one Public Room while participating (sending comments) in 
another.    You can learn who is participating in the room (but not who is observing), as well as make a 
transcript file of the ongoing conversation.

What you see on your screen

Who's Here button displays the nicknames and Member ID numbers of people participating in the room.

Record Text button saves the ongoing conversation in a transcript file on your computer.    You will be 
given the option of creating and naming your transcript file or appending the conversation to an existing 
transcript file.    The Record Text button changes to Stop Recording when you click it.    (Click the Stop 
Recording button to conclude recording.) The name of the transcript file will be shown at the bottom of the
Observe window.

Related help topics
Logging a Public Chat
Participating in a Public Chat



Who's Here Page

The Who's Here page lists the nicknames and Member ID numbers of all the people in the entire Chat 
area (all Public Rooms).    

You can read Member Profiles, add members to your Friends List, and initiate Private and Group Chats.    

If you prefer, you can view only those members who are in your Friends list.    You can also sort the list by 
clicking the Nickname, Member ID, Room, and Location column headings.

If you want to select multiple members, hold down the Ctrl key on your keyboard while clicking the various
nicknames.

What you see on your screen

Private Chat button send a Private Invitation to a highlighted member in the Who's Here list asking if the 
person would like to participate in a private conversation (Private Chat) with only you.

Group Invitation button sends a Private Invitation to a highlighted member in the Who's Here list asking 
if the person would like to participate in a Group Chat with you and other members to whom you send 
Group Invitations.

Member Profile button displays summary information about a person, such as where the person is 
connecting to CSi from, as well as interests or hobbies the person wants you to know about.

Make Friend button enables you to add one or more highlighted members to your personalized Friends 
List.

Show friends only checkbox displays only the people you've placed on your special Friends List.

Related help topics
Listing All Available Public Rooms
Setting up a Group Chat
Setting up a Private Chat
Creating a Friends List



Member Profile Window

The Member Profile window displays summary information for a CSi member, including the current 
nickname (or name) being used, the person's Member ID number, location (calling site), and general 
interests that the person wants you to know about.

You can add the person to your Address Book by clicking the Add Address button.

What you see on your screen

Name box displays the person's nickname for the current chat session.

Member ID box displays the person's Member ID number.

Location box displays information about where the person is connecting from.    (This information will be 
abbreviated.)

Interests box displays interests or hobbies that the person wants others to know about.

Add Address button displays a window from which you can quickly add the person to your Address 
Book.

Related help topics
Creating a Friends List
Creating a Prohibited Users List



Group Chat Window

The Group Chat window displays the conversation underway in a Group Chat.    

To participate in the ongoing conversation, type a comment in the Text to Send box, and then click Send.

You can participate in only one Group Chat at a time.    When you join a group, you leave the old group.

You can also learn who else is participating in the group, as well as make a transcript file of the ongoing 
conversation.

What you see on your screen

Who's Here button displays the nicknames and Member ID numbers of people participating in the group.

Record Text button saves the ongoing conversation in a transcript file on your computer.    You will be 
given the option of creating and naming your transcript file or appending the conversation to an existing 
transcript file.    The Record Text button changes to Stop Recording when you click it.    (Click the Stop 
Recording button to conclude recording.) The name of the transcript file will be shown on the status bar.

Send button posts any text in the box next to Send as a comment.

Related help topics
Concluding a Group Chat
Logging a Public Chat



Private Chat Window

The Private Chat window is your control center for all your ongoing Private Chats.    Each person to whom
you have sent a Private Chat Invitation, as well as each person who has sent you one, is listed in the 
Current Chats box.

Only one Private Chat is displayed at a time.    To display a particular conversation, click the appropriate 
nickname in the Current Chats box. 

To participate in the ongoing conversation, type a comment in the Text to Send box, and then click Send.

You can add members to your Friends List, as well as to your Prohibited List.    You can also make a 
transcript file of the ongoing conversation.

What you see on your screen

Goodbye button ends your Private Chat with the member whose name is selected in the Current Chats 
list.

Prohibit button removes the highlighted name from your Current Chats list and adds it to your Prohibited 
List.

Record Text button saves the ongoing conversation in a transcript file on your computer.    You will be 
given the option of creating and naming your transcript file or appending the conversation to an existing 
transcript file.    The Record Text button changes to Stop Recording when you click it.    (Click the Stop 
Recording button to conclude recording.) The name of the transcript file will be shown at the bottom of the
Private Chat window.

Make Friend button enables you to add one or more highlighted members to your personalized Friends 
List.

Current chats lists members to whom you sent a Private Invitation and those who have sent one to you.

From and Text received from displays the names and corresponding comments of members 
participating in the chat conversation. If you want to invite more than one member, simply select each one
before you click Group Invitation.    (Hold down the Ctrl key on your keyboard while clicking a nickname to 
select it.)

Send button transmits the comments you have typed in the box next to Send.    Once sent, you can view 
them in the Text received from box.

The box next to the Send button displays a comment you want to send.

Related help topics
Concluding a Private Chat



Private Chat Invitation Window

The Private Chat Invitation window gives you the option of participating in or refusing a Private Chat.    

If you do not want to be bothered by invitations to participate in Private Chats you can choose Ignore all 
invitations from the appropriate menu (Chat, Forums, or Conference) to prevent invitations from 
displaying for just the current session.]

If you are in Chat you can also mark the Private chats checkbox in your Chat preferences.    (Choose 
Preferences from the Access menu, and then click the Chat top tab to get there.)

What you see on your screen

Accept button closes the window and opens the Private Chat window where you can begin your 
conversation.

Decline button closes the window and sends the person a notice that you declined the invitation.

Related help topics
Accepting a Private Chat Invitation
Setting up a Private Chat



Prohibit Member Window

The Prohibit Member window enables you to decide how completely you want to exclude a person's 
presence once he or she is added to the Prohibited List.    

The name of the person in question is shown beside Prohibited member.

Click the option you feel is appropriate for the person, and then click OK.

What you see on your screen

Permanently - member is restricted until removed from list option excludes the person indefinitely by 
adding him or her to the Prohibited List as permanent.

Temporarily - member is restricted for this session only option excludes the user(s) only for the 
current session by adding them to the Prohibited List as temporary.

Related help topics
Creating a Friends List
Finding Who's Here



Invitations Page

The Invitations page lists all the Group Invitations that have been sent to you during the current Chat 
session.

You can participate (send comments) in only one Group Chat at a time.    

If you exit a Group Chat, you cannot reenter the group unless you receive a new Group Invitation.

You can sort the Group Invitations by clicking the Nickname, Member ID, and Received column headings.

What you see on your screen

Participate button lets you join in the Group Chat for the highlighted invitation.

Member Profile button displays summary information about a highlighted person.

Delete button removes a highlighted invitation.

Related help topics
Ignoring Invitations
Setting Chat Preferences



 Friends Page

The Friends page maintains a list of your Chat friends.    You can remove people from the list anytime.    
You can add people to the list, as well.

Friends are those people with whom you enjoy chatting.

To learn which of your friends are currently in Chat, access the Who's Here page, and then mark the 
Show Friends only checkbox.

You can sort the Current Friends list by clicking the Nickname and Member ID column headings.

What you see on your screen

New button opens a window where you can add a current user to your Friends List.

Member Profile button displays summary information for a highlighted person.

Delete button deletes a highlighted friend from the Current Friends box.

Related help topics
Creating a Friends List
Creating a Prohibited Users List



Select Friends Window

The Select Friends window enables you to select one or more people that you want to add to your 
Friends List.

If you want to add several friends, simply hold down the Control key while you click on each one.    When 
you are through, click OK.

Related help topics
Creating a Friends List
Finding Who's Here



Prohibited Members List Window

The Prohibited Members List window lists all the people you would like to avoid, whose comments you do
not want to be displayed on your screen.

Such people will not be listed in group and room windows or in Who's Here lists.

The tiny icons to the left of the listed nicknames denote whether a person is on your Prohibited List 
permanently or only temporarily.

What you see on your screen

New button opens a window where you can select a user to add to the Prohibited Members List.

Make Permanent button ensures that a highlighted user is blocked from every Group Chat you 
participate (send comments) in.

Delete button deletes a highlighted user from the list.

Related help topics
Creating a Prohibited Users List
Setting Chat Preferences



Select Ignore Window

The Select Ignore window enables you to select one or more nicknames that you want to add to your 
Prohibited List.

If you want to prohibit several members, simply select each one before you click OK. 

Related help topics
Creating a Prohibited List
Setting Chat Preferences



Moderated Chat Window

The Moderated Chat window displays the conversation underway in a Moderated Conference.

You can learn who else is attending the conference.    

In a Moderated Conference, the Conference Moderator determines the level of participation.    Depending 
on the Conference Moderator and nature of the conference, you might be able to participate in Private 
and Group Chats, ask a question, vote on one or more issues, change your ballot for an issue called for 
earlier in the conference, and view a preliminary tally of submitted ballots.

What you see on your screen

Who's Here button displays the names and Member ID numbers of people in the conference.

Send button transmits the comments you have typed in the box next to Send.    After you click Send, you 
can view your comments in the Text received from box.

Record Text button saves the ongoing conversation in a transcript file on your computer.    You will be 
given the option of creating and naming your transcript file or appending the conversation to an existing 
transcript file.    The Record Text button changes to Stop Recording when you click it.    (Click the Stop 
Recording button to conclude recording.) The name of the transcript file will be shown at the bottom of the
Moderated Chat window.

Depending on the moderator and type of Moderated Conference you are participating in, you might see 
one or more of the following buttons along the top of your Moderated Chat window:

Ask button lets you type and submit a question.    If you have already submitted a question, the Ask 
button enables you to withdraw the current question you submitted, or to submit a new question.    You 
cannot have more than one question submitted at a time.

Tally button displays the current count of the votes.    Once the actual vote is concluded, the moderator 
will post the voting results, and the Tally button will no longer be available.

Related help topics
Contacting CSi Members 
Voting in a Conference



Ask Window

The Ask window enables you to type and submit a question during a Moderated Conference.    

If you have already submitted a question, you can use this window to withdraw the question or replace the
question (resubmit.)

You can submit only one question.    If you withdraw that question to edit and resubmit, the resubmitted 
question is placed at the bottom of the question list.

What you see on your screen

If you are submitting a question for the first time you will see only the following button:

Submit button sends the question to the chat moderator.

If you have already submitted a question and the question is currently in the question queue awaiting 
response, you will see the following two buttons:

Withdraw button sends the moderator a request to remove the question from the waiting list.

Resubmit button sends the new question to the moderator.

Related help topics
Contacting CSi Members 
Voting in a Conference



Vote Window

The Vote window registers your vote in a conference vote.

Click the appropriate answer to the voting issue, and then click Cast Vote.

What you see on your screen

Issue box displays the issue to be voted on.

Choose box enables you to vote on the issue.    Depending on the type of issue and how the issue is 
worded, you might be asked to choose just one response, or you might be allowed to mark several.

Cast Vote box places your vote in the ballot box.

Related help topics
Attending a Moderated Conference 
Contacting CSi Members 



Vote Tally Window

The Vote Tally window displays preliminary status and current results of a vote.

Once a vote is concluded, the Conference Moderator will display the results for all to see.

What you see on your screen

Update button displays the latest tally results.

Change Vote button lets you cast a vote in a conference vote.

Related help topics
Attending a Moderated Conference 
Contacting CSi Members 



Group Invitation Window

The Group Invitation window enables you to participate in (or refuse) a Group Chat.

If you do not want to be bothered by invitations to participate in Group Chats you can do one of the 
following:

Choose Ignore all Invitations from the Chat menu to prevent invitations from displaying for just 
the current session.

Mark the Groups checkbox in your Chat preferences.    (Choose Preferences from the Access 
menu, and then click the Chat top tab to get there.)

What you see on your screen

Accept button closes the window and opens the Group Chat window where you can begin your 
conversation.

Decline button closes the window and sends the person a notice that you declined the invitation.

Related help topics
Ignoring Invitations 
Ignoring Group Chat Invitations



Chat Page

The Chat page (within the Preferences window) enables you to customize how you interact with the Chat 
area.

Chat preferences enable you to customize your Chat sessions.    You can specify a Chat nickname, as 
well as preferences related to your Prohibited Users List, recording Chat conversations, ignoring 
invitations, and retrieving graphics and sound files.

What you see on your screen

Nickname indicates the name other people see when you are active in chat.

Display all private chats in one window checkbox indicates whether you want to view all chats in the 
same window (one at a time).

The Record conversations area influences your ability to make a chat transcript (log file).

Record chat text checkbox indicates whether you wish to automatically record (log) your ongoing chats.

Add new text to the room's log file checkbox indicates whether you wish for your ongoing chats to be 
appended to a single chat log (transcript) file.

The Add prohibited members to list area control how long a person will stay on the Prohibited Members 
List once you add them to it.

Permanently option excludes the person indefinitely by adding him or her to the Prohibited Members List 
as permanent

For today only option excludes the person only for the current session by adding them to the Prohibited 
Members List as temporary

Ask me option displays a window where you can confirm that you want the person added to the 
Prohibited Members List as permanent

The Ignore invitations for area enables you to prevent invitations from displaying on your screen.

Private chats checkbox indicates whether you wish to block (prevent) invitations to chat one-on-one with 
someone (Private Chat).

Groups checkbox indicates whether you wish to block (prevent) invitations to chat in a group (Group 
Chat).

The Retrieve area controls your level of interaction in a conference.

Graphics files checkbox indicates whether you want to be able to receive grahics files that might be sent 
to you while in Chat.

Sound files checkbox indicates whether you want to be able to receive sound files that might be sent to 
you while in Chat.
 



Save all retrieved files checkbox indicates whether you want to automatically save any graphics files or 
sound files that are sent to you while in Chat.    (You can still save manually such files if you do not mark 
the Save all retrieved files checkbox.)

Related help topics
Nickname Rules
Setting Chat Preferences



Save Conversation Window

The Save Conversation window lets you name a transcript file of a recorded chat.

Each Chat window uses a different file.    If you select an existing file, you must confirm whether to append
to the existing file or replace it with a new file.

What you see on your screen

Save in enables you to select a location in which to save the conversation file.

Up One Level button displays the preceding level in the directory tree.

Create New Folder button adds a new folder to the selected location.

List button displays the names of the folders in the selected location.

Details button displays additional information for the listed folders.

Name, Size, Type, and Modified buttons sort the listed folders. 

File name enables you to type a name for the saved file in the text box.

Save as type enables you to select a type for the saved file.

Save button saves the conversation file.

Related help topics
Logging a Public Chat
Setting Chat Preferences



Tracking Chat Window

The Tracking Chat window enables you to watch who enters and leaves chats, switches locations, and 
changes nicknames.

Once you see the Tracking Chat window, you cannot prevent it from displaying simply by closing it.    
Instead you must choose Tracking from the Chat menu.    

(A check mark to the left of the Tracking command indicates that tracking is currently turned on.)

What you see on your screen

Options button opens a window where you can control the types of tracking activities displayed.

Track only friends checkbox indicates whether you want to track everyone in Chat, or only your friends.

Related help topics
Ignoring Someone



Define Tracking Options Window

The Define Tracking Options window enables you to control the types of tracking activities displayed in 
the Track Chat window.

If you want to track only those people on your Friends List, mark the Track only friends checkbox.

What you see on your screen

Entering checkbox indicates whether you want to track people joining the chat area.

Leaving checkbox indicates whether you want to track people exiting the chat area.

Changing rooms checkbox indicates whether you want to track people moving to different areas.

Changing nicknames checkbox indicates whether you want to track people changing their nicknames.

Track only friends checkbox indicates whether you want to track everyone in Chat, or only your friends.

Related help topics
Ignoring Someone



Home Desktop 



 

Main Menu Page

The Main Menu page enables you to explore CSi and the Internet.

What's New displays a window that lets you review the latest news summaries on CSi.

Table of Contents displays a window that lets you explore CSi services and events.

Internet starts the Internet Web browser so that you can explore the Internet.

Chat takes you to the CompuServe Chat page.

Forums and Communities takes you to the CompuServe Help Forum.

If you are interested in getting your Mail, creating and sending Mail, consulting your electronic Address 
Book, and so forth, click the Mail Center side button (along the left side of your CompuServe window) 
rather than one of the buttons on the Main Menu page.

Similarly, if you want to search for a CSi service or Internet Web page, click the Find side button.

Related help topics
Accessing a Service 
Accessing the CompuServe Directory 
Learning About CSi Services 
Reviewing Recent Destinations 



Welcome to CompuServe Interactive Page

The Welcome to CompuServe Interactive page enables you to become a CSi member.    You must be a 
CSi member in order to connect to CSi.

You will need your Offer Code to complete the Signup process.    For Signup assistance in the U.S. and 
Canada, call (800) 336-6823.    If you need additional help during the Signup process, you can also 
contact the CompuServe office nearest you for assistance.

If you are already a CSi member, click Setup to review or provide your connection information.

Related help topics
Accessing a Service 
Setting Connection Preferences

List of CompuServe Offices
Argentina 
Australia/New Zealand 
Austria 
Chile 
Colombia 
France 
Germany 
Hong Kong 
Hungary 
Israel 
Japan 
Mexico 
Netherlands
Singapore 
South Africa 
South Korea 
Switzerland 
Taiwan 
United Kingdom 
United States/Canada 
Venezuela 
Other Countries



Go Page

The Go page lists the CSi and Internet locations you have accessed recently so that you can access them
again easily.

If you attempt to go to an invalid location, you will be asked if you want to search for related CSi services. 

To go to a location in the Services Recently Visited list, click the location, and then click Go.    If you want 
to go to a location that is not listed, type the information (the CSi service name or Internet Web page) in 
the box beneath the Add to Favorite Places button, and then click Go.

What you see on your screen

Go button takes you to the highlighted location in the Services Recently Visited list, or to the location 
specified in the box below the Add to Favorite Places button.    You can specify a CSi service name or 
Internet destination address.

CompuServe Directory button displays a comprehensive listing of CSi services.

Add to Favorite Places button add a highlighted location in the    Services Recently Visited list to your 
Favorite Places.

Delete button removes a highlighted location from your Recent Places list.

Name, Location, and Date Visited column headings (in the Services Recently Visited list) sort the listed 
services.

Related help topics
Accessing a Service 
Grouping Your Favorite Services 



Favorite Places

The Favorite Places page (window) enables you to keep track of and easily go to your favorite locations 
on CSi and the Internet.

Once you add a location to your Favorite Places, it is listed on the lower portion of the Favorite Places 
page along with the date you last visited it and the current location's priority.

You can open an entry in the list to review or change information about it.    You can also delete entries 
and create new ones.

If you want to assign priority to a favorite location so that it appears at the top of the list, click the location 
in the list, and then click Open.

What you see on your screen

New button enables you to add an entry to your Favorite Places.

Open button enables you to review or change information about a highlighted location in the Favorite 
Places list, such as the name, address, or priority.

Go button takes you to a highlighted location in the Favorite places list.

Delete button removes a highlighted location from the Favorite places list.

Name, Last Visit, and Priority column headings (in the Favorite places list) sort your listed locations.

Related help topics
Finding CSi Services 
Reviewing Recent Destinations



Define Favorite Place Window

The Define Favorite Place window enables you to add a location to your Favorite Places or change 
information about one you have already added.

You can also add locations to your Favorite Places from the Go page, as well as from the window that 
displays the results of a Services search.

What you see on your screen

Name box records or indicates the name that you want to appear under Location in the Favorite places 
list.

Location box records or indicates the CSi service name or Internet address information.

Priority box records or indicates your preferred priority for the entry so that you can sort the entries in the 
Favorite places list accordingly.    (Higher numbers indicate higher priorities.)

Related help topics
Accessing a Service 
Finding CSi Services



Services Page

The Services page (or Services Search window) enables you to search for services on CSi, as well as 
Web pages on the Internet.

Type a subject in the box provided.

Use the Search button to find services on CSi, and the Start Internet Search button to find services and 
locations on the Internet.

What you see on your screen

Search button begins a search for CSi services related to the subject you type in the box provided.

Start Internet Search button begins a search for Internet sites related to the subject you type in the box 
provided.

Go button takes you to a highlighted service in the Services list.    (You will not see the Go button until 
services are found.)

Add button adds a highlighted service in the Services list to your Favorite Places. (You will not see the 
Add button until services are found.)

Stop button halts the search.    (The Stop button disappears upon completion of the search.)

Service and Location column headings (in the Services list) sort the listed services.

Related help topics
Finding CSi Services 
Learning About CSi Services 



Files Page

The Files page enables you to go to the File Finder area, where you can find files anywhere on CSi.

To reach the File Finder area, click the File Finder button at the bottom of the Files page.

Related help topics
Finding a File 
Learning About a File 



Members Page

The Members page (or Membership Search window) enables you to search for and learn about CSi 
members.

Define your search using the boxes provided.    You must provide a last name.    The other search boxes 
are optional.

What you see on your screen

Search button begins a search for a member based on the information you provide.

Add to Address Book button opens a window where you can add a highlighted member (found by your 
search) to your Addrses Book.    (You will not see the Add to Address Book button until members have 
been found.)

Last name, First name, City, State, and Country boxes record or indicate information on which to base 
the member search.

First Name, Last Name, City, State, Country, and Member ID column headings sort the members 
found as a result of your search.

Related help topics
Contacting CSi Members
Learning About CSi Members 



Member Search Results Window

The Member Search Results window lists the results of a member search.    

You can learn about the members listed and add them to your Address Book.

Related help topics
Contacting CSi Members
Finding CSi Members



Search Filing Cabinet Window

The Search Filing Cabinet window enables you to find items in your Filing Cabinet, such as news stories, 
Forum and CSi Mail messages, and other text documents.

Define your search using the boxes beside Find.    If a box has a down arrow, click the down arrow to see 
a menu of choices, and then click the choice you want.    If a box does not have a down arrow, simply click
the box, and then type your information.

If you want to search for Forum Messages or Mail Messages via sender or recipient, do not choose All 
items when defining your search.    Instead choose Mail messages or Forum messages as appropriate. 
Note also that you cannot search for Forum messages stored in your Filing Cabinet via message number.

You can click Less to hide your search interests.

When you click Search you might see a small confirmation window asking whether or not recently filed 
documents should be indexed before the actual search is started.    If you want such documents to be 
included in the search, be sure to click Yes in the confirmation window.

What you see on your screen

The More and Less buttons control the depth of your search terms.

More button displays additional search terms so that you can narrow your search.    (The More button 
becomes the Less button.)

Less button hides your search terms.    (The Less button becomes the More button.)

Find boxes enable you to specify the information required for your search.    Click the arrows to see a 
menu of choices, and then click the choice you want.    (Use the boxes to make a sentence describing 
what you want to search for.) 

Search button begins the search.

You will see the following search terms only if you click the More button.

Submitted boxes enable you to confine your search to a date range you select (click the arrows to 
change the dates). 

Received from Forum(s) enables you to confine your search to particular Forum areas.

Stored in Folders enables you to confine your search to particular Filing Cabinet folders.

All buttons select all items in the respective boxes.

None buttons unselect all folders in the respective boxes.

Related help topics
Auto-Filing Sent Forum Messages
Auto-Filing Sent Mail 
Searching for Items in the Filing Cabinet



Search Filing Cabinet Window

The Search Filing Cabinet window enables you to find text articles, news stories, Forum and CSi Mail 
messages, and other text documents currently stored in your Filing Cabinet.

Define your search using the boxes beside Find.    If a box has a down arrow, click the down arrow to see 
a menu of choices, and then click the choice you want.    If a box does not have a down arrow, simply click
the box, and then type your information.

If you want to search for Forum Messages or Mail Messages via sender or recipient, do not choose All 
items when defining your search.    Instead choose Mail messages or Forum messages as appropriate. 
Note also that you cannot search for Forum messages stored in your Filing Cabinet via message number.

You can click More to narrow your search.

When you click Search you might see a small confirmation window asking whether or not recently filed 
documents should be indexed before the actual search is started.    If you want such documents to be 
included in the search, be sure to click Yes in the confirmation window.

What you see on your screen

The More and Less buttons control the depth of your search terms.

More button displays additional search terms so that you can narrow your search.    (The More button 
becomes the Less button.)

Less button hides your search terms.    (The Less button becomes the More button.)

Find boxes enable you to specify the information required for your search.    Click the arrows to see a 
menu of choices, and then click the choice you want.    (Use the boxes to make a sentence describing 
what you want to search for.) 

Search button begins the search.

You will see the following search terms only if you click the More button.

Submitted boxes enable you to confine your search to a date range you select (click the arrows to 
change the dates). 

Received from Forum(s) enables you to confine your search to particular Forum areas.

Stored in Folders enables you to confine your search to particular Filing Cabinet folders.

All buttons select all items in the respective boxes.

None buttons unselect all folders in the respective boxes.

Related help topics
Auto-Filing Sent Forum Messages
Auto-Filing Sent Mail
Searching for Items in the Filing Cabinet



Search Results Window

The Search Results window lists the results of your Filing Cabinet search.

You can open and delete items.

If you want to delete more than one item, simply select each one before you click Delete.    (Hold down the
Ctrl key on your keyboard while clicking an item to select it.)

What you see on your screen

Open displays a highlighted document.

Delete removes a highlighted document from your Filing Cabinet.    A small window will be displayed 
asking you to confirm your intention.

Subject, Folder, and Date topic headings sort the documents.

Related help topics
Auto-Filing Sent Forum Messages
Auto-Filing Sent Mail 



Pref and Settings 



General Page

The General page (within the Preferences window) enables you to define a default Internet Web browser 
to be used for your CompuServe 3 sessions, as well as additional preferences related to saving opened 
graphics, displaying graphic versions of menus, displaying warning windows, and changing default 
directories.

What you see on your screen

Use external Internet browser checkbox indicates whether you want to use a different Web browser 
than the one provided during installation of your CompuServe 3 software as the default browser.    For 
example, if you are running Windows 95 and want to use an external browser application instead of the 
CompuServe 3 embedded Internet browser, mark the Use external Internet browser checkbox.

Select button opens a window where you can specify the Web browser (in the box provided) you want to 
define as the default. 

Prompt to save opened graphics checkbox enables you to receive a prompt each time you close a 
graphic asking if you want to save the graphic on your computer.

Retrieve graphic versions of menus checkbox enables you to view many CSi menus in an enhanced 
form with colorful graphics and buttons.    Such graphics will be downloaded to your computer.    Thus, if 
you find that the downloading process is taking too much time, you might want to disable (unmark) this 
checkbox and view text-only menus (without colorful graphics) instead.

Display confirmation messages button enables you to view warning messages in tiny windows, 
whenever appropriate, throughout your CompuServe 3 session, so that you can be aware of events that 
may not be otherwise apparent.

Set Directories button opens a window where you can view and change the default CompuServe 3 
directories (folders).

Related help topics
Defining Your Default Internet Browser
Requesting a Save Opened Grahics Prompt
Retrieving Graphic Versions of Menus
Displaying All Warning Dialogs



Set Directories Window

The Set Directories window lists the support folders used by your CompuServe 3 software so that you can
review or change them.

What you see on your screen

Change button opens a window where you can specify a new directory for a highlighted item.

Related help topics
Defining Default Directories
Setting General Preferences



Connection Page

The Connection page (within the Preferences window) shows your current connection information so that 
you can review or modify it.

Your connection information must be accurate in order for you to connect to CSi.

What you see on your screen

Connection box displays the current Connection set.    You can define more than one Connection set so 
that you can select an alternate set from this list when appropriate.    For example, you might want to use 
a different connection set when working from home or at your office.

Add button opens a new window where you can name a new connection set.

Delete button removes the highlighted Connection set.

Member name box indicates the name you want to use when using CSi.

Member ID box indicates the CSi account ID number you want to use when using CSi.

Password box records your CSi Password.    You do not have to provide your password (optional).    If 
you do not provide a password, you will be prompted for it each time you connect.    If you provide a 
password, it must match your official CSi Password; otherwise you will not be able to connect to CSi.    (If 
you want to change your CSi Password, you must go to the PASSWORD area on CSi.    Changing the 
password recorded in your Connection Preferences will not actually change your official CSi Password.)

Phone box records the telephone number required for you to connect to CSi.    This is not your home 
telephone number.    If you need to dial a number to reach an outside line, put a comma after the number.  
(If you are using dial-up networking, you will not see an Access phone box, but will see a Configure phone
button instead.)

Configure phone button enables you to review or change your access phone number if you are using 
dial-up networking to connect to CSi.    (You will see this button only if you are using dial-up networking.)

Port box indicates the communications or COM port you want to use to connect to CSi.

Port speed box indicates the highest baud rate at which your modem will transmit and receive 
information.

Network box determines the communications network that will be used for your CSi connection.

Dial type box determines your preferred dial type when connecting to CSi.

Connect Using box indicates that you have dial-up networking installed on your computer and enables 
you to select your phone book entry.

Define Advanced button allows you to review or provide additional logon information that might be 
necessary or desireable for your particular network.    For example, you might want to receive notice in the
event that your modem carrier signal is lost.

Define Modem button allows you to review or define your modem settings.



Winsock Connection Type box enables you to select your preferred Winsock connection type.    If you 
already have an existing TCP/IP connection to the Internet and want to continue to use it, such as via a 
LAN or other preferred existing Internet connectivity software, select default Winsock.    If you want to use 
dial-up networking to establish a TCP/IP connection using your phone line and modem with Windows 95, 
select Dial-up Networking.    (Dial-up Networking is the default.)

Related help topics
Changing Your Password
Creating a Connection Set
Setting Connection Preferences
Setting General Preferences



Terminal Page

The Terminal page (within the Preferences window) enables you to customize your terminal emulation 
sessions by controlling the size of your scrollback buffer.

What you see on your screen

Size of scrollback buffer box specifies how many lines of screen activity will be preserved by 
CompuServe 3 for logging, printing, or reviewing purposes at any given time in terminal emulation.    You 
may specify any number between 25 and 500.

Strip High Bit checkbox indicates whether text displayed on your screen in terminal emulation will 
include language-specific characters, such as letters with accents and umlauts.

Related help topics
Defining the Terminal Emulation Scrollback Buffer Size
Selecting Your Terminal Emulation Type
Automating Keystrokes in Terminal Emulation
Creating a Terminal Emulation Log File
Printing a Terminal Emulation Session



Fonts/Sound Page

The Fonts/Sound page (within the Preferences window) determines whether you will hear sounds for 
particular events during your CompuServe 3 session, as well as how characters, such as letters and 
numbers, look on your screen.

Each time you click an item in the Item box, the font currently used for that item is displayed in the 
Sample region for you to evaluate.

What you see on your screen

Item box lists the categories whose fonts you can change.

Change button opens a window where you can select a new font for a highlighted item in the Item box.

Default button restores the original (default) font for a highlighted item in the Item box.

Sample area shows an example of the selected font.

Play sounds checkbox indicates whether you will hear sounds for particular events during your 
CompuServe 3 session.

Related help topics
Changing the Appearance of Letters on Your Screen
Setting Your Fonts Preferences



New Session Name Window

The New Session Name window records the name for a new connection set.

Related help topics
Creating a Connection Set
Deleting a Connection Set



Modem Control Settings Window

The Modem Control Settings window enables you to define how your modem will interact with CSi.

You can specify the type of modem you will be using, the individual modem control strings, and whether 
modem security should be employed.

What you see on your screen

Modem box enables you to select a modem type. (Click the down arrow button, and then click a modem 
type.)

Initialize shows your modem's initialization command string.    The default string (Hayes) is: AT S0 Q0 V1

Prefix is the prefix string, also known as the attention command. The default string (Hayes) is: AT

Dial Tone is the string that initiates tone dialing. The default string (Hayes) is: DT

Reset is the string to reset the modem. The default string (Hayes) is: Z

Escape is the string to issue an Escape command. The default string (Hayes) is: +++.    (If your modem 
uses MNP or ARC error control protocols, this string will be: +++ also disconnects)

Connect is the string or phrase displayed when connection is established. The default string (Hayes) is: 
CONNECT

Suffix is the correct string to terminate a command. The default string (Hayes) is: ^M

Dial Pulse is the string to initiate pulse dialing. The default string (Hayes) is: DP

Hang Up is the string to free the telephone line.      The default string (Hayes) is: H

Acknowledge is the correct string or phrase displayed when a command is successfully received by the 
modem. The default string (Hayes) is: OK

Failure is the string or phrase to be displayed when there is no connection or the signal stops. The 
default string (Hayes) is: NO CARRIER

Speaker On enables you to turn on the speaker of a Hayes-compatible modem by marking the checkbox.

Reset button changes these settings back to the original    (default) ones.

Set Security button enables you to type in the User ID number and Password for a modem that is 
password-protected.

Related help topics
Conducting a Silent Modem Sequence
Specifying Modem Security



Define Advanced Settings Window

The Define Advanced Settings window enables you to specify logon parameters for rare situations, 
specify your preferred working language, and so forth.

What you see on your screen

Language sent from CompuServe to box indicates your working language    (Click the down arrow, and 
then click the language you want.)

Country Setting indicates the country from which you are connecting to CSi.

Logon Parameters records special instructions appended to your User ID number.    You should type 
information only when so directed by a CompuServe Customer Service representative.

HMI protocol time-out    records your preferred time-out value.    If you frequently experience time-out 
problems, you can increase this value, but large values may also waste time and money.

Number of retries records your preferred retry scenario.    If you like, you can specify the number of times
the connection process should be initiated in the box beside Number of retries should a dialing-related 
problem occur.    A reasonable value is 3.    (If you select Direct under Dial Type in the Connection Settings
window, there is no need to specify a value for Redial Attempts.)

Enable carrier detect checkbox indicates whether your connection software will attempt to detect when 
your modem loses carrier.    Your modem must support this feature in order for this option to work reliably. 

Disable password encryption checkbox enables you to turn off password encryption if you are using an 
external dialer.

Eicon X.121 box records the X.121 calling address for your system if you are using an Eicon X.121 
Address.

Related help topics
Defining Logon Parameters
Defining a Time-Out Value
Enabling Carrier Detect



Define LAN Settings Window

The LAN Support Settings window enables you to connect to CSi through a local area network.

The LAN Settings window that you see may require different information depending on whether you are 
connecting through NASI for Netware Connect, INT14, or NCSI or NASI without Netware Connect.

Related help topics
Defining NASI for Netware Connect
Defining INT14 Information
Defining NCSI or NASI without Netware Connect



News Desk



Lobby Page

The Lobby page is your starting place in the News Desktop.

The name of the particular news service you are in is displayed above the colorful Service Logo.

Related help topics
Opening a Folder
Searching for a News Article



Read Announcements Window

The Read Announcements window displays important news information.

You can print the Announcement, as well as send a copy of it in a Mail or Forum message.    (Choose the 
appropriate command from the File menu in the upper left-hand corner of the Read Announcements 
window.)

Related help topics
Learning About CSi Services 
What is the Executive News Service?



Read Page

The Read page lists the news folders available to you along with the type, status, and expiration date of 
each folder, as well as the number of articles (stories) in each.    

Only folders that you can browse will appear here.

If a folder is opened, the list of news folders is replaced by a list of articles in that folder.

What you see on your screen

Open button lists articles (stories) in a highlighted folder.

File It button opens the Filing Cabinet so that you can store the contents of a highlighted folder in the 
Filing Cabinet.

File Later button places the highlighted folder in your To-Do List, where you can retrieve the folder later, 
even after leaving the News Desktop.

Empty button deletes the contents of a highlighted Personal Folder.

Folder Name, Type, Articles, Status, and Expiration column headings (in the Folder List) sort the news 
folders.

Related help topics
Opening a Folder
Retrieving an Entire Folder



Read Page

The Read page lists the titles of all the articles (stories) in a folder along with the date and news sources 
of each.

If you want to redisplay the original list of news folders, click Go Back.    

If you want to view the contents of another folder, select it from the box beside Articles in folder. (Click the 
down arrow button, and then click a folder that you want to open.)

What you see on your screen

Open button displays the highlighted article (story).

File It button opens the Filing Cabinet so that you can store a highlighted article (story).

File Later button places the highlighted entry in your To-Do List, where you can retrieve the article later, 
even after leaving the News Desktop.

Delete button removes a highlighted article (story) from the Personal Folder.    You can delete articles 
(stories) only in a Personal Folder.

Empty button deletes all articles from the folder.

Go Back button redisplays the initial list of news folders.

See More button displays additional articles that are in the folder.    If there are more than 40 articles in 
the folder, you will see only the first 40 articles until you click the See More button.

Title, Date, and Source column headings sort the listed articles.

Related help topics
Opening a Folder
Retrieving an Entire Folder



Read Article Window

The Read Article window displays a news article (story).

You can file (save) the article in your Filing Cabinet for later reviewing, as well as delete (remove) it from 
the Personal Folder.

What you see on your screen

File It button opens the Filing Cabinet so that you can copy the article (story) to a folder there.

Delete button removes the article (story) from the Personal Folder and closes the Read Article window.

displays the next article (story), if there is one, in the opened folder.

displays the previous article (story), if there is one, in the folder.

Related help topics
Saving a News Article 
Printing a News Article 



Search Page

The Search page enables you to search for specific news articles (stories) from the News desk.

Define your search using the options provided.    The date selection and search terms will be based on the
capabilities of the folder you select.

Articles that match your search interests will be listed in a special window.

What you see on your screen

Search button begins a search for articles (stories) containing the information you specify.

Find articles in box enables you to identify the folder you want to search.    Only folders that are 
searchable will appear in this list.    Click the down arrow button, and then click a folder.)    Depending on 
the folder you select, you might see additional boxes.    (If a box has a down arrow, click the down arrow 
to see a menu of choices, and then click the choice you want.    If a box does not have a down arrow, 
simply click the box, and then type your information.)    

Submission date boxes enable you to search on all dates or confine your search to the date range you 
select (Click the arrows to change the dates). 

Sources enables you to confine your search to particular news sources.

You can also search for News articles (stories) stored in your Filing Cabinet by accessing the Filing 
Cabinet.

Related help topics
Printing a News Article 
Saving a News Article 
Searching for Items in the Filing Cabinet



Search Results Window

The Search Results window displays one or more news articles (stories) that were found as a result of a 
search.

What you see on your screen

Open button displays a highlighted article (story).

File It button opens the Filing Cabinet so that you can file (save) a highlighted article (story) for later 
viewing. 

File Later button marks a highlighted article (story) for later retrieval by adding it to your To-Do List where 
you can process it at your convenience.

Stop button halts the ongoing search. 

Title, Date, and Source column headings sort the listed articles.

Related help topics
Searching for a News Article
What is the Executive News Service?



Create Folders Page

The Create Folders page (window) enables you to create, review, and modify a Personal Folder.

You can create a maximum of three Personal Folders in the Executive News Service.

What you see on your screen

New button opens a window where you can create and set up a Personal Folder.

Change button displays information about a highlighted Personal Folder so that you can modify it.

Empty button clears all articles (stories) from a highlighted Personal Folder.

Delete button removes a highlighted Personal Folder from the list.

Folder Name, Articles, Status, and Expiration column headings sort the listed folders.

Related help topics
Deleting a Folder 
Creating a Folder 
Modifying a Folder



Define Personal Folder Window

The Define Personal Folder window enables you to create or modify a Personal Folder.

You can provide up to seven clipping terms.    Articles (stories) that match the selection interests you 
define will be clipped and put into the ensuing Personal Folder as they are released on the newswires.

(You create your clipping terms by typing the appropriate verbiage in the boxes shown in the Clipping 
Terms area.    Use the various menus to create a sentence for your search term.)

What you see on your screen

Folder name records the name for the folder.

Clipping terms enables you to create up to seven search terms by selecting phrases from the boxes 
(click the down arrow buttons, and then click the appropriate phrases) and typing related information in 
the associated text box (click the box before you begin typing).

enables you to review or provide additional clipping terms.

enables you to review previous clipping terms.

Look for articles in enables you to identify which news feeds you want to screen for articles (stories).

Select button opens a window where you can select one or more news feeds to screen for articles 
(stories).

Expiration dates enables you to indicate when the folder will expire and how long articles (stories) will be
held in it.

Related help topics
Creating a Folder 
Modifying a Folder



Select Sources Window

The Select Sources window lists the news sources available to you when searching for news articles 
(stories).

Initially all news sources are set to be searched.    To prevent a news source from being searched, click it 
so that there is no x in its corresponding checkbox. 

Related help topics
Creating a Folder 
Searching for a News Article



News Page

The News page (within the Preferences window) determines whether particular news folders will be 
displayed when you use a news service.

Public Folders are created and maintained by CompuServe.    Personal Folders are created and 
maintained by you in special news services, such as the Executive News Service.

What you see on your screen

Public Folders checkbox determines whether public-oriented news folders, such as Reuters Headlines 
or World News, are made available at the News Desk.

Personal Folders checkbox determines whether your Personal Folders, such as Widget Articles from 
Mom or My Favorite Bogus Editorials, are made available at the News Desk.

Delete all retrieved articles checkbox indicates whether CompuServe 3 will delete a story from a 
Personal Folder after you retrieve (download) it.

Related help topics
Requesting that Retrieved News Articles be Removed from Folders
What is the Executive News Service?



Misc Pages and Windows 



Remaining F1 Topics



Filing Cabinet Window

The Filing Cabinet window (page) lists all the folders in your Filing Cabinet.    You can use your Filing 
Cabinet to store documents, such as Mail messages, Forum messages, text articles, and news stories.

If you open a folder, the list or folders will be replaced by a list of documents within that particular folder.

You will always see at least three permanent folders (Incoming Messages, Outgoing Messages, and Copy
of Sent Messages) in your Filing Cabinet.    You cannot delete or rename permanent folders.

What you see on your screen

You will see a different arrangement or buttons depending on whether you are viewing a list of Filing 
Cabinet folders or a list of documents within a folder.

If you are viewing a list of folders you will see the following buttons and other screen elements:

New button opens a window so that you can add a folder.

Open button displays the contents of a highlighted folder.

Rename button opens a window where you can change the name of a highlighted folder.    Only non-
permanent folders can be renamed.

Search button opens a window where you can conduct a search for a specific document.

Delete button removes a highlighted folder.    Only non-permanent folders can be deleted.

If you are viewing a list of individual documents you will see the following buttons and other screen 
elements:

Open button displays a highlighted document.

Search button enables you to search for a specific document in your Filing Cabinet that might not be 
readily accessible.

Delete button deletes a highlighted document.

Items in Folder box enables you to view the contents of another folder.    (Click the down arrow, and then 
click a folder.)

Go Back button redisplays the list of Filing Cabinet folders.

Title, Source, Date, and Size column headings sort the documents in the folder.

Related help topics
Filing an Incoming Message 
Retrieving Message Topics 



Filing Cabinet Window

The Filing Cabinet window (page) lists all the items in a folder. You can open (read) and delete items.    
You can also conduct a full-text search to find items that are not immediately visible.

If you want to redisplay the original list of folders, click Go Back.

If you want to view the topics in another folder, select the folder from the box beside Items in folders.    
(Click the down arrow, and then click the folder you want.)

If you want to delete more than one item, simply select each one before you click Delete.    (Hold down the
Ctrl key on your keyboard while clicking an item to select it.)

What you see on your screen

You will see a different arrangement or buttons depending on whether you are viewing a list of Filing 
Cabinet folders or a list of documents within a folder.

If you are viewing a list of folders you will see the following buttons and other screen elements:

New button opens a window so that you can add a folder.

Open button displays the contents of a highlighted folder.

Rename button opens a window where you can change the name of a highlighted folder.    Only non-
permanent folders can be renamed.

Search button opens a window where you can conduct a search for a specific document.

Delete button removes a highlighted folder.    Only non-permanent folders can be deleted.

If you are viewing a list of individual documents you will see the following buttons and other screen 
elements:

Open button displays a highlighted document.

Search button enables you to search for a specific document in your Filing Cabinet that might not be 
readily accessible.

Delete button deletes a highlighted document.

Items in Folder box enables you to view the contents of another folder.    (Click the down arrow, and then 
click a folder.)

Go Back button redisplays the list of Filing Cabinet folders.

Title, Source, Date, and Size column headings sort the documents in the folder.

Related help topics
Filing an Incoming Message 
Retrieving Message Topics 



Rename Folder Window

The Rename Folder window records a name for a Filing Cabinet folder that you are renaming.

The Folder name you specify cannot be the same as that of an existing folder.

Related help topics
Auto-Filing Sent Mail
Retrieving Message Topics 



Add Folder Window

The Add Folder window records a name for a Filing Cabinet folder that you are creating.

The Folder name you specify cannot be the same as that of an existing folder.

Related help topics
Auto-Filing Sent Mail
Retrieving Message Topics 



Search Results Window

The Search Results window lists the results of your Filing Cabinet search.

You can open and delete items.

If you want to delete more than one item, simply select each one before you click Delete.    (Hold down the
Ctrl key on your keyboard while clicking an item to select it.)

What you see on your screen

Open displays a highlighted document.

Delete removes a highlighted document from your Filing Cabinet.    A small window will be displayed 
asking you to confirm your intention.

Subject, Folder, and Date topic headings sort the documents.

Related help topics
Auto-Filing Sent Forum Messages
Auto-Filing Sent Mail



File Item Window

The File Item window enables you to select or create a Filing Cabinet folder for a document that you want 
to save.    

Click the appropriate folder in the Folders listbox, and then click File It.

If you want to create a folder for the item, click New Folder before looking for the folder in the Folders 
listbox.

If you mark the Delete original checkbox, the original item will be deleted once it has been copied (filed) to
the selected folder.

Related help topics
Filing an Incoming Message 
Retrieving Message Topics 



To-Do List

The To-Do List page (window) lists any pending tasks for your current CompuServe 3 session so that you 
can review or process them all at once.

(Pending tasks are ones that you previously elected to postpone until a later time, such as retrieving 
perhaps dozens of Forum Message Topics and news articles (stories), as well as preparing numerous 
Contribute File Requests and Forum messages that you want to send.)

Items are added to the To-Do List whenever you click a File Later, Retrieve Later, or Send Later button in 
your CompuServe 3 session, such as when you elect to retrieve (download) later a Forum file or news 
article.

A tiny icon placed to the left of an item in the Queued Items list indicates whether the item is scheduled to 
be retrieved or sent.

If you want to process more than one item, simply select each one before you click the appropriate 
button.    (Hold down the Ctrl key on your keyboard while clicking an item to select it.)

What you see on your screen

Process Next button begins the send or retrieval process, as appropriate, for the next item in the Queued
Items list.

Remove button deletes a highlighted item (removes it from the To-Do list).

Process All button performs all the send (upload) and retrieve (download) requests in the Queued Items 
list.

Related help topics
Marking a File for Later Retrieval 
Retrieving Message Topics 



Weather Window

The Weather window enables you to view weather information worldwide.

Weather reports are provided by the National Weather Service and Accu-Weather.

What you see on your screen

Get Weather button displays a weather report based on the information specified in the City, 
State/Province, and Country boxes.    (The weather report is displayed in the lower part of the Weather 
window.)

City box indicates the city for which you want a weather report.    Click the down arrow, and then click the 
city you want.    If a desired city is not on the list, you can type it in the City box.

State/Province box records the appropriate state or provincial two-letter postal abbreviation (not the full 
name).

Country box records the country.

View Maps button opens a window where you can view regional weather maps and weather reports.

Related help topics
Accessing a Service 
Finding CSi Services 



Maintain Folders Window

The Maintain Folders window lists your Quotes Folders.    Each Quotes Folder is made up of one or more 
issue (ticker) symbols.

You can open a Quotes Folder to view the latest quotes information for the issues in that folder at the 
Stock Quotes window.

You can also create, rename, and delete folders.    (My Quotes is a default folder.) 

You cannot delete a folder if it is the last (only) folder.

What you see on your screen

Add button displays a window where you can add a folder.    

Rename button displays a window where you can rename a folder.

Delete button removes a highlighted folder.

Name and Issues column headings sort your Quotes Folders.

Related help topics
Financial Portfolio
Finding CSi Services 



Add Issue Window

The Add Issue window records the issue symbol for an issue that you want to add to a Quotes Folder.

Be sure to specify only an issue symbol in the Issue symbol box.    Do not specify a CUSIP number.

If you need to learn (find) an issue symbol, click the Look Up button.

Related help topics
Financial Portfolio
Finding CSi Services 



Define Folder Window

The Define Folder window records a name for a Quotes Folder that you are creating.

There is no limit to the number of Quotes Folders that you can define in the Stock Quotes window.    Each 
folder that you define can have up to 75 issue symbols.

Related help topics
Financial Portfolio
Finding CSi Services 



Stock Quotes Window

The Stock Quotes window lists quotes information for a Quotes Folder.    You can add issues to the list, as
well as delete issues from the list.    You can also view a price volume graph for one or more listed issues, 
and view any recent news stories for an issue..

You can view a list of all your Quotes Folders, as well as create, rename, and delete Quotes Folders, at 
the Maintain Folders window.    (Click the Edit Folders button to go there.)

If you want to view the quotes information for issues in another folder, select the folder from the box 
beside Issues in folders. (Click the down arrow button, and then click a folder that you want to open.)

What you see on your screen

New button enables you to add an issue to the opened folder.

Update button displays the latest information for all issues in the current folder.

View News button displays current news stories (if there is current news available) about a highlighted 
issue.    If there is news, there will be a picture of a tearsheet at the far right of the updated listing for the 
issue. 

Chart Issue button enables you to view a price volume graph for a highlighted issue.

Delete button removes a highlighted issue from the opened folder.    If you want to delete more than one 
listed issue, simply select each one before you click Delete.    (Hold down the Ctrl key on your keyboard 
while clicking an issue to select it.)

Issues in folders: box enables you to view the contents of another folder. (Click the down arrow button, 
and then click a folder.)

Edit Folders button displays a list of your Quotes Folders.

Iss..., Volume, High, Low, Last, Change, and Update column headings sort the listed issues.

Get Quote button displays a stock quote for the issue (ticker) symbol shown in the Issue box.    (You type 
the ticker symbol there before you click the Get Quote button.)

Related help topics
Financial Portfolio
Finding CSi Services 



Financial Portfolio Window

The Financial Portfolio window enables you to create and maintain a record of your stock purchases and 
produce a report analyzing their market performance.

If you open a folder, the list of folders will be replaced by portfolio information about that particular folder.

What you see on your screen

You will see a different arrangement or buttons depending on whether you are viewing a list of Portfolio 
Folders or a list of issue reports within a Message Topic.

If you are viewing a list of Portfolio Folders you will see the following buttons and other screen elements:

New button displays a window where you can define a portfolio folder.

Open button displays current quote information for all the issue symbols within a highlighted folder.

Delete button removes an entry.    If you want to delete more than one listed folder, simply select each 
one before you click Delete.    (Hold down the Ctrl key on your keyboard while clicking a folder to select it.)

Rename button enables you to change the name of a Portfolio Folder.

Name and Issue column headings sort the Portfolio Folders.

If you are viewing a list of issue reports you will see the following buttons and other screen elements:

New button enables you to add an issue to the opened Portfolio Folder.

Update button refreshes the detail shown with updated information.

Issues View button opens a window where you can view detail information for all issues within a folder.

Issues in Folder box enables you to display the contents of another portfolio folder. (Click the down 
arrow, and then click a folder.)

Go Back button redisplays the initial list of folders.

Related help topics
Finding CSi Services 
Stock Quotes



Add/Edit Issue Window

The Add/Edit Issue window records information about an issue that you want to add to a portfolio folder.

Be sure to include the issue symbol (do not use the CUSIP number), number of units (shares), cost per 
unit (price you paid for each share), and date of purchase.

Related help topics
Finding CSi Services 
Stock Quotes



Financial Portfolio Window

The Financial Portfolio window shows the detail information for all issues within a folder.

If you want to redisplay the original list of folders, click Go Back.

If you want to view portfolio information about another folder, select the folder from the box beside Issues 
in folders. (Click the down arrow button, and then click a folder that you want to open.)

What you see on your screen

You will see a different arrangement or buttons depending on whether you are viewing a list of Portfolio 
Folders or a list of issue reports within a Message Topic.

If you are viewing a list of Portfolio Folders you will see the following buttons and other screen elements:

New button displays a window where you can define a portfolio folder.

Open button displays current quote information for all the issue symbols within a highlighted folder.

Delete button removes an entry.    If you want to delete more than one listed folder, simply select each 
one before you click Delete.    (Hold down the Ctrl key on your keyboard while clicking a folder to select it.)

Rename button enables you to change the name of a Portfolio Folder.

Name and Issue column headings sort the Portfolio Folders.

If you are viewing a list of issue reports you will see the following buttons and other screen elements:

New button enables you to add an issue to the opened Portfolio Folder.

Update button refreshes the detail shown with updated information.

Issues View button opens a window where you can view detail information for all issues within a folder.

Issues in Folder box enables you to display the contents of another portfolio folder. (Click the down 
arrow, and then click a folder.)

Go Back button redisplays the initial list of folders.

Related help topics
Finding CSi Services 
Stock Quotes



Terminal Emulation Window

The Terminal Emulation window enables you to access special services on CSi and other host-based 
computer systems.    

The Terminal menu (on the menu bar at the top of your screen) and the controls along the lower portion of
the window enhance your experience. 

What you see on your screen

File Capture value indicates your file logging status.    (On means that future screen activity will be logged
to a disk file on your computer.)    You can choose Log to File from the Terminal menu to change this 
setting.

Printer Capture value indicates your printing status.    (On means that future screen activity will be 
printed.)    You can choose Log to Printer from the Terminal menu to change this setting.

View Mode value indicates your Capture Buffer status.    (Capture means you are viewing the contents of 
the Capture Buffer.    Terminal means you are not.)    You can choose Capture Buffer and Terminal 
Window respectively from the Terminal menu to change this setting.

VT100 value indicates your terminal emulation mode.    (CIS is intended for normal terminal emulation 
while on CSi.    Full is reserved for accessing services and applications, such as the Internet, that require 
full VT100 terminal emulation.)    You can choose VT100CIS and VT100FULL respectively from the 
Terminal menu to change this setting.

Alt+1, Alt+2, ... Alt+10 are your Alt key combinations.    If defined, you can click them for a shortcut 
command or automated series of keystrokes.    You can choose Function Key Settings from the Terminal
Menu to set these key combinations.

Close button closes the Terminal Emulation window.

Related help topics
Finding CSi Services 
Setting Your Terminal Emulation Preferences



Copy To Window

The Copy To window copies text, such as a weather forecast, portfolio report, or file abstract, to a 
message or file.

Related help topics
Creating a Mail Message 
Paste From



Paste From Window

The Paste From window pastes the contents of a file stored on disk or a document stored in your Filing 
Cabinet, Incoming Messages folder, or Outgoing Messages folder into a message that you are 
composing.

Related help topics
Copy To
Creating a Mail Message 



Toolbar Page

The Toolbar page (within the Preferences window) enables you to insert buttons in your CompuServe 
Toolbar.

What you see on your screen

Available Functions box shows all the available functions.

Functions Displayed box shows the current Toolbar buttons and function assignments.

Insert button adds the highlighted function (and button) from the Available Functions box to the Toolbar 
(unless the button is already there).    (The button will be inserted just below the highlighted function in the
list.)

Insert Services button displays a window where you can add a button to the Toolbar.    You can assign a 
function to the button that is not one of the default ones shown in the Available Functions box by typing it 
in the Insert Services Button window.

Delete button removes the highlighted button from the Functions Displayed box (and the Toolbar.)

Related help topics
Inserting a Toolbar Button
Changing the Way a Toolbar Button Works
Deleting a Toolbar Button



Modify Icons Window

The Modify Icons window enables you to change how a particular button in your CompuServe Toolbar 
works.

Related help topics
Inserting a Toolbar Button
Changing the Way a Toolbar Button Works
Deleting a Toolbar Button



Insert Service Window

The Insert Service window enables you to add a button to the CompuServe Toolbar.

Type the appropriate tool tip wording for the new button in the Name box.    Then type the name of a CSi 
service or the address of an Internet page in the Service box.    

Once you have provided appropriate Name and Service information, click the button (in the Button area) 
that you want to add to the CompuServe Toolbar, and then click OK.

Related help topics
Inserting a Toolbar Button
Changing the Way a Toolbar Button Works
Deleting a Toolbar Button



Manual Connect Window

The Manual Connect window enables you to conduct a manual logon sequence to connect to CSi. 

Related help topics
Setting Connection Preferences
Setting Your Terminal Emulation Preferences



Surcharged WATS Line Window

This window warns you that there is a surcharge for using the 1-800 phone number you are about to dial 
to connect to CompuServe Interactive (CSi).    If there is a local access phone number, you can avoid the 
surcharge by using it instead.

To find out whether you can use a local access phone number, please call 1-800-63-LOCAL (1-800-635-
6225).

Once you have a local access phone number, you can set up CompuServe 3 to dial that number with the 
following procedure:

1 From the Access menu, choose Preferences.

2 In the Connection field, select the connection you want to use.    (To list all the available connections, 
click the arrow at the right.

3 In the Winsock field under Connection Type, select Use Dial Up Networking.

4 Under Phone Number, click the button next to Use custom phone number.

5 In the Phone # field, type your local access phone number. If you need to dial 9 to reach an outside 
line, be sure to prefix the phone number with 9 and a comma (9,).    Do not include your area code 
unless you need to dial it to reach the local access number.

6 Click the OK button.
 



Using the Browser Desktop

Your CompuServe window changes as you explore CSi services and Web pages.

You can click (or double-click in some instances) the colorful graphics and buttons and assorted menu 
topics to view related services and information.

You can use the buttons along the top of your screen to go to other Web pages and CSi services.    

(You can position your arrow cursor over a Toolbar button for a few moments to learn what it represents.)

If you are having trouble getting to a service, click the Go button at the top of your screen, type the name 
of the service, and then click OK.    If the Go feature is unable to locate the service, you will be given the 
opportunity to search for it.

You can also click the Find button to locate services.

What you see on your screen

Page displays the title of the current page.    Click the arrow to view the titles of other pages visited during 
your session.    (You can click a page to go directly to that page too.)

Go button enables you to go directly to a location that you specify.

 button redisplays the page you visited prior to the current page.

 button redisplays the page you visited after the current page.

Working indicator (to the left of the Main Menu button) is visible and animated only when transfer to a 
new page is in progress.

Main Menu button takes you back to the Main Menu page (on the CompuServe 3 Home Desktop.)

File It button opens your Filing Cabinet.

Reload button retrieves graphics for menus.

What's New button displays the latest news highlights with links to the full articles.

Find button enables you to locate services based on a topic that you specify.

Stop button interrupts the retrieval of graphics.    (You will not see this button all the time.)

Related help topics
Internet-Related Forum Areas
Overview of the Internet 



About CompuServe for Windows Box

The About CompuServe for Windows box displays version information for your CompuServe 3 software.

Related help topics
Accessing a Service 
Connection Status
Learning About CSi Services 



Go Window

The Go window enables you to go to locations on CSi and the Internet.

Type the name of a CSi service or the address of an Internet page in the Service box, and then click OK.

If you attempt to go to an invalid location, you will be asked if you want to search for related CSi services. 

Related help topics
Accessing a Service 
Grouping Your Favorite Services 
Learning Service Names



View Image Window

The View Image window displays a graphic file that you have retrieved (downloaded) from CSi to your 
computer.

The title of the window contains the File Name.

The View Image window initially opens in the default size of the graphic image in normal mode.

Related help topics
Finding a File 
Learning About a File 
Understanding File Types 



Learn About Page

A Learn About page displays summary information about the desktop you are using, such as when you 
are in a Forum area or Chat.

Many Learn About pages display a list of help topics.    To view help for a listed topic, click the topic, and 
then press the Enter key on your keyboard.

Related help topics
Learning About a File 
Learning About CSi Members 
Learning About CSi Services 



View Connection Information Window

The View Connection Window displays information about your current CSi connection, such as your baud
rate and accumulated connect time.

If there is critical alert information about your current CSi session, it will be displayed in the box below 
Last system alert.

What you see on your screen

Port ID value shows your current communications port information.

Baud rate value shows your current port speed at which data will be transmitted over your 
communications line.

Session name value shows the particular connection set you are using to connect to CSi.

Accumulated connect time shows how long you have been connected to CSi during your current 
CompuServe 3 session (since you last started up CompuServe 3). 

Reset button resets the Accumulated connect time value to zero.

Since shows the date and time when the accumulated connect time began.

Last system alert shows whether a system alert has been issued concerning your connection session.    
If an alert has been issued, relevant information will be displayed in the box below Last system alert.

Related help topics
Changing Your Communications Port
Setting Connection Preferences



Unconditional Shutdown Window

The Unconditional Shutdown Window informs you that your CompuServe 3 software must be shut down 
due to an unrecoverable (unknown) conflict.    

Once the program has been shut down, simply restart your CompuServe 3 software.

Related help topics
Disconnect
Exit



Leave Window 

The Leave Window informs you that you are leaving an area.

Mark the Always ask me this checkbox if you always want to see the Leave confirmation window 
whenever you leave an area.

Related help topics
Disconnect
Exit
Leave



Text View Window

The Text View Window displays a text article.

Related help topics
Participating in a Conference 
Attending a Moderated Conference 



Agreement Window

The Agreement Window is displayed the first time you start up your CompuServe 3 software.

You must click Yes to agree to the terms before you can begin using the CompuServe 3 software.



CompuServe Learn About Page

The CompuServe Learn About Page introduces you to CSi.    You can click each of the buttons to learn 
about related services.

You can also access the CompuServe Directory, a listing of hundreds of services and Forum areas on 
CSi. 



Parental Controls Page

The Parental Controls page enables you to go to the CompuServe Parental Controls Center, where you 
can limit what your children can do on CSi and the Internet.

To reach the CompuServe Parental Controls Center, click the Parental Controls button at the bottom of 
the Parental Controls page.

Related help topics
Accessing a Service 
Overview of the Internet 
What is a Forum Area?



Article Window

The Article window displays a text or HTML (Internet) article that is stored in your Filing Cabinet.

The title of the window contains the article name.

Related help topics
Finding Web Sites 
What is HTML?



Select Forum Window

The Select Forum window lists the Forum areas in which you are currently a member.

Click the Forum area to which you want to contribute (upload) your file or message, and then click OK.

Related help topics
Contributing a File 
Learning About a File 
Understanding File Types 



Select Section Window

The Select Section window lists the sections in a Forum area to which you might want to contribute 
(upload) your file.

Click the Forum section to which you want to contribute your file or message, and then click OK.

Related help topics
Contributing a File 
Learning About a File 
Understanding File Types 



Read Messages Window

The Read Messages window enables you to process your messages.



Member Profile Window

The Member Profile window displays information about a CSi member.

You can add the person to your Address Book by clicking the Add Address button.

Related help topics
Adding Member Information to Your Address Book 
Contacting CSi Members 
Learning About CSi Members 



Membership Search Results Window

The Membership Search Results window shows the results of a Forum member search.

To view additional information about a listed member, click the member name, and then click the Open 
button.

To add a listed name to your Address Book, click the member name, and then click the Add to Address 
Book button.

Related help topics
Adding Member Information to Your Address Book 
Contacting CSi Members 
Learning About CSi Members 



Change Member Profile Window

The Change Member Profile Window enables you to review and edit your member entry information.

You can specify interest keywords that others can use to locate you.

Related help topics
Adding Member Information to Your Address Book 
Contacting CSi Members 
Learning About CSi Members 



Lockout Message Window

The Lockout Message window informs you that you have been locked out of the current Forum area.

You will have to contact the sysop of the Forum area to learn what to do next.

Related help topics
Learning About CSi Members 
Posting a Message 
What is a Forum Area?



Clear Folder Window

The Clear Folder window enables you to remove items from a folder.

Related help topics
Auto-Filing Sent Forum Messages
Auto-Filing Sent Mail 



Add Entries to Address Book Window

The Add Entries to Address Book window enables you to make an Address Book entry directly from a 
Forum message or a CSi Mail message.

For each person you want to add to your Address Book, click the name (in the Names box), type a 
comment in the Comments on this entry box (optional), and then click the Add button.    (The name will be 
removed from the Names box.)

When you have finished adding all the names you want, click the Done button.

Related help topics
Accessing the Address Book
Changing an Address Book Entry 
Copying Address Information to the Address Book
Deleting an Address Book Entry 



Select Recipients Window

The Select Recipients window lists the contents of your Address Book so that you can select one or more 
addresses for your Recipient List.

If you want to search for a CSi member who is not in your Address Book, click the Search Members 
button.

If you want to include several addresses from your Address Book, simply select each one before you click
OK.    (Hold down the Ctrl key on your keyboard while clicking an address to select it.

Related help topics
Addressing a Mail Message 
Attaching a File to a Mail Message
Sending a Mail Message 



Select Entry from Address Book Window

The Select Entry from Address Book window enables you to select one or more addresses from your 
Address Book for a Mailing List that you are creating.

If you want to include more than one address from your Address Book, simply select each one before you
click OK.    (Hold down the Ctrl key on your keyboard while clicking a message to select it.)

Related help topics
Accessing the Address Book
Addressing a Mail Message 
Attaching a File to a Mail Message



Function Key Settings Window

The Function Key Settings window enables you to customize your online CSi session.    You can assign a 
series of keystrokes or commands that you use frequently to up to ten Alt key combinations.

Type the sequence of keystrokes you want to automate in the appropriate Key Definition box.    The 
definition can be up to 80 characters.

You can type a label for the Alt key combination in the corresponding Key Label box.    Whenever the key 
combination is available to you, rather than the default Alt wording at the bottom of your screen, you will 
see the label you assigned.

When typing your sequence of keystrokes, to designate pressing the Enter key, type ^M.    To designate a 
new line, type ^J.

Your changes will be recorded when you click OK.

Related help topics
Defining the Terminal Emulation Scrollback Buffer Size
Setting Your Terminal Emulation Preferences
Selecting Your Terminal Emulation Type



Connect Query Window

The Connect Query window enables you to conduct a manual logon sequence with CSi. 



Unable to Find Service Window

The Unable to Find Service window enables you to find CSi services related to a name that you 
attempted to go to, but which did not exist.

If you want to conduct a search for related services, click the Search button.

You can also type a CSi service name or Internet address and click the Go button to go directly to that 
location.

Related help topics
Accessing a Service 
Grouping Your Favorite Services 
Learning Service Names



Define Forum Interests Window

The Define Forum Interests window (or Define Forum Interests window) enables you to review or change 
your Forum interests, as well as the name you are using in the Forum area.

You might have specified Forum interests when you joined the Forum area.

Other Forum members can learn your Forum interests when they view your Member Profile.

Related help topics
Setting Your Forum Area Preferences 
What is a Forum Area?



InfoPlex Preferences Window

If you have access to an InfoPlex Mail system, you can automate your InfoPlex connection procedure, as 
well as use your InfoPlex Mail system as your standard mail system.



Define Modem Security Window

The Define Modem Security window enables you to assign modem security access. 

Type your Member ID number in the User ID box.    Type your Password for security access in the 
Password box.



Rename/Add New Portfolio Window

The Rename/Add New Portfolio window enables you to rename or create a portfolio folder.

Type the folder name in the Portfolio name box.



Membership Search

The Membership Search window enables you to find CSi members.

Define your search using the boxes provided.    You must specify a last name. 

Last Name, First Name, City, State, Country, and Member ID column headings sort any listed 
members.



Make a Friend Confirmation

The Make a Friend Confirmation window enables you to confirm whether you want to add someone to 
your Friends List.



Description Window

The Description window displays information about a Message Section or Library Section.

You can view Descriptions for other sections by selecting them from the box beside Description for 
section.    (Click the down arrow button, and then click a section from the ensuing list.)

You can also use the File menu in the upper left-hand corner of the Description window to print and save 
the Description.    (Click the word File, and then click the command.)

Related help topics
Browsing Forum Messages 
Searching for a File 



Select Folder

The Select Folder window enables you select a Filing Cabinet folder for your sent messages.



Confirm

The Confirm window asks you to confirm your intention to exit CompuServe 3.

If you do not want to see this window each time you exit CompuServe 3, make sure that the Always 
display this window checkbox is not marked.



Welcome to the Executive News Service

You can learn more about the Executive News Service (ENS) from the Learn About area in the News 
Desktop.

Click the Learn About side button, and then click the Personal Folders top tab to view a list of related help 
topics.



Request in Progress Window

The Request in Progress window informs you that you are attempting to disconnect while another activity,
perhaps a file retrieval or services search, is in progress.

If you do not want to disturb the activity in progress, click Continue.    (The disconnect request will be 
ignored.)

However, if you still want to disconnect (without regard for the activity in progress), click Disconnect.

If you want to terminate your current CSi session and then reconnect immediately, click Reconnect.



Information Window

You have requested help for an application that is not part of CompuServe 3.    Such applications might 
not provide help.

If there is a Help button in the application window, please try clicking it for assistance rather than pressing 
the F1 key.    (Some applications provide help, but do not provide F1 help support.)

If there is still no help available, there might be help for other windows within the application that could 
offer assistance.



File Already Exists Window

The File Already Exists window informs you that there is a file on your computer that has the same name 
as a file you are attempting to retrieve (download).

If you attempted to retrieve a file and were unable to retrieve all of it, click Resume.    (The Resume button
will start up the retrieval where it left off.)

If you do not want to preserve the contents of the file that is on your computer, click Overwrite.    (The file 
on your computer will be replaced by the file you are retrieving.)



Run Window

The Run window enables you to specify an application to be run concurrently with, yet independently of, 
CompuServe 3.      

Type the path and filename of the application in the Command line box.    (If you prefer, you can use the 
Browse button to specify this information.)

If you want your application to run in minimized form, mark the Run Minimized checkbox.



Issue Search Window

The Issue Search window enables you to find issue symbols.

Define your search using the boxes beside Find.    If a box has a down arrow, click the down arrow to see 
a menu of choices, and then click the choice you want.    If a box does not have a down arrow, simply click
the box, and then type your information.    

After defining your search, click Search.

Issue symbols that match your search terms will be listed for you.



Account Maintenance Window

The Account Maintenance window displays information about your account.    For example, you might see
this window if your credit card has expired or payment is overdue.

Read the information and any instructions that are displayed.    You might be asked to provide information.
If so, type the information in the box provided, and then click Send.    (You might be asked to do this 
several times.)

Click Continue when you are finished.



Invalid Recipients Window

The Invalid Recipients window lists all recipients for whom address information is invalid.

You will see the Invalid Recipients window if you attempt to send a Mail message that has an invalid 
recipient address.

An address is considered invalid if it does not conform to its required format.    A CSi Mail address that no 
longer exists is also considered invalid.

You must correct or delete all invalid addresses from the Recipient List before you can send your 
message.

Related help topics
Alphabetical Listing of Address Formats



Searching for Items in the Filing Cabinet
You can search for items stored in your Filing Cabinet according to item type, such as Mail Messages, 
Forum Messages, and News Articles (stories), as well as by all items combined.

1 Access your Filing Cabinet.

2 In the Filing Cabinet window, click Search.

3 Choose the appropriate search method from the Find box.    If you want to search for Mail Messages 
or Forum Messages via sender or recipient, choose Mail messages or Forum messages as 
appropriate.    (Do not choose All items if you want to search via sender or recipient.)

4 Provide additional search information as appropriate.

5 Click Search.



Disabling Sound

You can disable the sounds that you normally hear while using CompuServe 3 through the Fonts/Sounds 
Preferences.

1 Choose Preferences from the Access menu.

2 Click the Fonts/Sounds top tab.

3 Click the Play Sounds checkbox appropriately.

4 Click OK. 

You can also disable (and reassign) the sound assignments for CompuServe 3 at your Windows 95 
Sound Properties window.

1 Choose Settings from the Windows 95 Start menu, and then choose Control Panel from the ensuing
submenu.    (Click the Start button on your Windows 95 desktop to access the Start menu.)

2 In the Control Panel window, locate the Sounds icon, and then open (double-click) it.

3 In the Sound Properties window, locate the CompuServe 3 heading within the Events box.    (You 
might need to use the scroll bar to find the CompuServe 3 heading.)

4 Click an event for which you want to disable (or reassign) sound.    (When you click an event, its 
corresponding sound assignment is displayed in the Name box just below the Events box.)

5 To disable sound for the highlighted event, simply click the down arrow in the Name box, and then 
click (None).    To change sound for the highlighted event, click the down arrow in the Name box, and 
then click the sound you want.    (You can use the Browse button to find other sound files if you have 
them on your computer.)

6 Repeat Steps 4 and 5 until you have disabled (or reassigned) sound for all the appropriate events.

7 Click OK.



Customer Service Updates

The Ask Customer Service area on CompuServe Interactive (CSi) has the latest contact information 
worldwide.

1 Choose Go from the Access menu.

2 At the Go window, type QUESTIONS, and then click OK.

3 At the Ask Customer Service window, scroll to the bottom of the window, and then click Proceed.

4 At the next window, click CompuServe Customer Service Offices, and then click Select. 

5 At the Help Database (FREE) window, click a location, and then click Select.



Sending a Message

Members worldwide can leave a message for CompuServe Customer Service via CSi Mail.    

1 Choose Go from the Access menu.

2 At the Go window, type FEEDBACK, and then click OK.

3 At the Ask Customer Service window, scroll to the bottom of the window, and then click Proceed.

4 At the next window, click Write to Customer Service, and then click Select. 

5 At the Customer Service Feedback window, click a category, and then click Select.

6 Follow the ensuing menus until you reach the Feedback System form.



Other Countries
For countries not listed, please contact CompuServe USA:

Customer Service
P.O. Box 20212
5000 Arlington Centre Blvd.
Columbus, Ohio 43220

US/Canada Freephone: (800) 848-8990
Outside US/Canada: (+1) (614) 529-1340
Fax: (+1) (614) 529-1611
Hours:     8:00 - 24:00 (EST) Weekdays

12:00 - 22:00 (EST) Saturday and Sunday



Argentina

CompuServe S.A. Argentina
Av. Rivadavia 969 2do. Piso Frente
Buenos Aires 1002
Argentina

Phone: Outside Argentina: (+54) (1) 345-3817
Fax: Outside Argentina: (+54) (1) 345-0825
Hours: 9:00 - 17:00 Weekdays



Australia/New Zealand

CompuServe Pacific
Fujitsu Australia Ltd.
475 Victoria Avenue
Chatswood, NSW 2067
Australia

Australia Freephone: 1 800 025 240
New Zealand Freephone: 0800 446 113
Outside Australia/New Zealand: (+61) (2) 410-4260
Fax: (+61) (2) 410-4223
Hours: 7:00 - 19:00 Weekdays (Sydney time)

8:00 - 13:00 Saturdays (Sydney time)



Austria

Austrian Freephone: 0660 8750
Outside Austria: (++49) 1805 25 81 46
Fax: (+49) (89) 66 535-241
Hours: 7:00 - 24:00 (CET) Every day except German holidays



Chile

Chilepac S.A.
Gerencia Red de Datos
Morandé 147
Santiago, Chile

Phone: (+56) (2) 252-5171
Fax: (+56) (2) 252-5624
Hours: 9:00 - 17:00 Weekdays



Colombia

Cra. 9 72-81
Oficina 604
Bogota, Colombia

Telephone: (571) 312-1703
Fax: (571) 312-1857
Hours:    7:00 - 19:00 Weekdays



France

CompuServe Information Service SARL
Centre ATRIA
Rueil 2000 - 21, Av. Edouard Belin
92566 RUEIL-MALMAISON CEDEX
France

AZUR Phone: 36-63-81-31
Outside France: (+33) (1) 4714 2160
Fax: (+33) (1) 4714 2151
Hours: 8:30 - 19:30 Weekdays



Germany

CompuServe GmbH
Postfach 11 69
82001 Unterhaching/München
Germany

Phone: 01805-25 81 46
Outside Germany: (++49) 1805 25 81 46
Fax: (+49) (89) 6657-8008
Hours: 24 hours, except German holidays



Hong Kong

CompuServe Hong Kong
Motorola AirCommunications, Ltd.
901 Cigna Tower
482 Jaffe Road
Causeway Bay
Hong Kong

Phone: (+852) 2833-1500
Fax: (+852) 2506-3445
Hours: 9:00 - 18:00 Weekdays



Hungary

CompuServe Hungary
Middle Europe Networks, Kft.
Budapest
Beg u. 3-5
H-1022 Hungary

Phone: (+36) (1) 175-6483
Fax: (+36) (1) 212-4162, (36) (1) 212-0639
Hours: 8:00 - 16:30 (CET) Weekdays



Israel

CompuServe Israel
Trendline Communications & Info. Svcs., Ltd.
12 Yad-Harutzim St.
Tel-Aviv
Israel 67778

Phone: (+972) (3) 638-8230
Fax: (+972) (3) 638-8288
Hours:     9:00 - 24:00 Sunday - Thursday

    8:00 - 17:00 Friday
10:00 - 18:00 Saturday



Japan

NIFTY Corporation
8th Floor, Omori Bellport A,
Minami-Oi 6-26-1, Shinagawa-ku
Tokyo 140 Japan

Japan Freephone: 0120 22 1200
Outside Japan: (+81) (3) 5471-5806
Fax: (+81) (3) 5471-5890
Hours: 9:00 - 19:00 (JST) Weekdays

9:00 - 17:50 (JST) Saturdays



Mexico

CompuServe Mexico
Infoacces S.A. de C.V.
Gutenberg 143
Col. Anzures
C.P. 11590 Mexico D.F.

Phone: (+52) (5) 629-8191
Fax: (+52) (5) 629-8198
Hours:     9:00 - 22:00 Weekdays

10:00 - 14:00 Saturdays



Netherlands

CompuServe Netherlands
Postbus 90046
1006AR
Amsterdam

Freephone:    0800-022-5991
Direct:    +(44) 990-000-400
Fax:    +(44)(117) 925-2210
Hours:  9:00 - 21:00 Weekdays

10:00 - 17:00 Saturdays 



Singapore

CompuServe Pacific
CNS Information(s) Pte. Ltd.
International Plaza
10 Anson Rd
#19-06A
Singapore    079903

Freephone:    800-6161-376
Direct:    +(65) 226-3928
Fax:    +(65) 226-3603
Hours: 7:00 - 19:00 Weekdays (Sydney time)

8:00 - 13:00 Saturdays (Sydney time)



South Africa

CompuServe Africa
P.O. Box 72668
Lynnwood Ridge
South Africa 0040

Phone: (+27) (12) 841-2530
Fax: (+27) (12) 241-3604
Hours: 9:00 - 17:00 Weekdays



South Korea

Hanjin Info System & Telecom Co.
Information Department
Marine Center New Bldg., 17F, 118, 2-ga
Namdaemun-ro, Chung-gu
Seoul, Korea 100-092

Korea Freephone: 080 090 1435
Outside Korea: (+82) (2) 318-1435
Fax: (+82) (2) 753-8666
Hours: 8:30 - 21:00 Weekdays

8:30 - 16:00 Saturdays



Switzerland

Within Switzerland: 0848-80 11 12
Outside Switzerland: (++41) 848-80 11 12
Fax: (+49) (89) 66 535-241
Hours: 7:00 - 24:00 (CET) Every day except Swiss holidays



Taiwan

Taiwan Telecommunications
Far East ABC Intelligent Science Park
1Fl., No. 13, Lane 50
Nan-Kang Road., Sec. 3
Taipei, Taiwan, R.O.C.

Taiwan Freephone: 080 251 177
Outside Taiwan: (+886) (2) 788-1588
Fax: (+886) (2) 782-2990
Hours: 9:00 - 18:00 Weekdays

9:00 - 12:00 Saturdays



United Kingdom

CompuServe Information Service (UK) Ltd.
1 Redcliff Street
P.O. Box 676
Bristol BS99 1YN
United Kingdom

Freephone within U.K.: 0990 000 400
Outside U.K.: (+44) (990) 000 400
Fax:    (+44) (117) 925-2210
Hours:     9:00 - 21:00 (London Time) Weekdays

10:00 - 17:00 (London Time) Saturdays



United States/Canada

Customer Service
P.O. Box 20212
5000 Arlington Centre Blvd.
Columbus, Ohio 43220

Signup Outsource Freephone US/Canada: 800-609-1674
US/Canada Freephone: (800) 848-8990
Outside US/Canada: (+1) (614) 529-1340
Fax: (+1) (614) 529-1611
Hours:     8:00 - 24:00 (US EST) Weekdays

12:00 - 22:00 (US EST) Saturday and Sunday



Venezuela

CompuServe C.A. Venezuela/Andean Net Services
Plaza Venezuela-Torre Capriles
Piso 4, Oficina 401
Caracas-Venezuela

Phone: (+58) (2) 793-2984
Fax: (+58) (2) 793-1952
Hours: 8:00 - 17:00 Weekdays



Accessing a Service
Here are some ways to go to locations on CompuServe Interactive (CSi):

You can choose Go from the Access menu and go directly to the location.    (You must know the 
name of the location, such as SPORTS for the Sports Services area on CSi.)

If you have recently been to the same location, you can use the Page feature to return there 
quickly.

If the service you want to go to is in your Favorite Places list, you can go directly to that service 
from the Favorite Places page.

You can choose CompuServe Directory from the Access menu to view a list of CSi destinations 
and access any that you want.



Reviewing Recent Destinations
Use the Page box (in the upper left part of your CompuServe window) to scan destinations you have 
recently visited and quickly return to them.

1 Click the down arrow on the Page box to review recent locations.

2 Click a location to revisit it.



Grouping Your Favorite Services
Use the Favorite Places feature to group your favorite destinations so that you can revisit them quickly.

1 At the Home Desktop, click the Go side button.

2 Click the Favorite Places top tab.

3 Click New.

4 Provide information about a destination you want to add.

5 Click OK.



Accessing the CompuServe Directory
The CompuServe Directory lists hundreds of CompuServe Interactive (CSi) services and Forum areas.

To access the CompuServe Directory, choose CompuServe Directory from the Access menu.



Finding Services on CompuServe Interactive
Use the Find feature to search for services on CompuServe Interactive (CSi).

1 At the Home Desktop, click the Find side button.

2 Click the Services top tab.

3 Type a category or service to search for.

4 Click Search.



Learning About CompuServe Interactive Services
There are lots of ways to learn about services on CompuServe Interactive (CSi).

Click the Find side button at your Home Desktop and set up a search for services, files, or CSi 
members.

Click the Learn About side button on the Home, Forum, News, and Chat Desktops to learn about 
those desktops.

Choose Contents from the Help menu (or click the Contents button at the top of this help 
window) to browse relevant help topics.

Choose What's New or Member Services from the Services menu to learn about happenings 
and promotions in the CSi community.

Choose CompuServe Directory from the Access menu to view descriptions of CSi services.

Ask other CSi members!    Post (send) a message in a Forum area in which you are a member, or
send an informal question while in a Public Room in a Forum area or Chat.

Click the Main Menu side button on the Home Desktop, click the Main Menu top tab, and then 
click the Table of Contents button to view CSi services by category.



Finding Forum Areas
With hundreds of Forum areas on CompuServe Interactive (CSi), you may need some help finding the 
ones you want.

Choose CompuServe Directory from the Access menu and browse the numerous descriptions 
of Forum areas.

Choose Go from the Access menu and Go to FORUMS.

Click the Find side tab at your Home Desktop and set up a Services search on the word FORUM.



Finding Internet Services
Here are some ways to find Internet services on CompuServe Interactive (CSi):

Choose Go from the Access menu and go to INTERNET.

Click the Find side button at your Home Desktop, click the Services top tab, provide a search 
term such as INTERNET or WEB, and then click the Search button.    (You can find services on the 
Internet by providing a search term and then clicking the Start Internet Search button.)

Ask other CSi members!    Post (send) a message in a Forum area in which you are a member, or
send an informal question while in a Public Room in a Forum area or Chat.

Click the Internet button on the Home Desktop.



Learning About Internet Services
Use the Learn About feature on the Home Desktop to learn about Internet services on CompuServe 
Interactive (CSi).

1 At the Home Desktop, click the Learn About side button.    

2 Click The Internet top tab.

3 Double-click a topic to learn about it.



Finding Members of CompuServe Interactive
Use the Find feature to search for the names and addresses of members of CompuServe Interactive 
(CSi).

1 At the Home Desktop, click the Find side button.

2 Click the Members top tab.

3 Provide the member information.

4 Click Search.



Learning About Members of CompuServe Interactive
Conducting a search for CompuServe Interactive (CSi) members gives you the following information:

member name

location

country

CSi Mail address (CSi member ID number)



Contacting Members of CompuServe Interactive
Here are some ways to contact CompuServe Interactive (CSi) members.

The easiest way to contact a CSi member is to send a Mail message or Forum message.    

You can also set up a member search.    To do so, click the Find side tab on your Home Desktop, 
and then click the Members top tab.

If the member frequents a particular Forum area, you can post (send) a Private Message on one 
of the Message Boards.    (You can also start a conversation if the member is in a Public Room there.)



Adding Member Information to Your Address Book
You can easily add member information to your Address Book:

1 At the Home Desktop, click the Mail Center side button.

2 Click the Address Book top tab.

3 Click Add Entry.

4 Provide the appropriate information.

If you are reading a Mail message and want to add the sender or one of the recipients to your Address 
Book, you can do so easily by clicking the Add Address button in the Read Mail window.

You can also use the Find feature to add member information to your Address Book:

1 At the Home Desktop, click the Find side button.

2 Click the Members top tab.

3 Provide the member information.

4 Click Search.

5 Click a member entry from the list of members found.

6 Click Add to Address Book.

7 Review or change the member information.

8 Click OK.



Finding a File
There are many ways to find files in a Forum area.

At the Forum desktop, you can click the File Libraries side button, then click the Search top tab to
set up a file search.

If you prefer not to conduct an automated search for files, you can simply browse through 
hundreds of Library files on your own, section by section.

If you can't seem to find the file you want, ask other CSi members!    Post (send) a message in the
Forum area, or send an interactive query while in a Forum Conference room.

You can also leave the Forum area and return to your Home Desktop to set up a search for files 
anywhere on CSi.    At your Home Desktop, click the Find side button, and then click the Files top tab to 
set up your search.    



Reviewing a File
Large files may take some time to retrieve (download).    You may want to confirm that you've located the 
correct file by reviewing it before you spend the time to download.

Once you find a file on CSi, use the Description button to view a Description (abstract) of the file.

The Description button appears in windows where your file is listed.



Retrieving a File from a Forum Area
Once you find a file in a Forum area, you will need to retrieve (download) it to your hard disk if you want to
use it.

To retrieve a file from a list, such as while browsing a File Library Section, click the file, and then click the 
Retrieve button shown there.

You can also retrieve a file that you have opened by clicking the Retrieve button in the opened file 
window.

If you click a button called Retrieve Later, you are in effect marking the file without retrieving it.    (The 
retrieve request is added to your To-Do List.)



Viewing a File

Forum area files come in various formats that affect whether you will be able to view them online or 
whether you will need to retrieve (download) them to your computer first.

You can view most graphics files.    You can also view compressed binary files.    Clicking the Open button 
shown with such files enables you to view them.

However, you cannot view or open text or binary files.    You must retrieve (download) these files.    
Clicking the Retrieve button enables you to retrieve a binary file.



Learning About a File
Every file in a Forum area has a brief Description (abstract) associated with it.    If you are browsing a list 
of files you can view a File Description by clicking the file, and then clicking the Description button shown 
there.

You can also learn about a file simply by examining the information displayed along with the listed file, 
such as its title, size, date submitted to the Forum area, and popularity (accesses).



Marking a File for Later Retrieval
While you are browsing Forum area files, you might prefer not to stop to retrieve (download) each file as 
you find it.    

Use the Retrieve Later button to mark a file for later, rather than immediate, retrieval. (The retrieve 
request is added to your To-Do List.)

The Retrieve Later button appears in windows where your file is listed.



Understanding File Types
Here are some of the more common file types you might encounter while browsing files in a Forum File 
Library:

Binary files (EXE) contain computer code.

Compressd files (SIT, ZIP) are compressed with compression software and must be 
decompressed on your disk before using.

Graphics files (GIF, JPG, BMP,    TGA, TIF) contain an image.

Text files (TXT) are nonbinary files that contain only ASCII characters (typewriter characters).



Understanding Naming Conventions
The files you see in the Forum area libraries are divided into several types.    These types are identified by
these extensions (which are assigned by convention):

Binary files (EXE) contain computer code.

Compressd files (SIT, ZIP) are compressed with compression software and must be 
decompressed on your disk before using.

Graphics files (GIF, JPG, BMP,    TGA, TIF) contain an image.

Text files (TXT) are nonbinary files that contain only ASCII characters (typewriter characters).



Contributing a File
To contribute (upload) a file to a Forum library, you actually send it.

1 In a Forum area, click the File Libraries side button.

2 Click the Create top tab.

3 Click New.

4 Provide the appropriate information.



Mailing a File
In order to mail (send) a graphic image or other type of file, you must attach it to a Mail message.

1 At the Home Desktop, choose Send File from the Mail menu.

2 At the Open window locate the file you want to send.

3 Click the file.

4 Click Open.

5 At the Attach Files window, click OK.

6 At the Create Mail window, create a Mail message.

7 Click Send.



Mail Topics



What is a Mailbox?

CompuServe Interactive (CSi) collects your incoming Mail in a special area on one of its computers.    This
special area is known as your mailbox.

To visit your mailbox, you need to be connected to CSi.    (If you visit your mailbox you can save time 
responding to your incoming Mail because you will be connected to CSi.)

As an alternative, you can simply retrieve (download) your mailbox contents to your computer.    This 
enables you to process your incoming Mail whenever you like, whether online or offline.    This can be 
useful when you encounter lengthy messages or when you simply want to take more time to process your
incoming Mail.

Your Mail preferences determine whether you will review your incoming Mail at your mailbox or retrieve 
(download) it automatically to your computer.    



Visiting Your Mailbox

Visit your online mailbox to process your incoming Mail while connected to CompuServe Interactive (CSi).

1 Confirm that the View mail online before retrieving checkbox in your Mail preferences is marked.    (To 
view your Mail preferences, choose Preferences from the Access menu, and then click the Mail top 
tab.) 

2 At your Home Desktop, click the Mail Center side button.

3 Click the Read top tab.

4 Click Get Mail.



Retrieving Mailbox Messages

Retrieving your mailbox messages enables you to process incoming mail offline whenever you like.

1 Confirm that the View mail online before retrieving checkbox in your Mail preferences is not marked. 
(To view your Mail preferences, choose Preferences from the Access menu, and then click the Mail 
top tab.)    

2 At your Home Desktop, click the Mail Center side button.

3 Click the Read top tab.

4 Click Get Mail.



Listing Your Mail Messages 

You list your incoming Mail at the Mail Center Read page.

1 At your Home Desktop, click the Mail Center side button.

2 Click the Read top tab.

3 Click Get Mail.



Delete Immediately Option

Whenever you retrieve (get) your incoming Mail, your mailbox contents are copied to the Incoming 
Messages folder (in your Filing Cabinet) where you have the option of processing your Mail messages 
whenever you like, whether you are online or off.

If the Delete Mail from online mailbox when retrieved checkbox in your Mail preferences is marked, your 
mailbox will be cleaned out after the retrieval process.    

If the Delete Mail from online mailbox when retrieved checkbox is not marked, your mailbox contents will 
be left untouched after the retrieval process.    

(The Delete Mail from online mailbox checkbox will be a valid option only if the View mail online before 
retrieving checkbox has been marked.)



Show Online Mail Option

Whenever you click the Get Mail button in the Mail Center Read page, your incoming Mail is listed for you.

If the View mail online before retrieving checkbox in your Mail preferences is marked, your incoming Mail 
will be listed, but will not be retrieved (downloaded) from your mailbox on CompuServe Interactive (CSi).   
This enables you to go directly to your mailbox to process your incoming Mail without worrying about 
storage on your computer.

If the View mail online before retrieving checkbox is not marked, your incoming Mail will be retrieved 
(downloaded) to a special Incoming Messages folder (in your Filing Cabinet) where you can process it 
offline (not connected to CSi).    This enables you to read and respond to your incoming Mail at your 
leisure without worrying about connection time.



Opening an Incoming Message

You open a message to read, forward, or reply to it.

1 At your Home Desktop, click the Mail Center side button.

2 Click the Read top tab.

3 If your incoming Mail is not listed there, click Get Mail.

4 Click a message.

5 Click Open.



Filing an Incoming Message

You can file (save) messages for later reviewing.

1 At your Home Desktop, click the Mail Center side button.

2 Click the Read top tab.

3 If your incoming Mail is not listed there, click Get Mail.

4 Click a message.

5 Click File It.

6 Specify the folder in which you want to file (save) the message.

7 Click OK.



Deleting an Incoming Message

Delete a message when you want to remove it permanently.

1 At your Home Desktop, click the Mail Center side button.

2 Click the Read top tab.

3 If your incoming Mail is not listed there, click Get Mail.

4 Click a message.

5 Click Delete.



Sorting Incoming Messages

You can sort your incoming Mail to find specific messages, as well as to rearrange messages.

1 At your Home Desktop, click the Mail Center side button.

2 Click the Read top tab.

3 If your incoming Mail is not listed there, click Get Mail.

4 Click the Subject, From, Date, or Size column headings in the Online Messages list. Your messages 
will be sorted based on the button you select.



Replying to an Incoming Message

To reply to an incoming message, you must first open the message. 

1 In the message window, if you want to reply only to the original message author, click Reply.

2 In the message window, if you want to reply to both the original message author and all message 
recipients, click Reply All.

3 Compose your message.

4 Click the appropriate processing button (Send, Send Later, or File It).    (If you click Send Later, the 
send request is added to your To-Do List and filed in your Outgoing Messages folder in your Filing 
Cabinet.)



Forwarding an Incoming Message

Here is how you can forward an incoming message that you have opened.

1 In the message window, click Forward. 

2 Provide the appropriate recipient and subject information. 

3 If you want to include a comment with the forwarded message, position your arrow cursor at the top of
the text window, and then type or paste the comment.

4 Click the appropriate processing button (Send, Send Later, or File It).    (If you click Send Later, the 
send request is added to your To-Do List and filed in your Outgoing Messages folder in your Filing 
Cabinet.)



Printing an Incoming Message

Choose Print from the File menu to print an opened or highlighted message.



Searching Your Mail Messages
You can search for Mail Messages stored in your online mailbox or your Filing Cabinet by topic, sender 
name or Member ID, recipient name or Member ID, or date.

1 At your Home Desktop, click the Mail Center side button.

2 Click the Search top tab.

3 Provide your search terms.

4 Click Search.

You can also access your Filing Cabinet to search for Mail messages stored there:

1 Access your Filing Cabinet.

2 At the Filing Cabinet window, click Search.

3 Choose Mail messages in the box beside Find.    (Click the down arrow, and then click Mail 
messages.)

4 Provide additional search information as appropriate. 

5 Click Search.



Saving Message Addresses

If you are reading a Mail message, you can copy address information to the Address Book without having 
to retype it.

1 In the message window, click Add Address.

2 Click a name in the Names box.

3 Review or modify the information as appropriate.

4 Click Add.

5 Repeat Step 2-4 for as many names as you want to add to your Address Book.

6 Click Done.



Saving the Recipient List

Once you open an incoming message, you can add the Recipient List into your Address Book.

1 In the message window, click Add Address.

2 Click a name in the Names box.

3 Review or modify the information as appropriate.

4 Click Add.

5 Repeat Step 2-4 for as many names as you want to add to your Address Book.

6 Click Done.



Making an Address Book Entry

You can make two types of entries in your Address Book:

Individual address entry is used for just one person:    Jack Smith, Sally Doe, Li Pond.

Group Mailing List entry is used to group two or more addresses.    You can name the group whatever 
you like:    Computer Pals, Softball Team, Stock Club.    A Mail message sent to a Group Mailing List 
address goes to everyone in the group.    Only individual address entries can be included in a Group 
Mailing List.



Making an Individual Address Entry

Make an individual address entry if the entry will be used for just one person, such as for Pat Smythe or Li
Chen.

1 Choose Address Book from the Mail menu.

2 Click New.

3 Click Individual address.

4 Click OK.

5 Provide the appropriate name and address information.

6 Click OK.



Making a Mailing List Entry

Make a Mailing List entry to group two or more persons under a common address label, such as 
Breakfast Club or Softball Pals.

1 Choose Address Book from the Mail menu.

2 Click New.

3 Click Group Mailing List.

4 Click OK.

5 Provide the Mailing List information.    

6 Click OK.



Copying Address Information to the Address Book

If you are reading a Mail message, you can copy its address information to the Address Book without 
having to retype it.

1 In the message window, click Add Address.

2 Click a name in the Names box.

3 Review or modify the information as appropriate.

4 Click Add.

5 Click Done.



Changing an Address Book Entry

Open an entry in your Address Book to change it.

1 Choose Address Book from the Mail menu.

2 Click an entry. 

3 Click Open.

4 Make your modifications.

5 Click OK.



Deleting an Address Book Entry

Delete an entry when you want to remove it from your Address Book permanently.    

1 Choose Address Book from the Mail menu.

2 Click an entry. 

3 Click Delete.

4 Confirm that you want the Address Book entry deleted.



Accessing the Address Book

There are two ways to access the Address Book:

You can choose Address Book from the Mail menu.

At your Home Desktop, you can click the Mail Center side button, then click the Address Book top
tab.



Obtaining a Personal Address

If your online mailbox is in the new CSi Mail system, you can obtain a Personal Address to use instead of 
your member ID number.    There is no extra charge for using a Personal Address.

 1 From the Access menu, choose Go.

 2 In the ensuing window, type REGISTER.

 3 Click OK.

Note:    If you are not using the new CSi Mail system, you will be given the opportunity to upgrade at this 
time.    You must be using the new system to obtain a Personal Address.

 4 In the Enter your name window, type your first name.

 5 Type your last name.

 6 Click Proceed.

 7 In the Select a Personal Address window, specify the Personal Address you want:    

To select one of the suggested options, click the adjacent radio button.

To specify something else, click the button next to Other and then type in the Personal Address.    
Your Personal Address can have from two to 32 letters, numbers, and underscore characters (_).    It can 
not have spaces or any other special characters.    At least one character must be a letter, and no 
character can be repeated more than four times in succession.

 8 Click the Proceed button.    If the Personal Address you specified can not be used, you will see a 
notice explaining why.    Click OK to return to the Select a Personal Address window and specify a 
different Personal Address.

 9 In the Confirmation window, click Yes to confirm your new Personal Address.    To return to the Select 
a Personal Address window and specify a different one, click No.

10 In the Congratulations window, click OK.

From now on, all your messages will be “signed” with your Personal Address and your correspondents 
will be able to send messages to either your Personal Address or your CSi member ID number.    Please 
be aware that your complete Internet e-mail address must still include @compuserve.com.    So, for 
instance, if your Personal Address is MaxNix, your complete e-mail address would be 
MaxNix@compuserve.com.

Once you have a Personal Address, you cannot change it.    However, you can elect to “sign” your CSi 
Mail messages with your CSi member ID number instead of your Personal Address.

Related help topics
Sending Mail to a Personal Address
Finding a Forgotten Personal Address
Changing Your CSi Mail Signature



Sending Mail to a Personal Address

If you want to send a CSi Mail message to someone with a Personal Address, you can specify the 
Personal Address instead of the CSi member ID number in the Recipient list for the message.

Note:    You do not have to use the Personal Address; the person’s member ID also works.

If you want to send a message through the Internet without using CSi Mail, you can address the message
to the recipient’s Personal Address, but it must include @compuserve.com.    Thus, for example, if the 
recipient’s Personal Address in CSi Mail was MaxNix, the complete Internet mailing address would be 
MaxNix@compuserve.com.



Finding a Forgotten Personal Address
If you forget your Personal Address for CSi Mail, you can find it on CSi.

1 From the Access menu, choose Go.

2 In the ensuing window, type REGISTER.

3 Click OK.

The ensuing window shows your Personal Address.



Changing Your CSi Mail Signature

Once you have a Personal Address, CompuServe 3 automatically uses it to “sign” all your CSi Mail 
messages.    However, you can specify that your CSi member ID number be used instead.

1 From the Access menu, choose Go.

2 In the ensuing window, type MAILSET.

3 Click OK.

4 In the Mail Settings window, select CompuServe Mail Settings.

5 In the CompuServe Mail Settings window, unmark the checkbox next to Display your Personal 
Address to Recipients.    (You unmark the checkbox by clicking on it.)

6 Click OK.

From now on, the return address for any CSi Mail messages that you send will show your CSi member ID
number instead of your Personal Address.    Of course, you can switch back to using your Personal 
Address by returning to the CompuServe Mail Settings window and marking the checkbox again. 



Assigning Urgency Status

The Indicate message is urgent checkbox enables you to assign high priority status to an outgoing Mail 
message.

1 In the Create Mail window, click Options.

2 Mark the Indicate message is urgent checkbox.

3 Click OK.



Requesting a Return Receipt

The Notify me when message is received checkbox causes a Mail receipt to be sent to you the instant 
your message is opened by a recipient.    The Mail receipt shows the time at which the recipient opened 
your message.

A confirmation message will be sent to you with the information.

1 In the Create Mail window, click Options.

2 Mark the Notify me when message is received checkbox.

3 Click OK.



Specifying a Release Date

The Release date checkbox enables you to specify the date on which a Mail message will be mailed 
(sent) from your Outgoing Messages list.

1 In the Create Mail window, click Options.

2 Mark the Release date checkbox.

3 Select the desired release date from the corresponding date box.

4 Click OK.



Specifying an Expiration Date

The Expiration Date checkbox enables you to determine the length of time that a Mail message you send 
will remain in a recipient's mailbox before it is deleted.

1 In the Create Mail window, click Options.

2 Mark the Expiration date checkbox.

3 Select the desired expiration date from the corresponding date box.

4 Click OK.



Controlling Text Formatting in a Message

Normally all outgoing Mail messages are reformatted to fit within the recipient's window to ensure the best
viewing experience.

However, you can specify that your message text not be reformatted, if you want, for example, to 
preserve column and paragraph breaks.

1 In the Create Mail window, click Options.

2 If you do not want to preserve column breaks, paragraph breaks, and such in your message, click the 
Reformat text to window option. (This is the normal setting.)

3 If you want to preserve the look of your message text without altering its current format, click the Send
exactly as shown option.

4 Click OK.



Creating a Mail Message

You do not have to be connected to CompuServe to create a Mail message.

1 On your Home Desktop, click the Mail Center side button.

2 Click the Create top tab.

3 Click New.

4 Compose your message.    (You will need to specify a name, address, and subject for the message.)

5 Click the appropriate button to process your message (Send, Send Later, or File It).    (If you click 
Send Later, the send request is added to your To-Do List and filed in your Outgoing Messages folder 
in    your Filing Cabinet.)



Addressing a Mail Message

Create a Recipient List to address a Mail message.

1 In the Create Message window, click Recipients.

2 Provide the recipient information.    (Use the Address Book button to include addresses from your 
Address Book.)

3 Click OK.



Sending a Mail Message

Use the Send button to send a Mail message.    

1 On your Home Desktop, click the Mail Center side button.

2 Click the Create top tab.

3 Click New.

4 Compose your message.    (You will need to specify a name, address, and subject for the message.)

5 Click the appropriate button to process your message (Send, Send Later, or File It).    (If you click 
Send Later, the send request is added to your To-Do List and filed in your Outgoing Messages folder 
in your Filing Cabinet.)



Attaching a File to a Mail Message

To send a file, you attach it to a Mail message.    

1 On your Home Desktop, click the Mail Center side button.

2 Click the Create top tab.

3 Click New.

4 Provide your message information.

5 Click Attach File.

6 At the Open window, click the file you want to attach (send).

7 Click Open.

8 If you want to attach additional files, click the Add to List button (in the Attach Files window) and 
repeat Steps 6-8.

9 In the Attach Files window, click OK.



Reviewing or Editing Outgoing Messages

Your outgoing (unsent) Mail is stored in the Outgoing Messages folder in your Filing Cabinet.    Your 
outgoing messages are listed automatically for you on the Mail Center Create page.

1 On your Home Desktop, click the Mail Center side button.

2 Click the Create top tab.



Sending an Outgoing Message

Your outgoing (unsent) Mail is stored in an Outgoing Messages folder in your Filing Cabinet.

1 On your Home Desktop, click the Mail Center side button.

2 Click the Create top tab.

3 Click a message.

4 Click Send.



Deleting an Outgoing Message

Delete an outgoing message only if you never want to send it.

1 On your Home Desktop, click the Mail Center side button.

2 Click the Create top tab.

3 Click a message.

4 Click Delete.



Sorting Outgoing Messages

Sort your outgoing message to find a particular message or to arrange them in a special order.

1 On your Home Desktop, click the Mail Center side button.

2 Click the Create top tab.

3 Click the Subject, To, Date, and Size buttons to sort your messages.



Forum Topics



What is a Forum Area?
Forum Areas are online communities in which CompuServe Interactive (CSi) members meet to exchange 
information, expound opinions and ideas, and join in general conversation.

Messages Boards are places where Forum members post (send) and read notes (messages).

File Libraries are collections of files you can retrieve (download) to your computer.    Files can 
include software, articles, interviews, graphics, and much more.

Forum Conferences are live interactions (not delayed like messages) with other CompuServe 
members.    You can think of conferences like phone calls except you type instead of talk.



Browsing Forum Messages
Browsing the various Message Boards in a Forum area gives you a bird's-eye view of all the Message 
Topics.

1 In a Forum area, click the Message Boards side button.

2 Click the Read top tab.

3 Click a section.

4 Click Open.

5 Click a topic.

6 Click Open.

7 Click the arrow buttons (  and 
) in the message window to continue reading other messages.



Creating a Message
Any Forum member can create and post (send) a message on a Message Board.

1 In a Forum area, click the Message Boards side button.

2 Click the Create top tab.

3 Click New.

4 Create your message.

5 Click Send

You can also create and post a Forum message offline (without being connected to CompuServe 
Interactive (CSi)).    At the Home Desktop, choose New Forum Messages from the File menu.



Posting a Message
Follow these steps to create and post (send) a message in a Forum area.

1 In a Forum area, click the Message Boards side button.

2 Click the Send top tab.

3 Click New.

4 Create the message.

5 Click Send.



Searching for a Forum Message
You can search for Forum Messages in a Forum area by topic, sender name or Member ID, recipient 
name or Member ID, message number, or date.

1 In a Forum area, click the Message Boards side button.

2 Click the Search top tab.

3 Provide your search terms.

4 Click Search.

You can also search for Forum Messages stored in your Filing Cabinet.

1 Access your Filing Cabinet.

2 At the Filing Cabinet window, click Search.

3 Choose Forum messages in the box beside Find.    (Click the down arrow, and then click Forum 
messages.)

4 Provide additional search information as appropriate.    (You cannot search for stored Forum 
messages via message number.)

5 Click Search.



Retrieving Message Topics
You retrieve (download) Message Topics to your Filing Cabinet. 

1 In a Forum area, click the Message Boards side button.

2 Click the Read top tab.

3 Click a section.

4 Click File It.

5 If you want to make a new folder for the retrieved Message Topic (thread), click New Folder, type a 
name for the folder, and then click OK.

6 In the File Item window, click a folder.

7 Click File It.



Replying to a Forum Message

A Forum message must be opened for you to reply to it.

1 In a Forum message window, click Reply.

2 Compose your reply.

3 Click Send.



Displaying a Waiting Message
If you do not see a Get Waiting Messages button on the Welcome page, you do not have any waiting 
messages.

1 In a Forum area, click the Welcome side button.

2 Click the Welcome top tab.

3 Click Get Waiting Messages.



Browsing Forum Libraries
Follow these steps to browse a Forum Library

1 In a Forum area, click the File Libraries side button.

2 Click the Read top tab.

3 Click a section.

4 Click Open.

5 Review the files.



Contributing a File
As a Forum member you can contribute (upload) a file from your hard disk to a library:

1 Click the File Libraries side button.

2 Click the Send top tab.

3 Click Create.

4 Provide your file information.

5 Click Send.



Searching for a File
You can search for Forum files by a submission date range, submitter User ID, and file extension.

1 In the Forum area, click the File Libraries side tab.

2 Click the Search top tab.

3 Specify your search terms.

4 Click Search.



Viewing a File
Forum area files come in various formats that affect whether you can view them.

You can view most graphics files.    You can also view compressed binary files.    Clicking the Open button 
shown with such files enables you to view them.

However, you cannot view or open text or binary files.    You must retrieve (download) these files.    
Clicking the Retrieve button enables you to retrieve a binary file.



Marking a File
You mark a file to indicate that you wish to retrieve (download) it at a later time, rather than at that exact 
moment.

As you browse the Forum libraries or open various files, click the Retrieve Later button to mark a file for 
later retrieval. (The retrieve request is added to your To-Do List.)



Participating in a Conference
Forum conferences enable you to meet and converse with other Forum members.

1 Click the Forum Conference side button.

2 Click the Public Rooms top tab.

3 Click a room.

4 Click Participate.

5 Type a comment in the Text to send box.

6 Click Send.



Attending a Moderated Conference
A Moderated Conference is a planned conference that features a guest speaker in a moderated question 
and answer format.

1 Click the Forum Conference side button.

2 Click the appropriate Public Room.

3 Click Participate.



Voting in a Conference
If a moderator calls for a vote in a conference, a special Vote window will be displayed on your screen.

1 In the Vote window, mark your ballot information as appropriate.

2 Click Cast Vote.



Ignoring Invitations
You might prefer not to be bothered by Group Invitations and Private Invitations while in a Forum area, 
Chat, or the Conference Center.

To prevent such Group Invitations and Private Invitations from appearing on your screen, however well-
intentioned they might be, simply choose Ignore All Invitations from the appropriate menu (Forum, Chat,
or Conference).



Reviewing Your Profile

Your Member Profile is a brief summary of your online (and perhaps offline) interests that you can share 
with other Forum members.

1 In a Forum area, click the Forum Conference side button.

2 Click the Who's Here top tab.

3 Click your name.

4 Click Member Profile.

5 Review or edit your Member Profile as needed.



Tracking Others
You might want to keep track of what is happening in a Forum area, such as who is coming and going.

1 Choose Tracking from the Forum menu.

2 To conclude tracking, choose Tracking again from the Forum menu.



Chat Topics



What is Chat?
Chat is like a computerized party line or conference call.    Instead of talking on a phone, people in Chat 
talk with their keyboards.    

Whatever you type appears on the screens of other members tuned to your room or group.    Likewise, the
messages they enter appear on your screen.    

In a chat (conversation), you type to talk and read to listen.



Entering a Public Room
Generally you will go into a Public Room in Chat to participate (send comments) in a chat (conversation).

1 At the Chat Desktop, click the Chat side button.

2 Click the Public Rooms top tab.

3 Click a room.

4 If you want to participate (send comments) in the ongoing conversation, click Participate.

5 If you want only to observe (watch) the ongoing conversation (without sending any comments), click 
Observe.



Leaving a Public Room
You can leave a Public room at any time by closing the Chat Room window.

There is no Leave button.



Learning About Public Rooms
While Chat has many rooms you can visit, some rooms are dedicated to specific topics or interests.    

The Newcomers room is a room mainly for people new to Chat.    Volunteers are usually available from 
6:00 p.m. until 2:00 a.m. (23:00-07:00 GMT) to assist you.    

Other special-interest rooms abound.

You can also learn about Chat at the Communications area on CompuServe.



Listing All Available Public Rooms
The Public Rooms page lists the Public Rooms that you can participate (send comments) in and observe 
(watch).

1 At the Chat Desktop, click the Chat side button.

2 Click the Public Rooms top tab.

3 Scroll through the list to review it.    Use the headings to learn about each room.



Starting a Public Chat
To start a chat:

1 At the Chat Desktop, click the Chat button.

2 Click the Public Rooms tab.

3 Click a room and click the Participate button.

4 Type your message.

5 Click the Send button.



Participating in a Public Chat
You participate in a Public Chat when you want to be able to make (send) comments to the ongoing 
conversation (chat).

1 At the Chat Desktop, click the Chat side button.

2 Click the Public Rooms top tab.

3 Click a room.

4 Click Participate.

5 Type a comment in the box beside the Send button.

6 Click Send.



Observing a Chat without Contributing
When you observe (watch) a Chat, nobody knows you are there because you cannot speak.

1 In Chat, click the Chat side button.

2 Click the Public Rooms top tab.

3 Click a room.

4 Click Observe.



Concluding a Public Chat
To conclude a Public Chat, simply close the window of the room you are in.



Logging a Public Chat
Here is how you can make a transcript of a Public Chat for later reviewing.

1 At the Chat Desktop, click the Chat side button.

2 Click the Public Rooms top tab.

3 Click a room.

4 Click Participate or Observe, depending on whether you want to be able to make (send) comments to 
the conversation or just observe (watch) it.

5 Click Record Text.

6 At the Save As window, type the appropriate name for the transcript at the File name box.    If you 
specify an existing file, the transcript will be appended to it.

7 Click Save.

8 The original Record Text button in the room window has now become a Stop Recording button.

9 When finished recording, click Stop Recording.



Setting Up a Group Chat
A Group Chat enables you to chat privately with more than just one person.

1 At the Chat Desktop, click the Chat side button.

2 Click the Who's Here top tab.

3 Click the nickname of someone you want to be in the group.

4 Click Group Invitation.

5 Repeat Steps 2 - 4 for each person you want to invite.

6 Type a welcome comment in the Send box.

7 Click Send.



Joining a Group Chat
You must receive an invitation from someone in a group before you can join a group.

When an invitation appears on your screen, click the Accept button on the invitation window to enter the 
group.



Concluding a Group Chat
To leave a Group Chat, simply close the Group Chat window.



Logging a Group Chat
You might want to make a transcript of your Group Chat for later reviewing.

1 In the Group Chat window, click Record Text.

2 At the Save As window, type the appropriate name for the transcript at the File name box.    If you 
specify an existing file, the transcript will be appended to it.

3 Click Save.

4 The original Record Text button in the room window has now become a Stop Recording button.

5 When finished recording, click Stop Recording.



Selecting Members for a Group Chat

A Group Chat enables you to chat privately with more than just one person.

1 At the Chat Desktop, click the Chat side button.

2 Click the Who's Here top tab.

3 Click the nickname of someone you want to be in the group.

4 Click Group Invitation.

5 Repeat Steps 2 - 4 for each person you want to invite.

6 Type a welcome comment in the Send box.

7 Click Send.



Setting Up a Private Chat
Set up a Private Chat when you want to have a private conversation with just one other person.

1 At the Chat Desktop, click the Chat side button.

2 Click the Who's Here top tab.

3 Click a nickname.

4 Click Private Chat.



Participating in a Private Chat
Participate in a Private Chat the same way you would in a Group or Public Chat.

1 In the Private Chat window, type a comment in the box next to the Send button.

2 Click Send.



Concluding a Private Chat
To conclude a Private Chat, simply close the Private Chat window.



Accepting a Private Chat Invitation
If you have initiated the Private Chat, the other person must click the Accept button in the invitation 
window before your conversation can begin.

If the other person has initiated the Private Chat, you must click the Accept button.



Creating a Friends List
Your Friends List is a collection of the people you prefer to chat with regularly.

1 At the Chat Desktop, click the Chat side button.

2 Click the Friends top tab.

3 Click the New button.

4 In the Select Friends window, click the listing for someone you want to have in your Friends list.

5 If you want to add toehr people to the Friends List, hold down the Control key while you click their 
listings. 

6 Click OK.



Creating a Prohibited Users List
Make a list of people whose comments you do not want to see.    Your comments will still appear on their 
screens (unless they put you on their Prohibited Users lists).

1 At the Chat Desktop, choose Modify Prohibited List from the Chat menu.

2 In the Prohibited Members List window, click New.

3 In the Select Ignore window, click the nickname(s) of anyone whose comments you do not wish to 
see.

4 Click OK.

5 In the Prohibit Member window for the first selected nickname, click the radio button next to 
Permanently or the radio button next to Temporarily.

6 Click OK.

7 In the Confirm window, click OK.    

Note:    If you don’t want to see this window, click the checkbox next to Always Display This Window.

8 Repeat Steps 5-7 for every member whose nickname you selected in Step 3.



Editing a Prohibited Users List
Add or remove members from the list of people whose comments you do not want to see, or change a 
member’s status from temporarily prohibited to permanently prohibited.

1 At the Chat Desktop, choose Modify Prohibited List from the Chat menu.

2 In the Prohibited Members List window, select a member if want to delete that member’s nickname 
from the list or change that member’s status.

3 Click one of the following:

New -- to add one or more members to the list.

Make Permanent -- to keep the selected member’s nickname on the list until you explicitly delete 
it.    No further action is necessary to change a member’s status.    You can change another member’s 
status by repeating Steps 2 and 3.

Delete -- to remove the selected member’s nickname from the list.    Skip to Step 8.

4 In the Select Ignore window, click the nickname(s) of anyone you wish to add.

5 Click OK.

6 In the Prohibit Member window for the first selected nickname, click the radio button next to 
Permanently or the radio button next to Temporarily.

7 Click OK.

8 In the Confirm window, click OK.    

Note:    If you don’t want to see this window, click the checkbox next to Always Display This Window.

9 Repeat Steps 4-8 for every member whose nickname you selected in Step 4.    Repeat Steps 2, 3 and
8 for every member whose nickname you want to delete.



Finding Who's Here
Consult the Who's Here page to learn who else is currently in Chat.

1 At the Chat Desktop, click the Chat side button.

2 Click the Who's Here top tab.



Sorting Your Users List

To sort the entries in the Private Chat window:

1 At the Chat Desktop, click the Chat button.

2 Click the Who's Here tab

3 Click a nickname in the list.

4 Click the Start Private Chat button

5 Click the left column heading of the Current Chats list to sort in this order.

A Current chats
B New messages received
C Inactive
D New invitations



Reading a Background
You can learn about a person by consulting the Member Profile information.

1 At the Chat Desktop, click the Chat side button.

2 Click the Who's Here top tab.

3 Click a nickname.

4 Click Member Profile.



Ignoring Someone
Add the names of people that you want to ignore to your custom Prohibited List.    

1 At the Chat Desktop, choose Modify Prohibited List from the Chat menu.

2 Click New.

3 Click one or more nicknames.

4 Click Permanently or Temporarily.

5 Click OK



Reviewing Your Profile

Review your Member Profile anytime to make sure it says what you want it to say.

1 At the Chat Desktop, click the Chat side button.

2 Click the Who's Here top tab.

3 Click your nickname.

4 Click Member Profile.



Tracking
To display the activities of others in Chat, choose Start Tracking from the Chat menu.

To conclude tracking activities, choose End Tracking from the Chat menu.



Internet Topics



Overview of the Internet
CompuServe 3 offers you direct accesss to many of the same types of services you find on CompuServe 
Interactive (CSi):

Communication

Information

Entertainment

On the Internet, these services are generally located through one these resources:

USENET Newsgroups

FTP (File Transfer Protocol)

Telnet (Remote Login)

World Wide Web



Surfing the Internet
Surfing the Internet refers to browsing or using the resources of the computers that make up the Internet.

You can browse the Internet in a number of ways:

Click the Main Menu side button (on the Home Desktop), and then click the Internet button.

Choose Internet from the Services menu to start the Internet Web Browser and access the 
CompuServe Interactive (CSi) home page on the World Wide Web.    You can click on the links there to go
to other Web sites.    You can also type an address and go to another Web page.

If a choice on a menu or list of services accesses the Internet and you click it, you will go to the 
Internet.



Internet-Related Forum Areas on CompuServe Interactive
CompuServe Interactive (CSi) provides many Forum areas for learning about different aspects of the 
Internet:

Deutsches Internet Forum is devoted to information about the Internet for German speakers.    
GO GERINT.

Internet Commerce Forum is devoted to information about the conduct of commerce on the 
Internet.    GO INETCO.

Internet Developers Forum is devoted to information about developing software products for the
Internet.    GO INETDEV.

Internet France Forum is devoted to information about the Internet for French speakers.    GO 
INETFR.

Internet New Users Forum is devoted to helping new people take advantage of the tremendous 
resources available on the Internet.    GO INETNEW.

Internet Publishing Forum is devoted to information about Web page development as well as 
other publishing on the Internet.    GO INETPUB.

Internet Resources Forum is devoted to information about advanced Internet topics.    GO 
INETRES.

Internet Webmasters Forum is devoted to information about creating the physical Internet sites 
(such as connecting a Web server to the Internet or becoming a provider).    GO INETWEB.

Netherlands Internet Forum is devoted to information about the Internet for Dutch speakers.    
GO NLINTER.

CompuServe Application Support Forum is devoted to addressing service-related issues and 
supporting Home Page Wizard products.    GO NLSUPP.

Other Forum areas are also available.    GO INN to learn more.



What is a USENET Newsgroup?
A USENET (Users Network) newsgroup is the Internet equivalent of a discussion group.    

First a message is posted (sent) to the newsgroup, and people respond to it with messages of their own.   
Then messages responding to the responses are posted and so on.

Newsgroups are organized into very broad categories which are further divided into subcategories 
(separated by periods), such as the following:

Alt Includes alternative topics to those in the other categories.    For example, alt.bionet discusses 
professional matters of biologists and alt.k12 discusses education (up to high school) topics.

Comp Includes topics about computer hardware and software.    For example, comp.graphics.animation 
discusses computer animation.

Misc Includes topics that don't fit elsewhere.    For example, misc.education.science discusses issues 
related to science education.

News Includes topics about the Internet.    For example, news.newusers.questions provides command 
questions and answers for new users of USENET.

Rec Includes topics about hobbies and pastimes.    For example, rec.art.movies discusses movies and 
moviemaking.

Sci Includes topics about scientific (physical and social) research.    For example, sci.physics.fusion 
discusses fusion research.

Soc Includes topics about the world's social and cultural issues.    For example, soc.roots discusses 
genealogical subject matter.

Talk Includes opinions and debate on about any issue you care to name.    For example, talk.religion.misc
discusses all manner of religious matters.

There are also regional newsgroups, as well as newsgroups devoted to universities.



Finding Newsgroups
Follow these steps to find USENET newsgroups of interest to you:

1 Choose Go from the Access menu.

2 At the Go window, type USENET, and then click OK.

3 At the ensuing menu, double-click USENET Newsreader (CIM).

4 At the USENET Newsgroups window, click Subscribe to Newsgroups, and then click Select. 

5 At the Subscribe to Newsgroups window, you can find newsgroups in either of two ways: 

Click one of the listings in the Browse for Newsgroups list and then click Select.    This lists the 
groups of newsgroups within the selected area.    You can select a group and drill further down.

Type a topic into the text box under Search for Newsgroups and then click the Search button.    
This lists all the newsgroups related to that topic.



Subscribing to Newsgroups

Subscribing to newsgroups incurs no additional fee.    Follow these steps to subscribe to USENET 
newsgroups of interest to you:

1 Choose Go from the Access menu.

2 At the Go window, type USENET, and then click OK.

3 At the ensuing menu, double-click USENET Newsreader (CIM).

4 At the USENET Newsgroups window, click Subscribe to Newsgroups, and then click Select. 

5 At the Subscribe to Newsgroups window, you can identify a specific newsgroup by clicking the 
Subscribe by Name button and then entering the newsgroup name into the ensuing window.    Or you 
can delve further for interesting newsgroups in either of two ways: 

Click one of the listings in the Browse for Newsgroups list and then click Select.    This lists the 
groups of newsgroups within the selected area.    You can select a group and drill further down.

Type a topic into the text box under Search for Newsgroups and then click the Search button.    
This lists all the newsgroups related to that topic.

6 When you find a newsgroup that you want to subscribe to, mark it by clicking the checkbox next 
to the newsgroup name.    You can click as many checkboxes as you like from a list of individual 
newsgroups.    Whenever you’re through with a list, click the Subscribe button.

7 Repeat Steps 5 and 6 as many times as you like.

8 When you have subscribed to all the newsgroups you want, click the Close button in the Subscribe to 
Newsgroups window.



Accessing Newsgroup Articles
You must have already subscribed to a USENET Newsgroup before you can access any of its articles.

1 Choose Go from the Services menu.

2 At the Go window, type USENET, and then click OK.

3 At the USENET Newsgroups window,    click USENET Newsreader (CIM), and then click Select.

4 At the Disclaimer Message window, click OK.

5 At the Netiquette Message window, click OK.

6 At the next window, click Access Your USENET Newsgroups, and then click Select.

7 At the next window, click a newsgroup, and then click Browse.

8 At the next window, click a thread, and then click Get.



Retrieving Marked Articles
You retrieve (download) Newsgroup articles in order to copy them to your computer.

1 Choose Go from the Services menu.

2 At the Go window, type USENET, and then click OK.

3 At the USENET Newsgroups window,    click Access Your USENET Newsgroups, and then click 
Select.

4 At the Access Newsgroups window, click a newsgroup, and then click Browse.

5 At the Newsgroup window, click a topic (thread) to mark it as one you want to retrieve (download).

6 Each time you mark a topic, click one of the following options:

As is saves the article and its origin information

Quoted saves the article with >s at the beginning of each line so that you can type a reply and 
still reference the original message.

Decoded expands encoded image files.

7 Click Retrieve and following the ensuing windows.



Posting an Article
You post an article in a Newsgroup to express your views.

1 Choose Go from the Services menu.

2 At the Go window, type USENET, and then click OK.

3 At the USENET Newsgroups window, click Access Your USENET Newsgroups, and then click 
Select.

4 At the Access Newsgroups window, click a newsgroup, and then click Browse.

5 At the Newsgroup window, click Create.

6 Type your message contents and click the Send button.

7 If needed, provide your USENET options, such as your name.



What Can You Do with FTP?

File Transfer Protocol (FTP) is a way to move files across the Internet.    

You can use FTP to locate and retrieve (download) files (including shareware and public-domain 
software) from computers (called sites) nearly anywhere on the Internet.



Selecting a Site
Follow these steps to select an FTP site.

1 Choose Go from the Access menu.

2 At the Go window, type FTP, and then click OK.

3 At the FTP Alert window, read the text and then click Proceed.

4 At the File Transfer Protocol window, click the List of Sites button, click a site, and then click Select.    
(You can also access a specific site if you know where you want to go.)



Viewing a File
Here is how you can view a text or GIF file in an FTP site's directory:

1 Choose Go from the Access menu.

2 At the Go window, type FTP, and then click OK.

3 At the FTP Alert window, read the text and then click Proceed.

4 At the File Transfer Protocol window, click the List of Sites button, click a site, and then click Select.    
(You can also access a specific site if you know where you want to go.)

5 At the next window, click a directory.    (You might need to go several directories deep.)

6 At the next window, click a text or GIF file in the Files listbox, and then click View.



Retrieving a File
You retrieve (download) a file from an FTP site in order to copy it to your computer.

1 Choose Go from the Access menu.

2 At the Go window, type FTP, and then click OK.

3 At the FTP Alert window, read the text and then click Proceed.

4 At the File Transfer Protocol window, click the List of Sites button, click a site, and then click Select. 
(You can also access a specific site if you know where you want to go.)

5 At the next window, click a directory.    (You might need to go several directories deep.)

6 At the next window, click a text or GIF file in the Files listbox, and then click Retrieve.

7 At the Save As window, indicate a location, and then click OK.



Submitting a File
You submit a file in order to upload it to an FTP site.    However, many sites do not accept uploads.

1 Choose Go from the Access menu.

2 At the Go window, type FTP, and then click OK.

3 At the FTP Alert window, read the text and then click Proceed.

4 At the File Transfer Protocol window, click the List of Sites button.

5 Click a site, and then click Select.

6 At the Access a Specific Site window, provide any relevant information, and then click OK.

7 At the next window, click a directory.    (You might need to go several directories deep.)

8 At the next window, click Upload, and then click OK.

9 At the next window, click File, and then indicate the file to be submitted.

10 At the next window, click OK, select the correct file type, and then click OK.



What Can You Do with Telnet?
Telnet is an Internet tool that lets you use commands on remote computers on the Internet.    

For example, you might use telnet to connect to Dartmouth College library and view information.    You 
could just as easily connect to a different library on the Internet.

To establish a telnet connection, you must have these pieces of information:

Name of the computer site you want to access .

Valid user name for that site.

Password for that site.

Some telnet sites allow for guest logins but limit the commands available to you.    Once you are 
connected to a telnet site, you often see a menu-driven system which is under the control of the telnet 
site.    Such a system guides you through the actions you may perform at that site.

Another common use of telnet is for users to log into their computers from remote locations.    In this case,
users enter their own user names and passwords and, therefore, have the same user privileges they 
would have when logged in without using telnet.



Selecting a Telnet Site
Here is how you can select a telnet site.

1 Choose Go from the Access menu.

2 At the Go window, type TELNET, and then click OK.

3 At the menu of Telnet options, double-click List of Sites.    (You can alternatively access a specific 
site.)

4 At the Telnet window, review the sites.



Accessing a Site
To access a site with telnet:

1 Choose Go from the Access menu.

2 At the Go window, type TELNET, and then click OK.

3 At the menu of Telnet options, double-click List of Sites.

4 At the Telnet window, click a site, and then click Select.    (You can alternatively access a specific site.)

5 At the You Are Leaving CompuServe Alert window, click Proceed.



Gopher
Gopher is a tool that conveniently lists a site's resources as a numbered list (menu).    All you have to do 
is type the number of the resource and press Enter to access that resource.    

1 Choose Go from the Services menu and type TELNET.

2 Click the OK button.

3 At the menu of Telnet options, double-click List of Sites.

4 Double-click The University of Minnesota Gopher.

5 Click the Proceed button and press Enter.

6 Click a resource number and press Enter.



Veronica
Veronica is an Gopher search tool.    You provide a keyword, and Veronica searches the list items in 
Gopher for that keyword.    This tool saves you the trouble of scanning menu after menu in search of your 
topic.

1 Choose Go from the Services menu and type TELNET.

2 Click the OK button.

3 At the menu of telnet options, double-click List of Sites.

4 Double-click The University of Minnesota Gopher.

5 Click the Proceed button and press Enter.

6 Type 8 and press Enter.

7 Type 3 and press Enter.

8 Type 19 and press Enter.

9 Type your keyword and press Enter.



Archie
Archie is a search tool for locating files on the Internet.    You must telnet to an Archie server, perform a 
search, and then FTP to the given location to retrieve (download) the file.

1 Telnet to an Archie server.

2 Type ARCHIE at the login: prompt.

3 Press Enter at the password: prompt.

4 Type FIND and your subject (such as JETSON) and press Enter.

Note this information:

Host (such as hea.ie)

Directory (such as /part4/funet-pics/comics/misc)

Filename (such as jetson.gif).

5 Type BYE and press Enter.

6 GO FTP and click the Access the Specific FTP Site button.

7 Supply the site (host) and directory information and click the OK button.

8 Mark the file and click the Retrieve button.



Archie Servers
Although it's best to use the server closest to you, you can try any of these Archie servers:

archie.unl.edu (Nebraska, USA)

archie.rutgers.edu (New Jersey, USA)

archie.nz (New Zealand)

archie.funet.fi (Finland)

archie.sogang.ac.kr (Korea)

Many other Archie servers exist.    Often you can type SERVERS at the Archie prompt and press Enter for
a list of Archie servers.



What is the World Wide Web?
The World Wide Web (Web or WWW) is a graphical, hypermedia part of the Internet (with all the technical
complexities hidden behind the scene).    

When you view the WWW, you see text and graphics and can navigate by clicking on links (just as you do
in this Help system).    

The big difference is that WWW links can display pages (as well as images and sounds) from remote 
computers across the Internet.



Making a Personal Web Page

Retrieve (download) CompuServe's home page publishing software to make a private Web page.

1 Choose Go from the Access menu.

2 At the Go window, type OURWORLD, and then click OK.

3 At the Our World area, click Publish on Our World. 

4 At the next window, click the download option and then follow those instructions.



What is HTML?

HTML stands for HyperText Markup Language and is used to describe the structure of a document.    In 
other words, HTML codes identify the parts of a document (such as a paragraph, a bulleted list, a 
numbered list, and so on).    These codes are the same whether you create them on a Macintosh, 
Window, UNIX, or other system and are easily read on different systems.

HTML, for the most part, does not describe the appearance of the document (such as, font, font size, 
indentions, and so on).    These qualities are provided by each browser (the software you use to view the 
Web page) and are usually customized by the user.    Thus, an HTML document can appear differently to 
each viewer but still have the same structure.



Finding Web Sites

One of the easiest ways to find a Web site is to click the Find side button (on the Home Desktop), click 
the Services top tab, and then click the Start Internet Search button.

You can also consult any of the numerous Internet-related Forum areas on CompuServe:

Deutsches Internet Forum area is devoted to information about the Internet for German 
speakers.    GO GERINT.

Internet Commerce Forum area is devoted to information about the conduct of commerce on 
the Internet.    GO INETCO.

Internet Developers Forum area is devoted to information about developing software products 
for the Internet.    GO INETDEV.

Internet France Forum area is devoted to information about the Internet for French speakers.    
GO INETFR.

Internet New Users Forum area is devoted to helping new people take advantage of the 
tremendous resources available on the Internet.    GO INETNEW.

Internet Publishing Forum area is devoted to information about Web page development as well 
other publishing on the Internet (including the World Wide Web).    GO INETPUB.

Internet Resources Forum area is devoted to information about advanced Internet topics.    GO 
INETRES.

Internet Webmasters Forum area is devoted to information about creating the physical Internet 
sites (such as connecting a Web server to the Internet or becoming a provider).    GO INETWEB.

CompuServe Internet Applications Forum is devoted to addressing service-related issues and 
supporting Home Page Wizard products.    GO NLSUPP.

Netherlands Internet Forum is devoted to information about the Internet for Dutch speakers.    
GO NLINTER.

Other Forum areas are also available.    GO INN to learn more.



Using an Internet Browser

Choose Internet from the Services menu to use the Internet browser.



Newsdesk topics



What is the Executive News Service (ENS)?
ENS is a news clipping service that collects the news stories you want based on search terms that you 
create.

Public Folders are provided by ENS.    Articles (stories) are organized by individual wire services.    
Anyone can open a Public Folder and read its articles.

Personal Folders are created by you.    Articles (stories) about topics that match keywords you specify 
are clipped as they are released by wire services.    Only you can open your Personal Folders. 



Creating a Folder
If you want to collect only those news stories that meet your selection interests, create a Personal Folder.

1 At the News Desktop, click the Articles side button.

2 Click the Create Folders top tab.

3 Click New.

4 Provide the folder information.

5 Click OK.



Modifying a Folder
You can change a Personal Folder to update the search terms or other folder-specific information.

1 At the News Desktop, click the Articles side button.

2 Click the Create Folders top tab.

3 Click a folder.

4 Click Change.

5 Change the information as appropriate.

6 Click OK.



Clearing a Folder
Use the Empty button to clear a Personal Folder of all its news articles (stories).

1 At the News Desktop, click the Articles side button.

2 Click the Create Folders top tab.

3 Click a folder.

4 Click Empty.



Opening a Folder
You open a folder to see which news articles (stories) are inside.

1 At the News desktop, click the Articles side button.

2 Click the Read top tab.

3 Click a folder.

4 Click Open.



Deleting a Folder
If you are no longer interested in maintaining a Personal Folder, you can delete it.

1 At the News Desktop, click the Articles side button.

2 Click the Create Folders top tab.

3 Click a folder.

4 Click Delete.



Searching for a News Article
You can search for news articles (stories) at the News Desk.

1 At the News Desktop, click the Articles side button.

2 Click the Search top tab.

3 Provide the search terms.

4 Click Search.

You can also search for News Articles stored in your Filing Cabinet.

1 Access your Filing Cabinet.

2 At the Filing Cabinet window, click Search.

3 Choose News articles in the box beside Find.    (Click the down arrow, and then click News articles.)

4 Provide additional search information as appropriate.

5 Click Search.



Reading a News Article
You open a news article to read it.

1 At the News Desktop, click the Articles side button.

2 Click the Read top tab.

3 Click a folder.

4 Click Open.

5 Click an article.

6 Click Open.



Saving a News Article
Saving a news article (story) to your Filing Cabinet lets you read the news article again later offline.    

1 At the News Desktop, click the Articles side button.

2 Click the Read top tab.

3 Click a folder.

4. Click Open.

5. Click an article.

6. If you want to file (save) the article immediately, click File It.

7. If you want to mark the article to be filed at a later time, rather than immediately, click File Later.    
(The file request will be added to your To-Do List.)



Printing a News Article
To print the news article (story) you are reading, choose Print from the File menu in the article window.



Marking a News Article for Retrieval
Use the File Later button to mark an article for later, rather than immediate, retrieval.

1 At the News Desktop, click the Articles side button.

2 Click the Read top tab.

3 Click a folder.

4 Click Open.

5 Click an article.

6 Click File Later. (The file request will be added to your To-Do List.)



Deleting a News Article
If you are reading an article (story) in a Personal Folder, you can delete the article by clicking the Delete 
button.



Home Desktop
In CompuServe 3, all your activity begins at the Home Desktop.    You use this desktop to locate services 
or information by using these elements:

Menu bar provides you with these menus of commands:

File (New Text File, New Mail Message, New Forum Message, Open, Close, Save, Add to Favorite 
Places, Filing Cabinet, Address Book, To-Do list, Filing Cabinet Utilities, Page Setup, Print, Run, and Exit 
commands).    Helps you manipulate files and special storage areas.

Edit (Undo, Cut, Copy, Paste, Clear, Select All, Paste From commands).    Helps you manipulate text.

Access (Favorite Places, Find, Go, Terminal Emulator, CompuServe Directory, Connect, Connection 
Status, and Preferences commands).    Helps you connect to or find information services as well as 
customize your CompuServe 3 software. 

Services (Table of Contents, What's New, Internet, Member Services, Latest Weather, Latest News, 
Executive News Services, Stock Quotes, Financial Portfolio Forums and Communities, and Chat 
commands).    Helps you quickly access popular services.

Mail (Create New Mail, Get New Mail, Send/Retrieve All Mail, Send File, and Address Book commands).   
Helps you to create and receive Mail, send files, and maintain your Mail addresses.

Window (displays menu items for each open window).    Helps you quickly display a particular window.

Tool bar provides you with a list of the most recent places you've visited as well as single-click access to 
popular commands.

The Home Desktop provides you with these side tabs which display page tabs that you can use to explore
CompuServe 3 and CompuServe Interactive (CSi):

Main Menu (displays the Main Menu and Assistance page tabs).    Helps you quickly connect to popular 
CSi services.

Go (displays the Go, Favorite Places, and Parental Controls page tabs).    Helps you easily access a 
service, display a list of your favorite services, and control access to certain services.

Find (displays the Services, Files, and Members page tabs).    Helps you find a particular service, Forum 
area file, or CSi member.

Mail Center (displays the Read, Create, Address Book, and Search page tabs).    Helps you manipulate 
your electronic Mail and list of electronic messages.

My Information (displays the Filing Cabinet and To-Do List page tabs).    Helps you quickly review your 
membership information, items stored in your Filing Cabinet, and tasks pending in your current session.

Learn About (displays the CompuServe, Mail, Getting Around, and The Internet page tabs).    Helps you 
understand several types of services on CSi as well as introduces you to the Mail Center, methods for 
locating information, and the Web browser.

Status bar provides you with icons showing connection status, connect time, Mail message count, and 
status messages.



Forum Desktop
Message Boards, file libraries, and conferences are all found in the Forum Desktop.    Use these elements
to explore the Forum area:

Menu bar provides you with these menus of commands:

File (New Text File, New Mail Message, New Forum Message, Open, Close, Save, Add to Favorite 
Places, Filing Cabinet, Address Book, To-Do list, Filing Cabinet Utilities, Page Setup, Print, Run, and Exit 
commands).    Helps you manipulate files and special storage areas.

Edit (Undo, Cut, Copy, Paste, Clear, Select All, Paste From commands).    Helps you manipulate text.

Access (Favorite Places, Find, Go, Terminal Emulator, CompuServe Directory, Connect, Connection 
Status, and Preferences commands).    Helps you connect to or find information services as well as 
customize your CompuServe 3 software. 

Services (Table of Contents, What's New, Internet, Member Services, Latest Weather, Latest News, 
Executive News Services, Stock Quotes, Financial Portfolio Forums and Communities, and Chat 
commands).    Helps you quickly access popular services.

Forum (Create Forum Message, Contribute Library File, Search, Get Announcements, Get Waiting 
Messages, See More Messages, Ignore All Invitations, Who’s Here List, Rooms List, Modify Prohibited 
List, Change Nickname, Change Member Profile, Tracking, and Leave commands).    Helps you use the 
Forum area.

Window (displays menu items for each open window).    Helps you quickly display a particular window.

Tool bar provides you with a list of the most recent places you've visited as well as single-click access to 
selected popular commands.

The Forum Desktop provides you with these side tabs which display page tabs that you can use to 
explore CompuServe3 and CompuServe Interactive (CSi):

Welcome (displays the Welcome, Announcements, and Members page tabs).    Helps you understand 
and use the Forum area.

Message Boards (displays the Read, Create, and Search page tabs).    Helps you read, send, and 
search for messages in the Forum area.

File Libraries (displays the Read, Create, and Search page tab).    Helps you view or search for files in 
the Forum area as well as contribute (upload) your own to the Forum area.

Forum Conference (displays the Public Rooms, Who's Here, and Friends page tabs).    Helps you locate 
and start a conversation with anyone else in the Forum area or just your special friends.

Learn About (displays the What is a Forum, Message Boards, File Libraries, and Conferences page 
tabs).    Helps you understand the purpose of a Forum area as well as its three major parts.

Leave Forums exits the Forum area and displays the Home Desktop.

Status bar provides you with icons showing connection status, connect time, Mail message count, and 
status messages.



News Desktop
The News Desktop helps you search for, read, and file news articles (stories) as well as maintain (create) 
news Personal and Public Folders.    Use these elements to explore the news desk:

Menu bar provides you with these menus of commands:

File (New Text File, New Mail Message, New Forum Message, Open, Close, Save, Add to Favorite 
Places, Filing Cabinet, Address Book, To-Do list, Filing Cabinet Utilities, Page Setup, Print, Run, and Exit 
commands).    Helps you manipulate files and special storage areas.

Edit (Undo, Cut, Copy, Paste, Clear, Select All, Paste From commands).    Helps you manipulate text.

Access (Favorite Places, Find, Go, Terminal Emulator, CompuServe Directory, Connect, Connection 
Status, and Preferences commands).    Helps you connect to or find information services as well as 
customize your CompuServe 3 software. 

Services (Table of Contents, What's New, Internet, Member Services, Latest Weather, Latest News, 
Executive News Services, Stock Quotes, Financial Portfolio Forums and Communities, and Chat 
commands).    Helps you quickly access popular services.

News (Get All Personal Articles, Get Announcements, and Leave commands).    Helps you quickly view 
news articles (stories) and Announcements.

Window (displays menu items for each open window).    Helps you quickly display a particular window.

Tool bar provides you with a list of the most recent places you've visited as well as single-click access to 
selected commands.

The News Desktop provides you with these side tabs which display page tabs that you can use to explore
CompuServe 3 and CompuServe Interactive (CSi):

Welcome (displays the Lobby page tab).    Helps you understand and use the News desktop.

Articles (displays the Read, Search, and Create Folders page tabs).    Helps you search for and read 
news articles (stories) as well as create, change, and delete clipping folders.

Learn About (displays the What is News, Articles, and Personal Folders page tabs).    Helps you 
understand the purpose of a ENS as well as the use of clipping folders.

Leave News exits the News desk and displays the Home Desktop.

Status bar provides you with icons showing connection status, connect time, Mail message count, and 
status messages.



Chat Desktop
The Chat Desktop helps you communicate with friends (new and old) on CompuServe Interactive (CS3) 
in Public Rooms or Private Chats.    Use these elements to explore the Chat area:

Menu bar provides you with these menus of commands:

File (New Text File, New Mail Message, New Forum Message, Open, Close, Save, Add to Favorite 
Places, Filing Cabinet, Address Book, To-Do list, Filing Cabinet Utilities, Page Setup, Print, Run, and Exit 
commands).    Helps you manipulate files and special storage areas.

Edit (Undo, Cut, Copy, Paste, Clear, Select All, Paste From commands).    Helps you manipulate text.

Access (Favorite Places, Find, Go, Terminal Emulator, CompuServe Directory, Connect, Connection 
Status, and Preferences commands).    Helps you connect to or find information services as well as 
customize your CompuServe 3 software. 

Services (Table of Contents, What's New, Internet, Member Services, Latest Weather, Latest News, 
Executive News Services, Stock Quotes, Financial Portfolio Forums and Communities, and Chat 
commands).    Helps you quickly access popular services.

Chat (Get Announcements, Ignore All Invitations, Who’s Here List, Rooms List, Modify Prohibited List, 
Change Nickname, Tracking, and Leave commands).    Helps you quickly control your interactions on the 
Chat desktop.

Window (displays menu items for each open window).    Helps you quickly display a particular window.

Tool bar provides you with a list of the most recent places you've visited as well as single-click access to 
selected commands.

The Chat Desktop provides you with these side tabs which display page tabes that you can use to explore
CompuServe 3 and CompuServe Interactive (CSi):

Welcome (displays the Welcome page tab).    Helps you understand and use the Chat desktop.

Chat (displays the Public Rooms, Who's Here, and Friends page tabs).    Helps you locate and start 
conversation with anyone else in the Chat area or just your special friends.

Learn About (displays the What is Chatting, Public Rooms, Private Chats, and Group Chats page tabs).   
Helps you understand how to engage in the different kinds of chats.

Leave Chat exits the Chat desktop and displays the Home Desktop.

Status bar provides you with icons showing connection status, connect time, Mail message count, and 
status messages.



Browser Desktop
Your CompuServe screen changes as you explore CompuServe Interactive (CSi) services and Internet 
locations.

You can click (or double-click in some instances) the colorful graphics and buttons and assorted menu 
topics to view related services and information.

You can use the buttons along the top of your screen to go to other Web pages, Internet locations, and 
CSi services.    

(You can position your arrow cursor over a Toolbar button for a few moments to learn what it represents.)

If you are having trouble getting to a service, click the Go button at the top of your screen, type the name 
of the service, and then click OK.    If the Go feature is unable to locate the service, you will be given the 
opportunity to search for it.

You can also click the Find button to locate services.

What you see on your screen

Page displays the title of the current page.    Click the arrow to view the titles of other pages visited during 
your session.    (You can click a page to go directly to that page too.)

Go button enables you to go directly to a location that you specify.

 button redisplays the page you visited prior to the current page.

 button redisplays the page you visited after the current page.

Working indicator (to the left of the Main Menu button) is visible and animated only when transfer to a 
new page is in progress.

Main Menu button takes you back to the Main Menu page (on the CompuServe 3 Home Desktop.)

File It button opens your Filing Cabinet.

Reload button retrieves graphics for menus.

What's New button displays the latest news highlights with links to the full articles.

Find button enables you to locate services based on a topic that you specify.

Stop button interrupts the retrieval of graphics.    (You will not see this button all the time.)



These topics were moved from the L1 and L2 files to make common repository.    Also two new 
ones for F1 support made on 13-May



Saving Items in the Filing Cabinet

If you want to store a Mail message, Forum message, news article (story), or other type of text article to 
review or use later, you can save it to your Filing Cabinet.    Simply click the File It button in the message 
or article window, and then select or create the folder where you want to store it.

To access the Filing Cabinet, click the My Information side button (on the Home Desktop), and then click 
the Filing Cabinet top tab.



Finding Access Phone Numbers

If you travel frequently and connect to CompuServe Interactive (CSi) from different locations, you will 
need to learn the best access phone number for your particular location.    Access phone numbers can 
also change unexpectedly.

To find access phone numbers, click the Main Menu side button (on the Home Desktop), click the 
Assistance top tab, and then click the Access Phones button.



Cancelling an Activity

There might be times when you want to cancel an activity or task in progress.    For example, while 
searching for a file, you might cancel the search to redefine the search terms.

In progress indicator windows, you can click the Cancel button (in the window) to cancel the task 
that is currently in progress.

In the Browser Desktop, you can click the Stop button (near the Toolbar) to cancel a task 
currently in progress there.



Confirming Online Status

You can confirm your online status by looking at the lower left-hand corner of the CompuServe window.

If you are connected to CompuServe Interactive (CSi), the connection counter beside the globe shown 
there will be displaying an increasing count of your connect time.

If the up and down arrows beside the globe are blinking, it means that information is being transmitted 
between your computer and CSi.

You can also look at the Connect or Disconnect button (the hands) on the CompuServe 3 Toolbar.    If the 
two hands are clasped (a handshake), you are connected to CSi.    If the two hands are not clasped (no 
handshake), you are not connected to CSi.



Contacting Customer Service

To contact CompuServe Customer Service, click the My Information side button (on the Home Desktop), 
click the Membership Information top tab, and then click the Customer Service button.

You can review your membership account information at the Membership Information page, too.    (Click 
the Account Information button.)

You can also contact the nearest CompuServe Customer Service office for assistance at any time.

List of CompuServe Offices
Argentina 
Australia/New Zealand 
Austria 
Chile 
Colombia
France 
Germany 
Hong Kong 
Hungary 
Israel 
Japan 
Mexico 
Netherlands
Singapore
South Africa 
South Korea 
Switzerland 
Taiwan 
United Kingdom 
United States/Canada 
Venezuela 
Other Countries



Using the To-Do List

Throughout your CompuServe 3 session you can create an ongoing To-Do List of tasks you want to 
perform, such as retrieving Forum Message Topics or sending Mail messages.    You can then process the
tasks on your To-Do List all at once (or individually) whenever you like.

You add tasks to your To-Do List by clicking buttons such as Retrieve Later (rather than Retrieve), Send 
Later (rather than Send), and so forth, as appropriate.

To view your To-Do List, click the My Information side button (on the Home Desktop), and then click the 
To-Do List top tab.



Making a Web Page

CompuServe's Home Page Wizard software offers you an easy way to design a personal Web page.    
(You can also use other authoring tools.)

You can design your Web page to include pictures, sound files, jumps to other Web pages, and more.

You can then use the Publishing Wizard to copy your Web page to the Internet, where it can be viewed by
millions.



Using Parental Controls

You can use Parental Controls to limit your child's access to the Internet and CompuServe Interactive 
(CSi).    

To go to the CompuServe Parental Controls Center, click the Go side button (on the Home Desktop), click
the Parental Controls top tab, and then click the Parental Controls button.



Going to the Internet

Here are just a few of the many ways you can go to the Internet:

Click the Go side button (on the Home Desktop), and then click the Go top tab to go directly to a 
Web page that you have visited recently or that you specify.

Click the Main Menu side button (on the Home Desktop), and then click the Internet button.

Choose Internet from the Services menu to start the Web Browser and access the CompuServe 
Interactive (CSi) home page on the World Wide Web.

If a choice on a menu or list of services accesses the Internet and you click it, you will go to the 
Internet.



Using the Web Browser

The Web Browser is started automatically whenever you go to the Internet.

You can choose Internet from the Services menu to go directly to the CompuServe Interactive (CSi) 
home page on the World Wide Web.

If you are running Windows 95 and you go to a Web page, the Web page will be displayed within the 
CompuServe window.    However, if you are not running Windows 95 and you go to a Web page, the Web 
page will not be displayed within the CompuServe window, but will be displayed externally (apart from 
your CompuServe 3 software.)



Mapping Message Topics

From time to time, while reading Forum messages, you might want to map the Message Topic.

A message map is similar to a genealogy chart.    It shows the relationships that a message has to other 
messages in the topic.    You can also display messages from a message map.

To map a Message Topic, click the Map button (in the Read Forum Message window) while reading a 
Forum message or while viewing a list of Message Topics.



Viewing Only Today's Messages

To set up a search for today's Forum messages, click the Message Boards side button (at the Forum 
Desktop), and then click the Search top tab.    

Click the More button there to specify your desired submission date.    (Set it for today's date.)



Sending a Private Message

A private Forum message is visible only to those people to whom you send it.

To assign a private status to a message you want to send, click the Options button in the Create Message
window (while creating or reviewing your message), and then click the Private Forum message option.



Contacting the Sysop

Every Forum area has a Forum manager, or sysop (short for system operator).    You can contact the 
sysop by sending him or her a message.

To send a Private Message to the sysop, type *SYSOP in the Name box of the Create Message window.

If you want other Forum members to see the message, type SYSOP (without the asterisk) in the Name 
box instead.



Viewing a List of Upcoming Conferences

You can review Forum Conference schedules at the Announce page in a Forum area.    (To get there, click
the Welcome side button, and then click the Announce top tab.)



Going to the Executive News Service

The Executive News Service is a news clipping service that collects news articles (stories) according to 
your preferred search interests.

To go to the Executive News Service, choose Go from the Access menu, and then type ENS.



Submitting a Question in a Moderated Conference

You can submit a question at any time during a Moderated Conference.

In your Moderated Chat window, click the Ask button, type your question, and then click the Submit button
shown there.



Changing a Question in a Moderated Conference

Once you have submitted a question in a Moderated Conference, you might want to change and resubmit
it.

In your Moderated Chat window, click the Ask button, edit your question, and then click the Resubmit 
button shown there.



Withdrawing a Question in a Moderated Conference

Once you have submitted a question in a Moderated Conference, you might want to withdraw it.

In your Moderated Chat window, click the Ask button, and then click the Withdraw button shown there.



Viewing Voting Results in a Moderated Conference

To view the current results of a vote, click the Tally button in the Moderated Chat window.

Each time you click the Tally button, the voting results will be updated if new ballots have been cast.

Upon completion of the vote, the conference moderator will post the voting results for all to see.



Learning Service Names

Conduct a Services search to learn the names (Go words) of CompuServe Interactive (CSi) services.

1 At your Home Desktop, click the Find side button.

2 Click the Services top tab.

3 Type SERVICES in the provided box.

4 Click Search.



Using the Define Connection Window

1 If you want to change the value shown in the Port box, click the down arrow and then click the choice 
you want.    

Port, or communications port, refers to the plug on the back of your computer used for 
communications, usually where your telephone line plugs in to your modem.

2 If you want to change the value shown in the Port speed box, click the down arrow and then click the 
choice you want.

Port speed, or baud, indicates your current speed at which data will be transmitted over your 
communications line.    Your modem must support the port speed that you select.

3 If you want to change the value shown in the Access network box, click the down arrow and then click
the choice you want.

Access network is the combinations of lines, satellites, and machines that enable your computer to 
exchange information with CompuServe.

4 If you want to change the value shown in the Dial type box, click the down arrow and then click the 
choice you want.

Dial type indicates how your modem dials a phone number to connect to CompuServe Interactive 
(CSi), such as Tone for a touchtone phone.    Select Direct only if your computer is hard-wired to 
another computer system which provides the connection for you.

5 If you want to change the value shown in the Access phone box, type it in the box.

Access phone number is the CompuServe local access telephone number to be used to connect to 
CompuServe.    (Do NOT type your home or business telephone number here.)

6 If you want to review or provide modem-specific information, click Define Modem.

7 If you will be connecting through a communications port that access a LAN or modem pool that 
makes your connection to CompuServe for you, click LAN to specify required information.

8 Click Next.



Replying to a Message

Follow these steps to reply to any incoming Mail message.

1 If the message you want to reply to is not currently opened, find it and open it.

2 Click Reply (in the message window).

3 Compose your reply and provide any other necessary information.

4 Click Send.



Sending to the Internet

Follow these steps to create an Internet address format as you compose a Mail message.

1 In the Address box within your Create Mail window, type the word INTERNET

2 Type a colon (:)

3 Type the person's Internet address

4 Type an at sign (@)

5 Type the address domain

Example
INTERNET:HORATIO@CLEVELAND.FREENET.EDU



Receiving from the Internet

Tell your Internet correspondents to use one of the following address formats to send Mail to your CSi 
mailbox:

User ID@COMPUSERVE.COM.    Be sure to replace the comma in your User ID number with a 
period.

Personal Address@COMPUSERVE.COM.    Your Personal Address is not case-sensitive.

Examples
70009.1234@COMPUSERVE.COM
MaxNix@COMPUSERVE.COM



How to Telnet to CSi

Follow these steps to telnet to CSi from a computer connected to the Internet:

1 At the appropriate command prompt, type TELNET COMPUSERVE.COM, and then press Enter.

2 At the Host Name: prompt, type CISAGREE, and then press Enter.

4 At the Enter choice <300,2400,9600,14400,OFF>: prompt, type a baud rate, and then press Enter.

5 At the User ID: prompt, type your CSi member ID number, and then press Enter.

6 At the Password: prompt, type your CSi password, and then press Enter.



Internet-Related Forum Areas

Here are a few of the many Internet-related Forum areas on CSi:

Deutsches Internet Forum is devoted to information about the Internet for German speakers.    
GO GERINT.

Internet Commerce Forum is devoted to information about the conduct of commerce on the 
Internet.    GO INETCO.

Internet Developers Forum is devoted to information about developing software products for the
Internet.    GO INETDEV.

Internet France Forum is devoted to information about the Internet for French speakers.    GO 
INETFR.

Netherlands Internet Forum is devoted to information about the Internet for Dutch speakers.    
GO NLINTER.

Internet New Users Forum is devoted to helping new people take advantage of the tremendous 
resources available on the Internet.    GO INETNEW.

Internet Publishing Forum is devoted to information about Web page development as well other
publishing on the Internet (including the World Wide Web).    GO INETPUB.

Internet Resources Forum is devoted to information about advanced Internet topics.    GO 
INETRES.

Internet Webmasters Forum is devoted to information about creating the physical Internet sites 
(such as connecting a Web server to the Internet or becoming a provider).    GO INETWEB.

CompuServe Application Support Forum is devoted to addressing service-related issues and 
supporting CompuServe's Home Page Wizard products.    GO NLSUPP.



Attending a Moderated Conference

To attend a Moderated Conference:

1 Click the Forum Conference side button.

2 Click the appropriate Public Room.

3 Click Participate.



Nickname Rules

Your nickname may have a maximum of 19 characters, but may not contain asterisks (*), pound signs (#),
or braces ({ or }).    

Your nickname may contain embedded spaces, but CSi removes leading or trailing spaces.    For 
example, Joe_Modem and Joe Modem are both valid nicknames.    

A nickname cannot be obscene or offensive to the average person.



Changing Your Forum Conference Nickname

To change the nickname that is attached to your conference comments in this Forum area

1 Choose Change Nickname from the Forum menu.

2 In the Define Nickname window, type the nickname you want to use in future conferences.

3 Click OK.



Retrieving an Entire Folder
You can retrieve (download) an entire folder, but only if the folder is one of your Personal Folders.

1 Click the Articles side button.

2 Click a Personal Folder.

3 To retrieve the folder immediately, click File It.    To mark the folder for later retrieval, click File Later. 
(The retrieval request will be added to your To-Do List.)



Deleting from an ENS Folder
You can delete one or more articles without opening them from one of your Personal Folders in ENS.

1 Click the Articles side button.

2 Click a Personal Folder.

3 Click Open.

4 Click an article.    To delete multiple articles, hold down the Control key while you click each article.

5 Click Delete.

6 In the ensuing window, which asks whether you want to delete the first selected article, click Yes.

7 Repeat Step 6 for each article you selected in Step 4.



Ignoring Group Chat Invitations

The Groups checkbox in your Chat preferences controls whether invitations to participate in Group Chats 
(Group Invitations) will be displayed on your screen while you are in Chat.

1 Choose Preferences from the Access menu.

2 Click the Chat top tab.

3 Mark the Groups checkbox (under Ignore invitations for).

4 Click OK.



Adding a Friend to your Friends List

1 At the Chat desktop, click the Chat side button.

2 Click the Friends top tab.

3 Click the New button.

4 In the Select Friends window, click the listing for someone you want to add.

5 If you want to add someone else, hold down the Control key while you click that person’s listing.    You
can repeat this step as many times as you like.

6 Click OK.

7 In the ensuing window, click Yes if you want to add your new frind’s name and Csi Mail address to 
CompuServe 3’s Address Book.    Otherwise, click No.    Thsi window apears once for every friend that
you selected in Steps 2 and 3.



Starting a Private Chat

You send an invitation to someone to start a Private Chat.

1 Click the Chat side button.

2 Click the Who's Here top tab.

3 Click a name.

4 Click Start Private Chat.



New Command
The New command displays commands for creating a new Mail message, Forum message, or a text file.

Mail Message displays a window for creating a Mail message

Forum Message displays a window for creating a Forum message

Text displays a window for creating a text file.

The New command is on the File menu.



Open Command
The Open command displays a window for selecting and opening image and text files as well as file 
folders.

The Open command is on the File menu.



Close Command
The Close command closes the active window.

The Close command is on the File menu.



Save Command
The Save command stores the following information to a file you select or name:

All the text in the active text window.

Images in the active image window.

The Save command is on the File menu.



Filing Cabinet Command
The Filing Cabinet command displays a window that lets you store and organize information in one or 
more Filing Cabinet folders.

The Filing Cabinet command is on the File menu.

You can save the following items in your Filing Cabinet:

Mail messages

Forum area messages

Executive News Service articles (stories)

Text articles



Address Book Command
The Address Book command displays a window that helps you add and maintain mailing addresses.

The Address Book command is on both the File and Mail menus.

Use the Address Book for these maintenance activities:

Adding new addresses

Creating Group Mailing Lists

Opening addresses

Deleting addresses



Printer Setup Command
The Printer Setup command displays a window that lets you select options for your printer.

The Printer Setup command is on the File menu.



Print Command
The Print command prints the following information:

All the text in the active text window.

Images in the active image window.

The Print command is on the File menu.



Run Command
The Run command displays a window that lets you start a program.

The Run command is on the File menu



Exit Command
The Exit command closes the CompuServe 3 software.

The Exit command is on the File menu.

If you are connected, this command disconnects you before closing the CompuServe 3 software.



Undo Command
The Undo command lets you undo your last action.

The Undo command is on the Edit menu.



Cut Command
The Cut command lets you remove the highlighted text and place it on the clipboard.

The Cut command is on the Edit menu.



Copy Command
The Copy command lets you duplicate the highlighted text and place it on the Clipboard.

The Copy command is on the Edit menu.



Paste Command 
The Paste command lets you put the contents of the clipboard at the insertion point.

The Paste command is on the Edit menu.



Clear Command
The Clear command deletes highlighted text.

The Clear command is on the Edit menu.



Select All Command
The Select All command lets you select (block) the contents of a text composition area (so that it is 
highlighed for copying or cutting).

The Select All command is on the Edit menu.



Show Clipboard Command
The Show Clipboard command lets you see the contents of the clipboard.

The Show Clipboard command is on the Edit menu (Macintosh only).



Preferences Command
The Preferences command lets you customize various aspects of CompuServe 3.

The Preferences command is on the Access menu.



Favorite Places Command
The Favorites Places command lets you display a window that lists favorite CompuServe Interactive (CSi)
services or Internet locations.    You can select a favorite place for immediate access, or add, change, or 
delete places.

The Favorite Places command is on the Access menu.



Find Command
The Find command includes commands for searching for services and members:

Services displays a window for finding a CompuServe Interactive (CSi) service.

Member displays a window for finding a CSi member.

The Find command is on the Access menu.



Go Command
The Go command displays a window from which you can go to a CompuServe Interactive (CSi) service or
Internet location.    

The Go command is on the Access menu.



Terminal Emulator Command
The Terminal Emulator command displays a window that lets you connect to CompuServe Interactive 
(CSi) using only text (no graphics or windows).

The Terminal Emulator command is on the Access menu.



Connect Command
The Connect command connects you to CompuServe Interactive (CSi).

The Connect command is on the Access menu.



Disconnect Command
The Disconnect command disconnects you from CompuServe Interactive (CSi) or the Internet, and also 
from the CompuServe network.

The Disconnect command is on the Access menu.



Connection Status Command
The Connection Status command displays a window that provides information about your phone link to 
the CompuServe network as well as the amount of time you've spent connected.

The Connection Status command is on the Access menu.



Preferences Command
The Preferences command displays a collection of preferences windows for customizing your 
CompuServe 3 software.    Preferences are grouped for your convenience, such as Mail preferences, 
Chat preferences, Toolbar preferences, and so forth.

The Preferences command is on the Access menu.



Internet Command
The Internet command starts the Web browser and displays the CompuServe Interactive (CSi) home 
page on the World Wide Web.

The Internet command is on the Services menu.



Table of Contents Command
The Table of Contents command displays a window that lets you explore CompuServe Interactive (CSi) 
services and events.

The Table of Contents command is on the Services menu.



What's New Command
The What's New command displays a window that lets you review summaries of the latest news affecting 
CompuServe Interactive (CSi) members.

The What's New command is on the Services menu.



Special Events Command
The Special Events command displays a window that lets you go to the unique offerings currently on 
CompuServe Interactive (CSi).

The Special Events command is on the Services menu.



Member Services Command 
The Member Services command displays a window that lets you go directly to member assistance areas 
on CompuServe Interactive (CSi).

The Member Services command is on the Services menu.



Latest Weather Command
The Latest Weather command displays a window that lets you get weather information for most 
geographic areas.

The Latest Weather command is on the Services menu.



Latest News Command
The Latest News command displays a window that lets you choose current news stories.

The Latest News command is on the Services menu.



Stock Quotes Command
The Stock Quotes command displays a window that lets you select issues and get their prices.

You can also organize issues into folders.

The Stock Quotes command is on the Services menu.



Financial Portfolio Command
The Financial Portfolio command displays a window that helps you calculate the current value of your 
stocks.

The Financial Portfolio command is on the Services menu.



Create Forum Message Command
The Create Forum Message command displays a window that lets you create and send a message to a 
person in a Forum area.

The Create Forum Message command is on the Forum menu.



Contribute Library File Command
The Contribute Library File command displays a window that lets you send a file to the Forum area library.

The Contribute Library File command is on the Forum menu.



Search Command
The Search command displays commands for finding messages, files, and members in a Forum area.

Messages displays a window for finding a Forum message.

Files displays a window for finding files.

Members displays a window for finding a member.

The Search command is on the Forum menu.



Get Announcements Command
The Get Announcements command displays a window of fast-breaking or otherwise important information
pertaining to the desktop or area that you are in at the time.

The Get Announcements command is on the Forum, Chat, Conference, and News menus.



Get Waiting Messages Command 
The Get Waiting Messages command displays a window that displays the Forum area messages 
addressed to you.

The Get Waiting Messages command is on the Forum menu.



See More Messages Command
The See More Messages command displays a window that lets you display and access messages based 
on date, time, or specific Forum message number.

The See More Messages command is on the Forum menu.



Ignore All Invitations Command
The Ignore All Invitations command hides any Group Invitations or Private Invitations sent to you when 
you are in a Public Room in a Forum area, Chat, or the Conference Center, for as long as you are in the 
particular area.

The Ignore All Invitations command is on the Chat, Forum, and Conference menus.



Change Forum Interests Command
The Change Forum Interests command displays a window that lets you define or change the interests 
included in your Member Profile in a Forum area.

The Change Forum Interests command is on the Forum menu.



Start Tracking Command
The Start Tracking command displays a window that lets you watch who enters and leaves, switches 
locations, and changes nicknames in an area, such as a Forum area, Chat, or the Conference Center.

The Start Tracking command is on the Forum, Chat, and Conference menus.



Leave Command

The Leave command closes the current desktop.

The Leave command is on the Forum, News, and Conference menus.



Get Announcements Command
The Get Announcements command displays a window that lets you see the official verbiage about the 
Newsdesk.

The Get Announcements command is on the News menu.



Leave Command
The Leave command closes the Newsdesk.

The Leave command is on the News menu.



Create New Mail Command
The Create New Mail command displays a window that lets you create and send electronic Mail.

The Create New Mail command is on the Mail menu.



Get New Mail Command
The Get New Mail command displays a window that lets you get electronic Mail people have sent to you.

The Get New Mail command is on the Mail menu.



Send and Receive All Mail Command

The Send and Receive All Mail command automatically retrieves (downloads) your incoming Mail (from 
your mailbox to your computer), and sends your outgoing Mail (from your Outgoing Messages folder) for 
you, as well.

The Send and Receive All Mail command is on the Mail menu.



Send File Command

The Send File command displays a window that lets you select a file and send it as part of a Mail 
message.    You can send more than one file at a time.

The Send File command is on the Mail menu.



Get Announcements Command
The Get Announcements command displays a window that lets you see the official verbiage about Chat.

The Get Announcements command is on the Chat menu.



Modify Prohibited List Command
The Modify Prohibited List command displays a window that lets you maintain a list of people you'd like to
avoid in a particular area, such as Chat, a Forum area, or the Conference Center.

The Modify Prohibited List command is on the Chat, Forum, and Conference menus.

The people listed are blocked from all chats, Group Invitations and Private Invitations, and are not 
displayed in group and room windows or the Who's Here List.    However, they can still detect your 
presence.



Change Nickname Command
The Change Nickname command displays a window that lets you create or change your nickname in 
Chat.

The Change Nickname command is on the Chat menu.



Contents Command
The Contents command displays the help system Contents page.

The Contents command is on the Help menu.



Search for Help on Command 
The Search for Help on command displays a window where you can search for help topics.

The Search for Help on command is on the Help menu.



What's New in 3 Command
The What's New in 3 command displays a summary of new features for CompuServe 3.

The What's New in 3 command is on the Help menu.



Upgrading to CompuServe 3 from CIM Command
The Upgrading to CompuServe 3 from CIM command displays information about upgrading to 
CompuServe 3 from Versions of CIM.

The Upgrading to CompuServe 3 from CIM command is on the Help menu.



How to Use Help Command
The How to Use Help command displays a window that offers tips for using the help system.

The How to Use Help command is on the Help menu.



CompuServe Directory Command
The CompuServe Directory command displays a listing of hundreds of services and locations on 
CompuServe Interactive (CSi).    You can access such services directly from the CompuServe Directory.

The CompuServe Directory command is on the Access menu.



About CompuServe for Windows Command
The About CompuServe for Windows command displays the CompuServe About Box so that you can 
review Version information.

The About CompuServe for Windows command is on the Help menu.



Home Desktop Command
The Home Desktop command enables you to return to the Home Desktop.

Each of the commands on the Windows menu corresponds to a desktop that you recently visited in your 
CompuServe 3 session.    If you click a Windows command, you will return to that desktop.

The Home Desktop command is on the Windows menu.



Forum Desktop Command
The Forum Desktop command enables you to return to the Forum Desktop.

Each of the commands on the Windows menu corresponds to a desktop that you recently visited in your 
CompuServe 3 session.    If you click a Windows command, you will return to that desktop.

The Forum Desktop command is on the Windows menu.



News Desktop Command
The News Desktop command enables you to return to the News Desktop.

Each of the commands on the Windows menu corresponds to a desktop that you recently visited in your 
CompuServe 3 session.    If you click a Windows command, you will return to that desktop.

The News Desktop command is on the Windows menu.



Conference Center Desktop Command
The Conference Center Desktop command enables you to return to the Conference Center Desktop.

Each of the commands on the Windows menu corresponds to a desktop that you recently visited in your 
CompuServe 3 session.    If you click a Windows command, you will return to that desktop.

The Conference Center Desktop command is on the Windows menu.



Browser Desktop Command
The Browser Desktop command enables you to return to the Browser Desktop.

Each of the commands on the Windows menu corresponds to a desktop that you recently visited in your 
CompuServe 3 session.    If you click a Windows command, you will return to that desktop.

The Browser Desktop command is on the Windows menu.



Settings and Preferences



Setting Your Forum Area Preferences
Forum preferences enable you to customize your Forum sessions.    You can specify the names you want 
to go by in a Forum area, as well as whether to automatically file copies of messages that you send.    You
can also set preferences for your Forum conferences (chats).

1 Choose Preferences from the Access menu.

2 Click the Forums top tab.

3 Provide your information.

4 Click OK.



Choosing Your Forum Conference Nickname
Initially, the name attached to your comments in Forum conferences is the same as the name assigned to
your account.    If that seems a bit formal, you can use the nickname of your choice.    You can define a 
global nickname and/or define a nickname for use within a particular Forum.

To define a global nickname

1 Choose Preferences from the Access menu.

2 Click the Forums top tab.

3 In the Name to use while conferencing box, type the nickname to be attached to your conference 
comments in Forum areas at large.

4 Click OK.

To define a nickname for conferencing in a particular Forum area

1 In the Forum area, choose Change Nickname from the Forum menu.

2 In the Define Nickname window, type the nickname to be attached to your conference comments in 
this Forum area (and only this Forum area).

3 Click OK.



Auto-Filing Sent Forum Messages
The Keep a copy of all sent mail in checkbox causes all Forum messages that you send to be filed 
automatically in your Filing Cabinet.

1 Choose Preferences from the Access menu.

2 Click the Forums top tab.

3 Mark the Keep a copy of all sent mail in checkbox.

4 Click Select Folder.

5 Specify the folder in which you want to save copies of your sent messages in the corresponding box. 

6 Click OK.



Setting Chat Preferences
Chat preferences enable you to customize your Chat sessions.    You can specify a Chat nickname, as 
well as preferences related to your Prohibited Users List, recording Chat conversations, ignoring 
invitations, and retrieving graphics and sound files.

1 Choose Preferences from the Access menu.

2 Click the Chat top tab.

3 Provide your information.

4 Click OK.



Adding People to the Prohibited List Permanently
The Permanently option ensures that the people you add to your Prohibited List will remain on the list 
indefinitely.

1 Choose Preferences from the Access menu.

2 Click the Chat top tab.

3 Click Permanently (under Add prohibited users to list).

4 Click OK.



Adding People to the Prohibited List Temporarily
The For today only option ensures that the people you add to your Prohibited List will remain on the list 
only for the duration of your Chat session.

1 Choose Preferences from the Access menu.

2 Click the Chat top tab.

3 Click For today only (under Add prohibited users to list).

4 Click OK.



Requesting a Prompt for Adding People to the Prohibited List
The Ask me option ensures that you will be prompted each time you add a person to the Prohibited List 
as to whether the person should remain on the list indefinitely or just for the current Chat session.

1 Choose Preferences from the Access menu.

2 Click the Chat top tab.

3 Click Ask me (under Add prohibited users to list).

4 Click OK.



Creating a Chat Transcript File
The Record chat text feature causes a Chat transcript file to be created each time you participate in or 
observe a chat.

1 Choose Preferences from the Access menu.

2 Click the Chat top tab.

3 Mark the Record chat text checkbox (under Record conversations).

4 Click OK.



Appending Chat Text to a File
The Add new text to the room's log file feature enables future chats to be appended to an ongoing chat 
transcript (log) file.

1 Choose Preferences from the Access menu.

2 Click the Chat top tab.

3 Mark the Record chat text checkbox (under Record conversations).

4 Click OK.



Ignoring Private Chat Invitations
The Private checkbox in your Chat preferences controls whether invitations to participate in Private Chats 
will be displayed on your screen while you are in Chat.

1 Choose Preferences from the Access menu.

2 Click the Chat top tab.

3 Click the Private checkbox (under Ignore invitations for).

4 Click OK.



Requesting that Graphics Files be Retrieved
The Graphics files feature enables you to retrieve (download) and view graphics files that are sent while 
participating in a conference (chat).

1 Choose Preferences from the Access menu.

2 Click the Chat top tab.

3 Mark the Graphics files checkbox (under Retrieve).

4 Click OK.



Requesting that Sound Files be Retrieved
The Sound files feature enables you to retrieve (download) and hear sound files that are sent while 
participating in a conference (chat).

1 Choose Preferences from the Access menu.

2 Click the Chat top tab.

3 Mark the Sound files checkbox (under Retrieve).

4 Click OK.



Requesting that All Retrieved Files be Saved
The Save all retrieved files feature causes all graphics and sound files sent during a conference (chat) to 
be saved automatically on your computer.

1 Choose Preferences from the Access menu.

2 Click the Chat top tab.

3 Mark the Save all retrieved files checkbox (under Retrieve).

4 Click OK.



Setting Your Fonts Preferences
Fonts preferences determine how characters, such as letters and numbers, look on your screen.

1 Choose Preferences from the Access menu.

2 Click the Fonts top tab.

3 Provide your information.

4 Click OK.



Changing the Appearance of Letters on Your Screen
The Change button in your Fonts preferences enables you to change the appearance of characters, such 
as letters and numbers, on your screen.

1 Choose Preferences from the Access menu.

2 Click the Fonts top tab.

3 Click the display category in the Item list box.

4 Click Change.

5 Click the desired font and size.

6 Click OK.

The Default button changes text back to its original (default) appearance (font and size).    



Setting General Preferences
General preferences enable you to define a default Web browser to be used with CompuServe 3, as well 
as preferences related to saving opened graphics files, displaying graphic versions of menus, displaying 
warning windows, and changing default directories (folders).

1 Choose Preferences from the Access menu.

2 Click the General top tab.

3 Provide your information.

4 Click OK.



Defining Your Default Internet Browser
The Internet feature enables you to specify a particular Web browser to be used with CompuServe 3.

1 Choose Preferences from the Access menu.

2 Click the General top tab.

3 Click the Select button beside the Internet Browser box.

4 Locate the browser you want to use as the default, click it, and then click OK.

5 In the General preferences window, click OK.



Requesting a Save Opened Graphics Prompt
The Prompt to save opened graphics feature ensures that you will be reminded about saving an opened 
graphic when you attempt to close it.

1 Choose Preferences from the Access menu.

2 Click the General top tab.

3 Mark the Prompt to save opened graphics checkbox.

4 Click OK.



Retrieving Graphic Versions of Menus
The Retrieve graphic versions of menu feature enables you to view many CompuServe Interactive (CSi) 
menus in a colorful, graphic presentation.

1 Choose Preferences from the Access menu.

2 Click the General top tab.

3 Mark the Retrieve graphic versions of menus checkbox.

4 Click OK.



Displaying All Warning Dialogs
The Display all warning dialogs feature ensures that cautionary messages are displayed on your screen 
whenever appropriate.    (Previously dismissed messages will be reenabled.)

1 Choose Preferences from the Access menu.

2 Click the General top tab.

3 Mark the Display all warning dialogs checkbox.

4 Click OK.



Setting Connection Preferences
Connection preferences contain the information that is required for you to make a connection to 
CompuServe Interactive (CSi) or the Internet, such as your communications port, access telephone 
number, and so forth.

1 Choose Preferences from the Access menu.

2 Provide your information.

3 Click OK.



Creating a Connection Set
The Add feature in your Connection preferences enables you to create secondary connection sets for 
alternative connection requirements, such as when having to change a telephone access number in order
to connect from a different location.

1 Choose Preferences from the Access menu.

2 Retain or change the information as appropriate.    This includes content associated with the Define 
Modem and Define Advanced buttons.

3 Click Add.

4 Specify a name for the new connection set.

5 Click OK.



Deleting a Connection Set
The Delete feature in your Connection preferences enables you to remove unneeded connection sets.

1 Choose Preferences from the Access menu.

2 Click the connection set in the Connection box that you want to delete.    (Click the down arrow, and 
then click a connection set.)

3 Click Delete.



Changing Your Member Name
The Member name box in your Connection preferences indicates the name you want to use when using 
CompuServe Interactive (CSi). 

1 Choose Preferences from the Access menu.

2 Change the name in the Member name box as appropriate.

3 Click OK.



Changing Your Member ID
The Member ID box in your Connection preferences indicates the CompuServe Interactive (CSi) member 
ID number you want to use to connect to CSi or the Internet. 

1 Choose Preferences from the Access menu.

2 Change the information in the Member ID box as appropriate.

3 Click OK.



Changing Your Password
You must be connected to CompuServe Interactive (CSi) in order to change your CSi Password.    
(Changing the password recorded in your Connection Preferences will not actually change your official 
CSi Password.)

1 Choose Go from the Access menu.

2 At the Go window, type PASSWORD, and then click OK.

3 Follow the ensuing prompts to provide the appropriate information.

4 If your previous password is recorded in your Connection Preferences, you will need to change it so 
that it matches your new password. (Specifying your password in your Connection Preferences 
streamlines your connection process, enabling you to connect to CSi without having to manually 
provide your password each time you want to make a connection.    However, if you specify your 
password in your Connection Preferences, anyone using your computer will be able to use your CSi 
account.    If you have security concerns, you should delete your password from your Connection 
Preferences.)    

To change (or delete) your password in your Connection Preferences:

1 Choose Preferences from the Access menu.

2 Change (or delete) the password in the Password box as appropriate.    You will not see your 
password as you type it, only asterisks.

3 Click OK.



Changing Your Access Phone Number
The Access phone box records the telephone number required for you to connect to CompuServe 
Interactive (CSi) or the Internet.

1 Choose Preferences from the Access menu.

2 Change the phone number in the Access phone box as appropriate.

3 Click OK.



Changing Your Communications Port
The Port box indicates the communications or COM port you want to use to connect to CompuServe 
Interactive (CSi) or the Internet.

1 Choose Preferences from the Access menu.

2 Click the arrow in the Port box.

3 Click the desired Port.

4 Click OK.



Changing Your Baud Rate
The Port speed box indicates the baud rate at which your modem will transmit and receive information.

1 Choose Preferences from the Access menu.

2 Click the arrow in the Port speed box.

3 Click the desired speed.

4 Click OK.



Changing Your Access Network
The Access network box determines the communications network that will be used to connect to 
CompuServe Interactive (CSi) or the Internet. 

1 Choose Preferences from the Access menu.

2 Click the arrow in the Access network box.

3 Click the desired network.

4 Click OK.



Changing Your Dial Type
The Dial type box determines how your modem dials to connect to CompuServe Interactive (CSi) or the 
Internety.

1 Choose Preferences from the Access menu.

2 Click the arrow in the Dial type box.

3 Click the desired dial type.

4 Click OK.



Setting Mail Preferences
Mail preferences enable you to request whether to save outgoing (unsent) messages, as well as whether 
to file (save) sent messages, whether to view Mail directly from your online mailbox, and whether to 
delete Mail from your online mailbox once retrieved (downloaded). 

1 Choose Preferences from the Access menu.

2 Click the Mail top tab.

3 Provide your information.

4 Click OK.



Auto-Deleting Retrieved Mail from Mailbox

The Delete mail from online mailbox when retrieved checkbox ensures that your CompuServe Interactive 
(CSi) mailbox will be cleaned out each time your get your Mail.

1 Choose Preferences from the Access menu.

2 Click the Mail top tab.

3 Mark the Delete mail from online mailbox when retrieved checkbox.

4 Click OK.



Viewing Mailbox Before Retrieving Mail

The View mail online before retrieving checkbox enables you to process your incoming Mail at your online
mailbox rather than retrieving it to your computer first.

1 Choose Preferences from the Access menu.

2 Click the Mail top tab.

3 Mark the View Mail online before retrieving checkbox.

4 Click OK.



Requesting a Save Message Prompt

The Prompt to save unsent messages checkbox enables you to view a reconsideration prompt whenever 
you attempt to exit with unsent messages (Outgoing Mail).

1 Choose Preferences from the Access menu.

2 Click the Mail top tab.

3 Mark the Prompt to save unsent messages checkbox.

4 Click OK.



Auto-Filing Sent Mail

The Keep a copy of all sent mail in checkbox causes all Mail messages that you send to be filed 
automatically in your Filing Cabinet.

1 Choose Preferences from the Access menu.

2 Click the Mail top tab.

3 Mark the Keep a copy of all sent mail in checkbox.

4 Click Select Folder.

5 Specify the folder in which you want to save copies of your sent Mail in the corresponding box. 

6 Click OK.



Setting Your News Preferences
News preferences determine whether particular articles (stories) that you retrieve (download) from a 
Personal Folder in the Executive News Service will also be deleted from the online folder after they have 
been retrieved.

1 Choose Preferences from the Access menu.

2 Click the News top tab.

3 Provide your information.

4 Click OK.



Requesting that Retrieved News Articles be Removed from Folders
The Delete all retrieved feature ensures that an article (story) that you retrieve (download) from a 
Personal Folder in the Executive News Service will also be deleted from the online folder after it has been
retrieved.

1 Choose Preferences from the Access menu.

2 Click the News top tab.

3 Mark the Delete all retrieved checkbox.

4 Click OK.



Setting Your Terminal Emulation Preferences
Terminal preferences enable you to customize your terminal emulation sessions by controlling the size of 
your scrollback buffer. 

1 Choose Preferences from the Access menu.

2 Click the Terminal top tab.

3 Provide your information.

4 Click OK.



Defining the Terminal Emulation Scrollback Buffer Size
The terminal emulation scrollback buffer enables you to view your recent terminal emulation activities.

1 Choose Preferences from the Access menu.

2 Click the Terminal top tab.

3 Type a number from 25-500 in the Size of scrollback buffer box.    (Type a high value.)

4 Click OK.



Automating Keystrokes in Terminal Emulation
The Function-Key Definitions feature enables you to assign one or more keystrokes to up to 10 ALT key 
combinations in terminal emulation.

1 Choose Set Function Keys from the Terminal menu in terminal emulation.

2 Determine which ALT key combination you want to define.    Type a title for the key combination in the 
appropriate box beneath Title.    For example, if the key combination returns a weather forecast, you 
could type WEATHER. 

3 Type the desired keystrokes or commands in the appropriate box beneath Command.    

4 Click OK.



Creating a Terminal Emulation Log File
The File feature enables you to log (record) your terminal emulation screen activity to a file.    

1 Choose Preferences from the Access menu.

2 Click the Terminal top tab.

3 Mark the File checkbox (beneath Record session to).

4 Click OK.



Printing a Terminal Emulation Session
The Printer feature enables you to print your terminal emulation screen activity.

1 Choose Preferences from the Access menu.

2 Click the Terminal top tab.

3 Mark the File checkbox (beneath Record session to).

4 Click OK.



Setting Your Toolbar Preferences
Toolbar preferences enable you to add and change the various buttons on your CompuServe 3 Toolbar.    
You may add as many buttons as there is room for in the Toolbar.

1 Choose Preferences from the Access menu.

2 Click the Toolbar top tab.

3 Provide your information.

4 Click OK.



Inserting a Toolbar Button
The Insert feature in your Toolbar preferences enables you to add a button to your CompuServe 3 
Toolbar.

1 Choose Preferences from the Access menu.

2 Click the Toolbar top tab.

3 Click the desired function in the Available Functions list box.    

4 Click the point at which you want to insert the new button.

5 Click Insert.

6 Provide the appropriate information. 

7 Click OK.



Deleting a Toolbar Button
The Delete feature in your Toolbar preferences removes a button from your CompuServe 3 Toolbar.

1 Choose Preferences from the Access menu.

2 Click the Toolbar top tab.

3 Click the button you want to delete in the Functions Displayed list box.

4 Click Delete.



Defining Default Directories
The Set Directories window enables you to change the directories (folders) where the files used to 
support CompuServe 3, as well as the files that you retrieve (download) while using it, are placed by 
default. 

1 Choose Preferences from the Access menu.

2 Click the General top tab.

3 Click Set Directories.

4 Click a directory.

5 Click Change.

6 In the Open window, locate and click a directory to be used as the new directory.

7 Click OK.

8 If you want to change another directory, repeat Steps 4-7.

9 In the Set Directories window, click OK.



Defining Your Modem Settings
The Modem Settings window enables you to review or define your modem command strings and modem 
security values.

1 Choose Preferences from the Access menu.

2 Click Define Modem.

3 Provide your information.

4 Click OK.



Specifying a Modem
The Modem Control Settings window enables you to specify a modem to use with your connection 
settings.

1 Choose Preferences from the Access menu.

2 Click Define Modem.

3 Click a modem in the Modem box.    (Click the down arrow, and then click a modem.)

4 Click OK.



Specifying an Initialization String
The modem initialization command string initializes your communication sequence.

1 Choose Preferences from the Access menu.

2 Click Define Modem.

3 Type the appropriate information in the Initialize box.

4 Click OK.



Specifying a Prefix String
The Prefix string is also known as the attention command

1 Choose Preferences from the Access menu.

2 Click Define Modem.

3 Type the appropriate information in the Prefix box.

4 Click OK.



Specifying a Dial Tone String
The Dial Tone string is the string that initiates tone dialing.

1 Choose Preferences from the Access menu.

2 Click Define Modem.

3 Type the appropriate information in the Dial Tone box.

4 Click OK.



Specifying a Reset String
The Reset string resets the modem.

1 Choose Preferences from the Access menu.

2 Click Define Modem.

3 Type the appropriate information in the Reset box.

4 Click OK.



Specifying an Escape String
The Escape string issues an Escape command.

1 Choose Preferences from the Access menu.

2 Click Define Modem.

3 Type the appropriate information in the Escape box.

4 Click OK.



Specifying a Connect String
The Connect string is the string or phrase that is displayed when connection is established.

1 Choose Preferences from the Access menu.

2 Click Define Modem.

3 Type the appropriate information in the Connect box.

4 Click OK.



Specifying a Suffix String
The Suffix string is the correct string to terminate a command.

1 Choose Preferences from the Access menu.

2 Click Define Modem.

3 Type the appropriate information in the Suffix box.

4 Click OK.



Specifying a Dial Pulse String
The Dial Pulse string is the string used to initiate pulse dialing.

1 Choose Preferences from the Access menu.

2 Click Define Modem.

3 Type the appropriate information in the Dial Pulse box.

4 Click OK.



Specifying a Hang Up String
The Hang Up string is used to free the telephone line.

1 Choose Preferences from the Access menu.

2 Click Define Modem.

3 Type the appropriate information in the Hang Up box.

4 Click OK.



Specifying an Acknowledge String
The Acknowledge string is the correct string or phrase displayed when a command is successfully 
received by the modem.

1 Choose Preferences from the Access menu.

2 Click Define Modem.

3 Type the appropriate information in the Acknowledge box.

4 Click OK.



Specifying a Failure String
The Failure string is the string or phrase to be displayed when there is no connection or the modem signal
stops.

1 Choose Preferences from the Access menu.

2 Click Define Modem.

3 Type the appropriate information in the Failure box.

4 Click OK.



Specifying Modem Security
The modem security feature enables you to password-protect your modem with a Member ID number and
Password.

1 Choose Preferences from the Access menu.

2 Click Define Modem.

3 Click Set Security.

4 Type the appropriate information in the Member ID and Password boxes.

5 Click OK.



Conducting a Silent Modem Sequence
The Speaker Off feature in your Modem Settings window enables you to avoid hearing your modem 
connection sounds.

1 Choose Preferences from the Access menu.

2 Click Define Modem.

3 Mark the Speaker Off checkbox.

4 Click OK.



Setting Advanced Preferences
The Advanced preferences window enables you to review or provide additional logon information that 
might be necessary for your particular network.    For example, you might want to receive notice in the 
event that your modem carrier signal is lost.

1 Choose Preferences from the Access menu.

2 Click Define Advanced.

3 Provide your information.

4 Click OK.



Defining Logon Parameters
Logon Parameters are special instructions appended to your member ID number.    You should provide 
such information only when so directed by a CompuServe Customer Service representative.

1 Choose Preferences from the Access menu.

2 Click Define Advanced.

3 Type the appropriate information in the Logon Parameters box.

4 Click OK.



Defining a Time-Out Value
If you frequently experience time-out problems, you can increase the HMI Timeout value, but large values
may also waste time and money.

1 Choose Preferences from the Access menu.

2 Click Define Advanced.

3 Type the appropriate information in the HMI Time-Out box.

4 Click OK.



Defining a Retries Value
Your retries value determines the number of times the connection process should be initiated should a 
dialing-related problem occur.

1 Choose Preferences from the Access menu.

2 Click Define Advanced.

3 Type the appropriate information in the Retries box.

4 Click OK.



Enabling Carrier Detect
The Enable Carrier Detect feature ensures that your connection software will attempt to detect when your 
modem loses carrier.    

Your modem must support this feature for it to work reliably.    

1 Choose Preferences from the Access menu.

2 Click Define Advanced.

3 Mark the Enable Carrier Detect checkbox.

4 Click OK.



Specifying an X.121 Calling Address
The Advanced preferences window enables you to type the X.121 calling address for your system if you 
are using an Eicon X.121 Address.

1 Choose Preferences from the Access menu.

2 Click Define Advanced.

3 Type the address in the X.121 box.

4 Click OK.



Choosing Your Chat Nickname
To specify a nickname that others see when you are in Chat conferences

1 Choose Change Nickname from the Chat menu.

2 In the Define Nickname window, type the nickname to be attached to your Chat comments.

3 Click OK.
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Using Shortcut Keys

You can use shortcut keys (or hotkeys) while using CompuServe 3 to navigate side buttons and top tabs 
via your keyboard.

At the Home Desktop, Forum Desktop, News Desktop, Chat Desktop, and Conference Center Desktop:

ALT + 1 is equivalent to clicking the top-most side button, ALT + 2 is equivalent to clicking the 
second top-most side button, and so forth.    

ALT + Shift + 1 is equivalent to clicking the first (left-most) page (top tab) associated with the top-
most side button, ALT + Shift + 2 is equivalent to clicking the second page, and so forth.



How to Use Help

In help, you click on green words and yellow folders (     
) to view other help topics.

Click on the following green words.    Watch what happens.

What is a popup window?

What is a procedure window?

(Use the scroll bar in this window to view more topics about help, or click the Back button to return to the 
previous help topic.)

Related help topics
How to use the scroll bar
How to find help topics
How to access the help system
How to size and move help windows
How to use     

How to use     
 

How to use the Help Topics Feature
How to use help system menus
How to leave the help system



What is a Popup Window
When you click on a green word (with a broken green underline), help appears in a small popup window 
like this.    (Click anywhere outside the popup window to dismiss it.)



What is a Procedure Window?

When you click on a green word (with a solid green underline), procedural help often appears in a window
like this.    

You can click the close box in the upper right-hand corner of the help window to dismiss it.    (In Windows 
95, the close box looks like .)

If you want to return to the original help window without dismissing this window, click the original window, 
making sure that you do not also click a green word in the process.



How to Use the Scroll Bar

If you see scroll bars in a help window, it means that all of the information in the particular help topic is not
currently visible.    (You can use the scroll bar to scroll through the topic to view all of its information.)

(Click the various parts of this sample scroll bar to learn how to use it.)

(Some scroll bars are horizontal.    The same principles apply.)    



You can click this arrow button to scroll forward one line at a time.



You can click this arrow button to scroll backward one line at a time.



You can click in this region (below the elevator box) to scroll forward one page at a time.



You can click in this region (above the elevator box) to scroll backward one page at a time.



You can position your arrow cursor on this elevator box, press the right mouse button, and then drag the 
elevator box up and down while continuing to hold down the right mouse button to display other parts of 
the topic. 



How to Redisplay this Topic

To redisplay the How to use help topic, simply choose How to use help from the Help menu.



How to Use     

If you choose Contents from the Help menu, a Contents page for the help system is displayed.

As you explore (click) the various categories, you will see yellow folders that look like:  and 
.

Click the following sample folder to see what happens.    (Then click it again.)

Sample topics



How to Use     

If you choose Contents from the Help menu, a Contents page for the help system is displayed.

As you explore (click) the various categories, you will see yellow folders that look like:  and 
.

Click the following sample folder to see what happens.    (Then click it again.)

Sample topics

What is a Mailbox?
Listing Your Mail Messages
Visiting Your Mailbox
Retrieving Mailbox Messages



These are only sample topics.    Now dismiss this popup window, and then click the (opened) yellow folder
to hide the sample topics.



How to Use     
    

If you are at the Help Topics window, you might see a page displayed with book-related icons.

The icons look like , 
, and 

.

You can double-click on 
 icons to view related topics.

You can double-click on 
 icons to hide related topics.

You can double-click on 
 icons to view those help topics.

(You can also single click on an icon, and then click the Open, Close, or Display button in the lower part of
the window, as appropriate.)



How to Use the Help Topics Feature

Whenever you click the Index button along the top of your help window, a Help Topics window is 
displayed.

Each top tab in the Help Topics window leads to a unique page:

Contents page displays a page with icons that look like 
, 
, and 

.

Index page enables you to find topics via keyword

Find page enables you to perform a full-text search of help system topics 



How to Access the Help System

You can access the help system a number of ways:

If you are at a window, you can press the F1 key (on your keyboard) for help with that window.

Some windows have a Help button that you can click for help with that window.

Some desktops (screens) have a Learn About side button that you can click.    (After clicking the 
Learn About side button, click the appropriate Learn About top tab, and then double-click a topic.)

The Help menu offers a number of commands that you can choose.    (See the Help Menu 
Commands topic below.)

Help Menu Commands

Each of the following Help menu commands accesses the help system:

Contents displays a Contents page for the entire help system.

Search for help on displays the Index for the help system.

What's New in 3 displays a help topic that summarizes some of the new features in CompuServe
3.

Upgrading to CompuServe 3 from CIM displays a help topic that you will find useful if you are 
upgrading to CompuServe 3 from CompuServe Information Manager software, such as WinCIM 2.01.

How to use Help displays this help topic (How to Use Help) so that you can learn how to use and
navigate the help system.



How to Find Help Topics

If you are in the help system you can:

Click the Contents button along the top of your help window to explore the help system via topic 
categories.

Click the Glossary button along the top of your help window for quick definitions about new 
terminology. 

Click the Index button along the top of your help window to search for help topics via keyword.

(If you are using Windows 3.1, this button will be called Search.)

If you are not in the help system you can:

Click the Learn About side button (when available) for desktop-sensitive help.

Press the F1 key on your keyboard while at a window for context-sensitive help about that 
window.

Choose Search for Help on from the Help menu to search for help topics via keyword.

Choose Contents from the Help menu to explore the help system via topic categories.



How to Use Help System Menus

Just above the button bar in your help windows are miscellaneous words (menus).

A menu is a collection of related actions (commands).    You click a menu name to view the menu.    You 
then click a command to initiate its function.    

Menus enable you to customize your help sessions.    For example, using the various help system menus 
you can assign bookmarks to and print help system topics, increase (or decrease) the type size in help 
system windows, and more.



How to Size and Move Help Windows

Help windows are designed to stay on top of your screen so that you do not accidently lose them.

To size a help window (make it smaller or larger), position your arrow cursor on any window 
border, press the right mouse button, and then drag the border (as appropriate) while continuing to hold 
down the right mouse button.    Release the right mouse button when you are satisfied with the new 
window size.
 

To move a help window, position your arrow cursor on the window title, press the right mouse 
button, and then drag the window (as appropriate) while continuing to hold down the right mouse button.   
Release the right mouse button when you are satisfied with the new window position.



How to Leave the Help System

To leave (close) the help system, simply click the close box in the upper right-hand corner of the help 
window.

The close box looks like .

However, you might want to keep the help system opened as you use CompuServe 3 for easy reference. 
(You will probably want to size and move your help windows for your viewing pleasure.)

To leave the help system without closing it, click anywhere outside the help window but inside the 
CompuServe window.



Using the Index

Individual commands, windows, and pages are not listed as key entries.

To find information about individual commands, look under: commands, list of

To find information about individual windows and pages, look under: windows and pages, list of

To find simple explanations (definitions) of terms and concepts, click the Glossary button along 
the top of this help window

To learn how to use the help system, click the Help button along the top of this help window



Other Countries
For countries not listed, please contact CompuServe USA:

Direct
+(1)(614) 529-1340

Fax
+(1)(614)529-1611



Argentina

CompuServe S.A. Argentina
Direct
+(54)(1) 345-3817

Fax
+(54)(1) 345-0825



Australia/New Zealand

CompuServe Pacific
Fujitsu Australia Ltd.
Australia Freephone
1-800-025-240

New Zealand Freephone
0-800-446-113

Direct
+(61)(2) 410-4260

Fax
+(61)(2) 410-4223



Austria

Austria
Freephone
0660-8750

Direct
++(49)1805 25 81 46

Fax
+(49)(89) 66-535-241



Chile

Chilepac S.A.
Direct
+(56) (2) 252-5171

Fax
+(56) (2) 252-5624



Colombia

Direct
(571) 312-1703

Fax
(571) 312-1857



France

CompuServe Information Service SARL
AZUR Phone
36 63 81 31

Direct
+(33)(1) 47 14 21 60

Fax
+(33)(1) 47 14 21 51



Germany

CompuServe GmbH
Freephone
01805-25 81 46

Direct
++(49) 1805 25 81 46

Fax
+(49)(89) 66 57 80 08



Hong Kong

CompuServe Hong Kong
Direct
+(852)(2) 833-1500

Fax
+(852)(2) 506-3445



Hungary

CompuServe Hungary
Middle Europe Networks, Kft.
Direct
+(36)(1) 175-6483

Fax
+(36)(1) 212-4612
+(36)(1) 212-0639



Israel

CompuServe Israel
Trendline Communications and Info. Svcs., Ltd.
Direct
+(972)(3) 638-8230

Fax
+(972)(3) 638-8288



Japan

NIFTY Corporation
Freephone
012-022-1200

Direct
+(81)(3) 54715806

Fax
+(81)(3) 5471-5890



Mexico

CompuServe Mexico
Direct
+(52)(5) 629-8191

Fax
+(52)(5) 629-8198



Netherlands

CompuServe Netherlands
Freephone
0800-022-5991

Direct
+(44) 990-000400

Fax
+(44)(117) 925-2210



Singapore

CompuServe Pacific
CNS Information(s) Pte. Ltd.
Freephone
800-6161-376

Direct
+(65)226-3928

Fax
+(65)226-3603



South Africa

CompuServe Africa
Direct
+(27)(12) 841-2530

Fax
+(27)(12) 241-3604



South Korea

Hanjin Info System & Telecom Co.
Freephone
080-090-1435

Direct
+(82)(2) 318-1435

Fax
+(82)(2)753-8666



Switzerland

Switzerland
Within Switzerland
0848-80 11 12

Outside Switzerland
++(41) 848-80 11 12

Fax
+(49)(89) 66-535-241



Taiwan

Taiwan Telecommunications
Freephone
080-251-177

Direct
+(886)(2) 788-1588

Fax
+(886)(2)782-2990



United Kingdom

CompuServe Information Service (UK) Ltd.
Freephone within U.K.
0990 000 400

Outside U.K.
+(44) (990) 000 400

Fax
+(44) (117) 925 2210



United States/Canada

Customer Service
Freephone
800-848-8990

Direct
+(1)(614) 529-1340

Fax
+(1)(614)529-1611



Venezuela

CompuServe C.A. Venezuela/Andean Net Services
Phone
+(58) (2) 793-2984

Fax
+(58) (2) 793-1952



Alphabetical Listing of Address Formats

Listed below are address formats for many interconnected Mail services:

Advantis 400
X400:(C=country;A=IBMX400;P=private-domain;S=surname;G=given-name)

America Online
INTERNET:address@AOL.COM

AppleLink
INTERNET:address@APPLELINK.APPLE.COM

AT&T EasyLink
X400:(C=country;A=WESTERN UNION;P=private-domain;S=surname;G=given-name;D=ELN:easylink-number)

AT&T Mail 400
X400:(C=country;A=ATTMAIL;P=private-domain;S=surname;G=given-name;D=ID:mail-id)

BT Messaging Service
X400:(C=country;A=BT;O=organization;S=surname;G=given-name)

Cable and Wireless (Mercury)
X400:(C=country;A=CWMAIL;P=private-domain;O=organization;S=surname;G=given-name)

CompuServe Interactive (CSi)
Use the CSi member ID number or personal address.

CompuServe Mail Hub Service
MHS:user-name@workgroup

or ...

CCMAIL:user-name AT post-office

Deutsche Bundespost
X400:(C=country;A=DBP;P=private-domain;O=organization;S=surname;G=given-name)

Fax
FAX: fax-number

Infonet
X400:(C=country;A=INFONET;P=private-domain;O=organization;S=surname;G=given-name)

Internet
INTERNET:address@domain

Lotus cc:Mail
CCMAIL:username AT post-office

Lotus Notes
NOTES:username@domain

MCI Mail
MCIMAIL:mci-id



or ...

X400:(C=country;A=MCI;P=private-domain;S=surname;G=given-name;D=ID:mail-id)

or ...

X400:(C=country;A=MCI;S=surname;D=EMS:ems-number;D=MBX1:mailbox)

NIFTY-Serve
NIFTY:mail-id

or ...

X400:(C=country;A=NIFTY;P=private-domain;S=mail-id)

Novell Netware MHS
MHS:username@post-office

Private CompuServe Mail
system-name:user-address

Prodigy
INTERNET:address@PRODIGY.COM

SprintMail
X400:(C=country;A=TELEMAIL;P=private-domain;O=organization;S=surname;G=given-name)

Telex and TWX
TLX:machine-number answerback

Uniplus arCom 400 (Swiss)
X400:(C=country;A=ARCOM;P=private-domain;O=organization;S=surname;G=given-name)

Uniplus 400NET (Dutch)
X400:(C=country;A=400NET;P=private-domain;O=organization;S=surname;G=given-name)

Unisource Business Network
X400:(C=country;A=400NET;P=private-domain;O=organization;S=surname;G=given-name)

U. S. Postal
>POSTAL\name\company\street-address\street-address\city\state\zip\country



answerback
Optional component of Telex and TWX address formats.    Do not specify an answerback 
unless you are sure that it is correct.



country
Standard X.400 code for the country where the mail service is located.



given name
First name of the recipient.



mail id
Recipient's unique mail service address.



organization
Organization through which the recipient receives messages.



private domain
Private domain of the recipient's organization (if there is one).



surname
Last name of the recipient.



system name
Three-letter code assigned to a private CompuServe mail system.



state
The state, province, or other government subdivision.



username
Recipient's username.



workgroup
Recipient's MHS workgroup, as registered with the CompuServe Mail Hub.



post office
Recipient's cc:Mail post office as registered with the CompuServe Mail Hub.



username
Recipient's username, which identifies a Lotus cc:Mail user.



post-office
Lotus cc:Mail post office, as registered with the CompuServe Mail Hub.



username
Recipient's username, which identifies a Lotus Notes user.



domain
Address registered by the user with Lotus Notes Enterprise Connect.



username
Recipient's username, which identifies a Novell NetWare MHS user.



post-office
Novell NetWare MHS post office, as registered with the CompuServe Mail Hub



administrative-domain
Unique mail service identifier, such as DBP for Deutsche Bundespost, MCI for MCI Mail, or TELEMAIL for
SprintMail.



fax-number
The country code, followed by the area code or city code, followed by the telephone number.



ems-number
The unique Remote Electronic Mail System identifying number.



mailbox
The unique mailbox identifier.





Contacting Customer Service

Please click the appropriate location.

Argentina 
Australia/New Zealand 
Austria 
Chile 
Colombia 
France 
Germany 
Hong Kong 
Hungary 
Israel 
Japan 
Mexico 
Netherlands
Singapore 
South Africa 
South Korea 
Switzerland 
Taiwan 
United Kingdom 
United States/Canada 
Venezuela 
Other Countries



Reinstalling CompuServe 3

1 Insert the CompuServe CD into your CD-ROM drive.

3 Double-click Setup.exe.

5 Select the Custom Install option to reinstall CompuServe 3:

If you have software on your computer that currently enables you to connect to the Internet, or if 
you will be connecting via LAN, select Use Existing Internet Connectivity.

If you do not have software on your computer that enables you to connect to the Internet and you 
will using a modem to connect to CSi, select Dial-Up Networking.

(You might need to uninstall your CompuServe 3 software if you attempt to reinstall and learn that you 
need more space on your hard drive.)



Uninstalling CompuServe 3

You might need to uninstall your CompuServe 3 software if you attempt to reinstall and learn that you 
need more space on your hard drive.

Here is one way you can uninstall your CompuServe 3 software:

1 If you are currently running CompuServe 3, please exit the program.    (Choose Exit from the File 
menu.)

3 At your Windows 95 desktop, choose Settings from the Start menu, and then choose Control Panel 
from the ensuing submenu.    (Click the Start button to access the Start menu.)

3 In the Control Panel window, open the Add/Remove Programs icon.

4 In the Add/Remove Programs window, click the Install/Uninstall top tab.

5 Click the appropriate entry for CompuServe 3 that you wish to uninstall, and then click the 
Add/Remove button.

6 Click OK.

(You can also use the Uninstall program that comes with your CompuServe 3 software to uninstall 
CompuServe 3.)



Confirming Your Dial-Up Networking Settings

If you are using Dial-Up Networking, please follow these steps to confirm that your Dial-Up Networking 
settings are set appropriately.

1 In your CompuServe 3 software, choose Preferences from the Access menu.

2 Confirm that Dial-Up Networking is specified in the Winsock box (under Connection Type).    If it is not,
click the down arrow, and then click Dial-Up Networking from the resulting list.

3 If CompuServe is your Internet Service Provider (ISP), click the Configure Phone button and proceed 
to Step 4.    If you use a different ISP, click the OK button and refer to your ISP’s documentation for 
further instructions.

4 In the CS3 Connection window, click the Server Type button.

5 In the Server Types window, do the following:

Confirm that CISPPP.PPP Connection using CompuServe networks is specified in the Type of 
Dial-Up Server box.    If it is not, click the down arrow, and then click CISPPP.PPP Connection using 
CompuServe networks from the ensuing menu.

Confirm that the TCP/IP checkbox is the only one checked in the Allowed Network Protocols box. 
(Click a checkbox to mark or unmark it.)

Click the TCP/IP Settings button when all settings are accurate.

6 In the TCP/IP Settings window, do the following:

Confirm that both the Server assigned IP address and Server assigned name server addresses 
options are selected.    (Click an option to select it.)

Confirm that both the Use IP header compression and Use default gateway on remote network 
checkboxes are marked.

Click OK when all settings are accurate.

7 Click OK in the Server Types window to return to the CS3 Connection window.

8 Click the Configure button.

9 In the ensuing window, do the following:

Confirm that the Port and Maximum Speed settings specified are appropriate for your modem.    If
they are incorrect, please provide the appropriate information.

Click the Connection top tab, click the Define Advanced button, and then confirm that the Use 
flow control checkbox is marked and the Hardware (RTS/CTS) option is selected.

Click OK when all settings are accurate.

10 Click OK in all subsequent windows, until you close the Preferences window.    This completes the 
procedure.





Confirming Your Default Winsock Settings

If you have existing Internet connectivity and are using a default winsock, please follow these steps to 
confirm that your default winsock settings are set appropriately.

Note:    This method works only if you are using Dial-Up Networking as your default network connection.

1 In your CompuServe 3 software, choose Preferences from the Access menu.

2 Confirm that Default Winsock is specified in the Winsock box (under Connection Type).    If it is not, 
click the down arrow, and then click Default Winsock from the ensuing menu.

3 At your Windows 95 desktop, open the My Computer icon.    (You can double-click on the My 
Computer icon to open it.)

4 In the My Computer window, open the Dial-Up Networking folder.    If there is no Dial-Up Networking 
folder, end this procedure and reinstall CompuServe 3 using Custom Install to select Dial-Up 
Networking.

5 If there is a Welcome to Dial-Up Networking panel in the Dial-Up Networking folder, click the Cancel 
button in the lower right-hand corner of that panel.

6 In the Dial-Up Networking window, click the CompuServe Connection icon once to select it.    If there 
is no CompuServe Connection icon, end this procedure and reinstall CompuServe 3 using Custom 
Install to select Dial-Up Networking.

7 Choose Properties from the File menu in the Dial-Up Networking window.

8 In the CS3 Connection window, click the Server Type button.

9 In the Server Types window, do the following:

Confirm that CISPPP.PPP Connection using CompuServe networks is specified in the Type of 
Dial-Up Server box.    If it is not, click the down arrow, and then click CISPPP.PPP Connection using 
CompuServe networks from the ensuing menu.

Confirm that the TCP/IP checkbox is marked and that all other checkboxes are not marked.    
(Click a checkbox to mark or unmark it.)

Click the TCP/IP Settings button when all settings are accurate.

10 In the TCP/IP Settings window, do the following:

Confirm that both the Server assigned IP address and Server assigned name server addresses 
options are selected.    (Click an option to select it.)

Confirm that both the Use IP header compression and Use default gateway on remote network 
checkboxes are marked.

Click OK when all settings are accurate.

11 Click OK in the Server Types window in order to return to the CS3 Connection window.

12 Click the Configure button.



13 In the ensuing window, do the following:

Confirm that the Port and Maximum Speed settings specified are appropriate for your modem.    If
they are incorrect, please provide the appropriate information.

Click the Connection top tab, click the Define Advanced button, and then confirm that the Use 
flow control checkbox is marked and the Hardware (RTS/CTS) option is selected.

Click OK when all settings are accurate.

14 Click OK in the CS3 Connection window, close the Dial-Up Networking window and then the My 
Computer window, and click OK in the Preferences window.    This completes the procedure.



Please Increase Your HMI Time-Out

If you see one of these error messages:
Host did not initiate protocol
Protocol timed out

Your connection was terminated because CSi took too much time to respond to your last transmission.

Please increase your HMI timeout to at least 120 seconds and then try to connect again.

To increase your HMI timeout:

1 From the Access menu, choose Preferences.

3 In the Preferences window, click the Define Advanced button.

5 In the Define Advanced Settings window, change the number in the HMI protocol time-out field to 120.
(If it is already set to 120 or higher, try increasing it by an increment of 30.)

7 Click the OK button to return to the Preferences window.

9 Click the OK button to activate your changes.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Reinstalling CompuServe 3 



Please Try Again

If you see one of these error messages:
Application requested abort
Application requested immediate abort
Unexpected protocol packet received
Protocol transport error
Packet overflow detected
Packet underflow detected
Failure packet detected

CompuServe 3 was unable to initialize its proprietary protocol.

Please try to connect again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Reinstalling CompuServe 3 



Please Close Applications

If you see this error message:
Out of memory

Your system is out of memory or system resources.

Please close all applications that you are running and try to connect again.      (You can press the Ctrl, Alt, 
and Delete keys on your keyboard simultaneously to bring up a list of running applications.)    Close all 
applications except CompuServe 3, Internet Explorer, and FCSERV32, which holds the Filing Cabinet 
files for CompuServe 3.    

If you continue to experience a problem, reboot (restart) your    computer.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 



Please Try Again

If you see one of these error messages:
Comm port failed
Could not set comm port

CompuServe 3 was unable to initialize its proprietary protocol because of problems with your computer.

Please try to connect again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Reinstalling CompuServe 3 



Please Try Again

If you see this error message:
Could not read script file

CompuServe 3 could not read the script files that it uses to establish a communications connection.

Please try to connect again.

If this fails, please reinstall your CompuServe 3 software using Custom Install to select Dial-Up 
Networking or Use Existing Internet Connectivity, as appropriate.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Reinstalling CompuServe 3 



Please Reinstall

If you see one of these error messages:
Invalid script file specified
Symbol not found
Script expression is invalid
Specified primary network is invalid
Missing account id or password
Invalid parameters specified

One or more of the CompuServe 3 connection script files has become corrupted.

If you haven’t modified any script files, you should reinstall your CompuServe 3 software using Custom 
Install to select Dial-Up Networking or Use Existing Internet Connectivity, as appropriate.

If you have modified any script files, you should review your modifications.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Reinstalling CompuServe 3 



Please Confirm Member ID and Password

If you see one of these error messages:
User ID needed
Password needed

CSi did not recognize your Member ID or Password.

Please confirm that the Member ID and Password specified in your Connection Preferences is accurate.   
Sometimes it helps to delete your Password and enter it again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Setting Connection Preferences



Please Confirm Communications Port

If you see this error message:
Invalid comm port specified

The communications port that you have specified in your CompuServe 3 software is not available, you are
using an invalid WSOCK32.DLL file, or the WSOCK32.DLL file is missing.

The following suggestions might help you resolve your problem:

Confirm that there is a file named WSOCK32.DLL in your WINDOWS\SYSTEM subdirectory.    If 
WSOCK32.DLL is not there, please reinstall CompuServe 3 using Custom Install to select Dial-Up 
Networking. 

If there is a WSOCK32.DLL file in the directory or subdirectories that contain your CompuServe 3 
software, please rename the file to WSOCK32.OLD.

Confirm that the port setting in your Connection Preferences is correct.    To check the port 
setting, choose Preferences from the Access menu and look in the Phone/Port Information box.

Confirm that your Dial-Up Networking settings are accurate.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Confirming Your Dial-Up Networking Settings 
Contacting Customer Service 
Setting Connection Preferences
Reinstalling CompuServe 3 



Please Try Again

If you see this error message:
Could not connect

CompuServe 3 was unable to establish a connection to the host computer.

Please try to connect again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Reinstalling CompuServe 3 



Please Reinstall

If you see this error message:
Specified .INI file is invalid

CompuServe 3 cannot find your user settings file.

Please reinstall your CompuServe 3 software using Custom Install to select Dial-Up Networking or Use 
Existing Internet Connectivity, as appropriate.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Reinstalling CompuServe 3 



Please Provide InfoPlex Information

If you see one of these error messages:
IPX Password needed
IPX Mailbox needed
IPX Mailbox password needed

One or more of your InfoPlex settings is incorrect or missing.

Please confirm that your InfoPlex settings are correct.

If the problem persists, please contact your CompuServe account representative.

Related Information
Confirming Your Dial-Up Networking Settings 
Contacting Customer Service 



Please Confirm Host Name

If you see this error message:
Winsock error:    host not found

If you are using a LAN, a proxy server, or any Internet Service Provider (ISP) other than CompuServe 
Interactive (CSi), please check the related documentation and/or contact the responsible administrator or 
representative.    

If you are using CSi as your ISP, the following suggestions might help you resolve your problem:

Make sure that you are connecting to gateway.compuserve.com.

Please also confirm that your Dial-Up Networking settings are accurate.

Test your dialer's ability to contact CSi by attempting to establish a connection without running 
CompuServe 3.

Change your host name by editing your CIS.INI file in your \CSERVE directory.    Look for the 
HostIPName entry in the [Connector (CIS Connection)] section..

If the problem persists, please contact CompuServe Customer Service.

Related Information
Confirming Your Dial-Up Networking Settings 
Testing Your Dialer 
Contacting Customer Service 



Testing Your Dialer

Follow these steps to ensure that your dialer is able to contact CSi apart from CompuServe 3.

1 If you are using Dial-Up Networking, choose Programs from the Start menu, then choose 
Accessories from the menu of programs, and the choose Dial-Up Networking from the menu of 
accessories..    If you are not using Dial-Up Networking, go to Step 5.

2 In the Welcome to Dial-Up Networking window, click the Cancel button.

3 In the Dial-Up Networking window, click the CS3 Connection icon (presuming you have not changed 
the name initially assigned to this connection by the CompuServe 3 software). 

4 From the File menu, choose Connect.    If the connection is unsuccessful, please check your Dial-Up 
Networking settings.    If the connection is successful, proceed to Step 5. 

5 Choose Programs from the Start menu, and then choose MS-DOS Prompt from the menu of 
programs.

6 At the ensuing DOS prompt, type PING GATEWAY.COMPUSERVE.COM and press the Enter key.    
(Be sure to include a period between GATEWAY and COMPUSERVE, and alsobetween 
COMPUSERVE and COM.)    If the connection is successful, you will see a series of four lines 
beginning with the words "Reply From."    If you see these, your dialer is working properly. If you see 
“Bad IP address GATEWAY.COMPUSERVE.COM.” then Dial-Up Networking is not properly 
configured for the Internet Domain Name Service (DNS).    Please proceed to Step 7.

7 Choose Run from the Start menu.

8 In the RUN window, type C:\WINDOWS\WINIPCFG and click the OK button.

9 In the IP Configuration window, click the More Info>> button.

10 In the ensuing window, check the decimal address in the DNS Servers field and change it if 
necessary.

Related Information
Confirming Your Dial-Up Networking Settings 
Contacting Customer Service 



Please Confirm Winsock

If you see this error message:
Winsock error:    WSOCK32.DLL not found

The WSOCK32.DLL file is either not present on your computer or is in the wrong directory.    It must be in 
your WINDOWS\SYSTEM subdirectory.

The following suggestions might help you resolve your problem:

Confirm that there is a file named WSOCK32.DLL in your WINDOWS\SYSTEM subdirectory.    If 
WSOCK32.DLL is not there, please reinstall CompuServe 3 using Custom Install to select Dial-Up 
Networking. 

If there is a WSOCK32.DLL file in the directory or subdirectories that contain your CompuServe 3 
software, please rename the file to WSOCK32.OLD.    (Please do not delete the file.)

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Reinstalling CompuServe 3 



Please Confirm Winsock

If you see this error message:
Winsock error:    Bad address

The WSOCK32.DLL file is either not present on your computer or is in an incorrect directory or path.

The following suggestions might help you resolve your problem:

Confirm that the port setting in your Connection Preferences is correct.    To check the port 
setting, choose Preferences from the Access menu and look in the Phone/Port Information box.

Confirm that there is a file named WSOCK32.DLL in your WINDOWS\SYSTEM subdirectory.    If 
WSOCK32.DLL is not there, please reinstall CompuServe 3 using Custom Install to select Dial-Up 
Networking. 

Examine your CSERVE directory or path.    If you have a WSOCK32.DLL file in your CSERVE 
directory or path, please rename it to WSOCK32.OLD. (Please do not delete the file.)

Please also confirm that your Dial-Up Networking settings are accurate.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Confirming Your Dial-Up Networking Settings 
Contacting Customer Service 
Reinstalling CompuServe 3 



Please Restart Your Computer

If you see one of these error messages:
Winsock error:    Socket operation on non-socket
Winsock error:    Socket type not supported
Winsock error:    Net dropped connection or reset
Winsock error:    Host is down
Winsock error:    Host not found or server failure
Winsock error:    Non-recoverable error
Generic Winsock Error

Please restart your computer and then try to connect again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Confirming Your Dial-Up Networking Settings 
Contacting Customer Service 
Reinstalling CompuServe 3 



Please Try Again

If you see this error message:
Winsock error:    Socket is not connected

Your connection was lost during an upload or download.

Please try to connect again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 



Please Try Again

If you see this error message:
Winsock error:    Connection timed out

The connection timed out while CompuServe 3 was attempting to upload or download.

Please try to connect again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 



Please Try Again

If you see one of these error messages:
Winsock error:    No route to host
Winsock error:    Network can’t be reached at this time

CompuServe 3 was unable to access the requested destination from your Internet address.

Please try to connect again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 



Please Try Again

If you see this error message:
Winsock error:    The network subsystem has failed

The requested destination is currently invisible to your computer.

Please try to connect again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 



Please Try Again

If you see this error message:
Winsock error:    Network subsystem is unavailable

Your current Winsock configuration is invalid.

The following suggestions might help you resolve your problem:

Confirm that there is a file named WSOCK32.DLL in your WINDOWS\SYSTEM subdirectory.    If 
WSOCK32.DLL is not there, please reinstall CompuServe 3 using Custom Install to select Dial-Up 
Networking. 

Confirm that the WSOCK32.DLL file in your WINDOWS\SYSTEM subdirectory is the correct 
WSOCK32.DLL file.

Confirm that there are no other files named WSOCK32.DLL on your computer.    If you find 
another WSOCK32.DLL file, please rename it to WSOCK32.OLD. (Please do not delete the file.)

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Reinstalling CompuServe 3 



Please Try Again

If you see this error message:
Winsock error:    Connection aborted due to timeout or other failuer

Winsock aborted a data transfer operation.

Please try to connect again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 



Please Try Again

If you see this error message:
Winsock error:    Connection reset by remote host

Your connection has been terminated by the remote host computer.

Please try to connect again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 



Please Try Again

If you see this error message:
Winsock error:    Attempt to connect was forcefully rejected

The remote host computer has refused to allow you to connect.

Please try to connect again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 



Please Confirm Phone Number

If you see this error message:
Dial-Up Networking failed:    a voice-only number was dialed

A voice-only number was dialed by your modem.

Please confirm that the phone number specified in your Connection Preferences is accurate, and then try 
again.

Another good way to check the phone number is to dial it manually and listen to confirm that you hear 
modem tones.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Setting Connection Preferences
Reinstalling CompuServe 3 



Please Confirm Phone Number

If you see this error message:
Dial-Up Networking failed:    no answer

There was no answer at the phone number that your modem dialed.

Please confirm that the phone number specified in your Connection Preferences is accurate, and then try 
again.

Another good way to check the phone number is to dial it manually and listen to confirm that you hear 
modem tones.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Setting Connection Preferences



Please Confirm Phone Number

If you see this error message:
Dial-Up Networking failed:    data carrier not established

Dial-Up Networking was unable to establish a connection to the modem at the phone number you dialed.

Please confirm that the phone number specified in your Connection Preferences is accurate, especially 
the prefix (for example, make sure that “9,” appears at begiining of the phone number if you need to dial 
out to reach an outside line), and then try again.

Also, please confirm that the modem at the number that you are dialing supports the same baud rate and 
standards as your modem.

Another good way to check the phone number is to dial it manually and listen to confirm that you hear 
modem tones.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Setting Connection Preferences



Please Confirm Line Connection

If you see one of these error messages:
No dial tone
Dial-Up Networking failed:    no dial tone

There is no dial tone.

Please check the connection between the phone line and the modem.

If you’re using voicemail, please remove any messages.

If you’re trying to connect from Europe or from a hotel, or you have voicemail, please change your 
Windows 95 settings to disable dial tone recognition:

1 Choose Settings from the Start menu, and then choose Control Panel from the settings menu.

2 In the Control Panel window, click the icon next to Modems.

3 Choose Open from the File menu.

4 In the Modems Properties window, click the Properties button.

5 In the window that shows the selected modem’s properties, click the Connection top tab.

6 Make sure the Wait for dial tone before dialing check box is not checked.    If it is checked, click on it.

7 Click the OK button as many times as necessary to close all windows.

If you’re using Dial-Up Networking, try adding X3 to your CompuServe 3 modem settings:

1 From the Access menu, choose Preferences.

3 In the Connection tab, click the Configure Dial-Up Networking button.

5 In the General tab, click the Configure button.

7 In the modem properties window, click the Connection tab.

9 Click the Advanced button.

11 In the Advanced Connection Settings window, type X3 into the Extra settings box. 

13 Click the OK button as many times as necessary to close all windows.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Confirming Your Dial-Up Networking Settings
Contacting Customer Service 



Please Check Your Modem

If you see this error message:
Dial-Up Networking failed:    modem not responding

Your modem is not turned on or is disconnected, or your modem definition has been corrupted..

Please check the connections between your computer and modem and ensure that the modem is turned 
on.

Please also confirm that the correct modem is selected in your Dial-Up Networking settings.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Confirming Your Dial-Up Networking Settings 
Contacting Customer Service 



Please Try Again

If you see this error message:
could not initialize commport

CompuServe 3 could not initialize your communications port because the port name was invalid.

Please confirm your communications port in your Connection Preferences, and then try again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Setting Connection Preferences



Please Try Again

If you see this error message:
could not connect through Internet

Please try again at a later time.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Setting Connection Preferences
Reinstalling CompuServe 3 



Please Confirm Direct Dial Access

If you see this error message:
Direct dial access not allowed on account

Neither toll-free (800) direct dial access nor modem connections are authorized for the account that you 
specified.

Please ensure that you are not attempting to establish a direct connection.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Setting Connection Preferences
Reinstalling CompuServe 3 



Please Confirm Modem Operation

If you see this error message:
Modem not responding

Your modem is not responding to reset or initialization strings, or not dialing the phone number.

Please confirm your modem initialization strings as defined in your CompuServe 3 modem settings, and 
then try again.

If your modem initialization strings are correct, and the modem still won’t initialize, please test it:

1 Choose Settings from the Start menu, and then choose Control Panel from the settings menu.

2 In the Control Panel window, click the icon next to Modems.

3 Choose Open from the File menu.

4 In the Modems Properties window, click the Diagnostics top tab.

5 Select the modem specified in your CompuServe 3 modem settings.

6 Click the More Info button.    This tests the modem configuration.    If the test is successful, proceed to 
Step 12.    

7 If you receive an error message notifying you that the modem failed to respond, remove the modem 
from the Modems Properties list.    To do so, click the OK buttons in the Error window and also in the 
ensuing More Info window, then click the General top tab in Modems Properties window, then click 
the modem you tested and click the Remove button and then the Close button.

8 Shut down your computer and restart it.

9 Check to see if the modem was automatically added during startup. Choose Settings from the Start 
menu and Control Panel from the settings menu, then click the icon next to Modems in the Control 
Panel window.    If the modem is listed in the Modems Properties window, proceed to Step 11.

10 If the modem is not listed in the Modems Properties window, add it.    Click the Add button then click 
the Next button in the Install New Modems window, and then .    When the modem has been added, 
click the OK button.

11 Repeat the diagnostics test (Steps 3 through 5).    If the test is still unsuccessful, contact your modem 
vendor.

12 If the diagnostics test is successful, try to connect.    

If you see the same error message, please try one more test with HyperTerminal (if it is installed on your 
computer):

1 Choose Programs from the Start menu, then choose Accessories from the menu of programs, and 
then choose HyperTerminal from the menu of accessories.

2 In the HypertTerminal window, click the icon next to Hypertrm.exe.



3 Choose Open from the File menu.

4 In the Connection Description window, type a random name, such as TEST, in the Name field, and 
then press the Enter key.    (Do not use the name of an existing connection.)

5 Click OK.

6 In the Phone Number window, type the phone number that CompuServe 3 uses to connect.

7 In the Connect using field, select the modem or port that you are testing.

8 Click OK.

9 If HyperTerminal is unable to complete the connection, please contact your modem vendor.    If 
HyperTerminal successfully connects, please try to connect again with CompuServe 3.    If you receive
the same error message, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Defining Your Modem Settings
Setting Connection Preferences



Please Confirm Modem ID and Password

If you see this error message:
invalid modem security ID/password

Your modem security ID or modem password is missing or invalid. 

Please confirm this information in the Modem Security window, and then try again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Setting Connection Preferences
Specifying Modem Security



Please Confirm Modem Initialization

If you see this error message:
Modem not initializing

CompuServe 3 could not initialize your modem.

Please confirm your modem initialization strings as defined in your CompuServe 3 modem settings, and 
then try again.

If your modem initialization strings are correct, and the modem still won’t initialize

1 Choose Settings from the Start menu, and then choose Control Panel from the settings menu.

2 In the Control Panel window, click the icon next to Modems.

3 Choose Open from the File menu.

4 In the Modems Properties window, click the Diagnostics top tab.

5 Select the modem specified in your CompuServe 3 modem settings.

6 Click the More Info button.    This tests the modem configuration.    If the test is successful, proceed to 
Step 12.    

7 If you receive an error message notifying you that the modem failed to respond, remove the modem 
from the Modems Properties list.    To do so, click the OK buttons in the Error window and also in the 
ensuing More Info window, then click the General top tab in Modems Properties window, then click 
the modem you tested and click the Remove button and then the Close button.

8 Shut down your computer and restart it.

9 Check to see if the modem was automatically added during startup. Choose Settings from the Start 
menu and Control Panel from the settings menu, then click the icon next to Modems in the Control 
Panel window.    If the modem is listed in the Modems Properties window, proceed to Step 11.

10 If the modem is not listed in the Modems Properties window, add it.    Click the Add button then click 
the Next button in the Install New Modems window, and then .    When the modem has been added, 
click the OK button.

11 Repeat the diagnostics test (Steps 3 through 5).    If the test is still unsuccessful, contact your modem 
vendor.

12 If the diagnostics test is successful, try to connect.    If you see the same error message, please 
contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Defining Your Modem Settings
Setting Connection Preferences



Please Try Again

If you see this error message:
Too many retries

CompuServe 3 has been unable to establish a connection, despite repeated retries.

Please try again later.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 



Please Confirm Phone Number

If you see this error message:
Number is busy

The phone number that your modem is dialing is busy, or your modem is dialing the wrong phone number.

Please confirm the access phone number in your Connection Preferences, and then try again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Setting Connection Preferences



Please Try Again

If you see this error message:
missing X.121 address

Please fill in your X.121 address and try again.

To fill in your X.121 address

1 Choose Preferences from the Access menu.

3 Click the Define Advanced button.

5 Type your X.121 address into the X.121 Address field.    If you don’t know the address, ask your 
system administrator.

7 Click the OK button.

If the problem persists, please contact your account representative or CompuServe Customer Service.

Related Information
Contacting Customer Service 
Reinstalling CompuServe 3 



Please Try Again

If you see one of these error messages:
system is unavailable
remote busy or unavailable

The CSi host computer system is busy or not available.

Please try again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 



Please Confirm Member ID and Password

If you see one of these error messages:
invalid user ID or password
Incorrect User ID or password

The Member ID or Password specified in your CompuServe 3 software is incorrect or missing.

Please confirm your Member ID and Password in your Connection Preferences.    Sometimes it helps to 
delete your Password and enter it again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Setting Connection Preferences



Please Try Again

If you see this error message:
simultaneous users exceeded (Infoplex)

There are too many users trying to access the system at the same time.

Please try again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 



Please Confirm Logon Parameters

If you see one of these error messages:
invalid user ID syntax
system unavailable, check user ID

One or more logon parameters could be incorrectly formatted.

1. Confirm that the Member ID that CompuServe 3 is using is correct.    To check your Member ID, 
choose Preferences from the Access menu and look in the Connection Settings box. 

1. Confirm that no logon parameters are specified.    To check your logon parameters, click the Define 
Advanced button.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Confirming Your Dial-Up Networking Settings 
Contacting Customer Service 
Setting Advanced Preferences



Please Try Again

If you see one of these error messages:
CAP not supported
Invalid ESC-I sequence supplied
modem connection lost/dropped
host not responding to login request
secure response from host was invalid
PPP connection failure
generic CIS connection failure

Please try to connect again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 
Reinstalling CompuServe 3 



Please Try Again

If you see this error message:
secure login failure, non-secure connect

Please try to connect again.

If the problem persists, please contact CompuServe Customer Service.

Related Information

Contacting Customer Service 



Please Try Again

Please try to connect again.

If the problem persists, please contact CompuServe Customer Service.

Related Information
Contacting Customer Service 



Learn About CompuServe Special Exceptions



CSi is News

Whether you want a global perspective on the news or the latest local weather, CSibrings you the news 
the way you want it.    You can get current updates directly from respected news and weather sources – 
often before they are available in the media.    And you can take advantage of a convenient clipping 
service to collect stories of special interest to you.

Would you like to go there now?
Click the following topic, and then close this help window.

Take me to the News area!



CSi is Chat

When you're ready for social interaction and lively conversation in real time, CompuServe Chat is the 
place to be!    Here, you can meet old friends and make new ones, chat with a whole room full of people,    
participate in private conversations, or just observe the festivities – right from the comfort of your home.

Would you like to go there now?
Click the following topic, and then close this help window.

Take me to the Chat area! 



CSi is Forums and Communities

If you are looking for information, support, or just a place to express yourself on almost any subject, check
into the Forum areas on CSi.    These online special interest groups enable members to exchange 
information about their shared enthusiasms.    Forum members can exchange messages on the message 
boards, retrieve (download) and contribute (upload) files in the libraries, and meet in the electronic 
conference rooms to chat or listen to an invited speaker.

Would you like to go there now?
Click one of the following topics, and then close this help window.

Take me to a list of Forum areas! 
Take me to the Practice Forum! 



CSi is Mail

CSi Mail is your key to fast, reliable communication with members worldwide.    And the Mail Center 
enables you to manage your correspondence with ease and efficiency.    You can compose messages 
while connected or disconnected – and send them immediately or hold them in your Outgoing Messages 
folder to be sent later.    Addressing Outgoing Mail is streamlined by one-click access to your Address 
Book – and you can easily define addresses for members of CSi and many different Mail services.

To access the Mail Center, click the Mail Center side button on the Home Desktop.



Learn About Mail Page Topics



Read New Messages

To list your new Mail messages, click the Mail Center side button, click the Read top tab, and then click 
the Get Mail button.

Your Mail Preferences determine whether your new Mail will be retrieved from your online mailbox to your
computer (the default), or whether you will instead go to your online mailbox to process messages there.

(To review your current Mail preferences, choose Preferences from the Access menu, and then click the 
Mail top tab.)

Want to learn more?
Opening an Incoming Message
Retrieving Mailbox Messages 
Setting Mail Preferences



Send a Message

To send a message that you are currently composing, when you complete the message, simply click the 
Send button in the Create Mail window.

If you click Send Later, the message will be placed in both the Outgoing Messages list and the To-Do List,
but not sent.

To send a message stored in your Outgoing Messages list, click the Mail Center side button, click the 
Create top tab, click the listed message, and then click the Send button.

Want to learn more?
Addressing a Mail Message 
Attaching a File to a Mail Message
Reviewing or Editing Outgoing Messages 



Learn Mail Options

Mail Options enable you to assign various sending options to a Mail message, such as whether to assign 
an urgency status to the message, whether to specify a particular release or expiration date, whether to 
request a notification when the recipient actually opens the message, and whether the message text 
should be reformatted when sent.

You can assign sending options while you are creating, reviewing, or modifying a message by clicking the
Options button in the Create Mail window.

Want to learn more?
Assigning Urgency Status
Requesting a Return Receipt
Specifying a Release Date
Specifying an Expiration Date
Controlling Text Formatting in a Message



Attach a File

You can send one or more files with a CSi Mail message by attaching each file to the message before 
sending it.    The original message and any attached files are sent together, but as individual messages.

If you have already created the accompanying Mail message and the message is opened, or if 
you are currently creating the Mail message, simply click the Attach File button in the Create Mail window 
to select a file.

If you have not yet created the accompanying Mail message, choose Send File from the Mail 
menu.

Want to learn more?
Attaching a File to a Mail Message 
Sending a Mail Message 



Retrieve Only Some Messages

Because your mailbox resides on CSi (online), you can read and process your incoming Mail two ways:

You can retrieve your entire mailbox contents (all messages) to your computer, then process 
them on your computer (online or offline) at your leisure (the default).

You can visit your online mailbox to selectively process and retrieve (download) individual 
messages.    Use this method to retrieve only some messages from your mailbox.

Consult your Mail Preferences to set up your preferred processing method. 

(To review your current Mail preferences, choose Preferences from the Access menu, and then click the 
Mail top tab.)
 
Want to learn more?
Setting Mail Preferences
Visiting Your Mailbox
What is a Mailbox?



Reply to a Message

Before replying to a message, you must open (read) it. 

To compose your reply, click the Reply button in the Read Mail window.

If you want text from the original message to appear in your reply, simply select it via your right mouse 
button before clicking the Reply button.

Want to learn more?
Replying to a Message
Forwarding an Incoming Message
Creating a Mail Message
Including Yourself when Replying to All



Make an Address Book Entry

You can make an Address Book entry in two ways:

If you are currently at your Address Book, simply click the Add Entry button.    

If you are reading a Mail message and want to add the message author or a member of the 
message recipient list, click the Add Address button in the Read Mail window.

Want to learn more?
Making an Individual Address Entry 
Making a Mailing List Entry



Review Mail Preferences

Mail preferences enable you to personalize your CSi Mail sessions.    For example, you can request 
whether to file sent messages, whether to view mail directly from your online mailbox, and whether to 
delete Mail from your online mailbox once it has been retrieved.

To review your current Mail preferences, choose Preferences from the Access menu, and then click the 
Mail top tab.

Click to view step-by-step instructions for
Auto-Deleting Retrieved Mail from Mailbox
Viewing Mailbox Before Retrieving Mail
Requesting a Save Message Prompt
Including Yourself when Replying to All



Address a Message

There are two ways to address a Mail message:

You can type the recipient name and address in the Name and Address boxes in the Create Mail 
window.    (Use this method if you are sending the Mail message to one person.)

You can click the Recipients button in the Create Mail window and create a Recipient List.    (If a 
recipient is in your Address Book, the name and address information will be filled in automatically as you 
type the recipient's name.)    

Want to learn more?
Making an Address Book Entry 
Making an Individual Address Entry 
Making a Mailing List Entry



Get a Personal Address for CSi Mail
A Personal Address is a CSi Mail address that you can use instead of your member ID number.    A good 
Personal Address, such as some variation of your name, should be easy for people to remember when 
they want to send you messages.    There is no extra charge for using a Personal Address.

To obtain a Personal Address, access the REGISTER service on CSi.    REGISTER gives you some 
suggestions for a Personal Address based on your name.    You can select one of the suggestions or 
specify a different Personal Address, provided that it conforms with the following rules:

It must have from two to 32 characters.

It can include letters, numbers, and underscore characters (_), but can not include spaces or any 
other special characters.    

At least one character must be a letter.

No character can be repeated more than four times in succession.
 
Once you confirm your Personal Address, it becomes the “signature” for all your CSi Mail messages.    
Your correspondents can send messages to either your Personal Address or your CSi member ID 
number.    

Note:    Your complete address for Internet e-mail must still include @compuserve.com.    So, for instance, 
if your Personal Address is MaxNix, your complete e-mail address would be MaxNix@compuserve.com.

Once you have a Personal Address, you cannot change it.    However, you can elect to “sign” your CSi 
Mail messages with your user ID number instead of your Personal Address.

If you forget your Personal Address, you can find it by accessing REGISTER again.

Want to learn more?
Obtaining a Personal Address
Sending Mail to a Personal Address
Finding a Forgotten Personal Address
Changing Your CSi Mail Signature



Search for a Message

To set up a search for a specific Mail message, click the Mail Center side button, and then click the 
Search top tab.

You can search for Mail messages in your mailbox (online messages), as well as Mail messages that you 
have already retrieved (filed messages) to your computer.

Want to learn more?
Opening an Incoming Message 
Searching for Items in the Filing Cabinet
Viewing Mailbox Before Retrieving Mail



Create a Message

You do not have to be connected to CSi to create a Mail message.

To create a Mail message, click the Mail Center side button, click the Create top tab, and then click the 
New button.

Want to learn more?
Creating a Mail Message
Sending a Mail Message
Attaching a File to a Mail Message 



Learn About Getting Around Page Topics



Save Items in the Filing Cabinet

If you want to store a Mail message, Forum message, news article, or other type of text article to review 
or use later, you can save it to your Filing Cabinet.    Simply click the File It button in the message or 
article window, and then select or create the folder where you want to store it.

To access the Filing Cabinet, click the My Information side button, and then click the Filing Cabinet top 
tab.

Want to learn more?
Marking a File for Later Retrieval
Filing an Incoming Message 
Saving a News Article 
Searching for Items in the Filing Cabinet



Find Access Phone Numbers

If you travel frequently and connect to CSi from different locations, you will need to learn the best access 
phone number for your particular location.    Access phone numbers can also change unexpectedly.

To find access phone numbers, click the Main Menu side button, click the Assistance top tab, and then 
click the Access Phones button.

Want to learn more?
Finding CSi Members
Changing Your Access Phone Number



Cancel an Activity

There might be times when you want to cancel an activity or task in progress.    For example, while 
searching for a file, you might cancel the search to redefine the search terms.

In progress indicator windows, you can click the Cancel button (in the window) to cancel the task 
that is currently in progress.

If the CompuServe window shows a Stop button (near the Toolbar), you can click the Stop button 
to cancel a task currently in progress there.

If you want to disconnect from CSi for any reason while in the midst of a process (activity), you 
can click on the globe displayed in the lower left-hand corner of the CompuServe window.

Want to learn more?
Accessing the CompuServe Directory 
Finding CSi Services
Retrieving a File from a Forum Area 



Confirm Online Status

You can confirm your online status by looking at the lower left-hand corner of your CompuServe window.

If you are connected to CSi, the connection counter beside the globe shown there will be displaying an 
increasing count of your connect time.

If the up and down arrows beside the globe are blinking, it means that information is being transmitted 
between your computer and CSi.

You can also look at the Connect or Disconnect button (showing the hands) on the CompuServe Toolbar.  
If the two hands are clasped (a handshake), you are connected to CSi.    If the two hands are not clasped 
(no handshake), you are not connected to CSi.

Want to learn more?
Accessing a Service 
Changing Your Password 
Finding CSi Services
Inserting a Toolbar Button



Explore Chat

CompuServe Chat enables you to chat (converse via your computer) with people around the world!

To explore the CompuServe Chat area, click the Main Menu side button, click the Main Menu top tab, and
then click the Chat button.

Want to learn more?
Finding CSi Services
Participating in a Public Chat
What is Chat?



Contact Customer Service

To contact CompuServe Customer Service, click the Main Menu side button, click the Assistance top tab, 
and then click the Member Services button.

You can review your membership account information at the Assistance page, too.    (Click the Account 
Information button.)

You can also contact the nearest CompuServe Customer Service office for assistance at any time.

List of CompuServe Offices
Argentina 
Australia/New Zealand 
Austria 
Chile 
Colombia
France 
Germany 
Hong Kong 
Hungary 
Israel 
Japan 
Mexico 
Netherlands
Singapore
South Africa 
South Korea 
Switzerland 
Taiwan 
United Kingdom 
United States/Canada 
Venezuela 
Other Countries

Want to learn more?
Accessing the CompuServe Directory 
Finding CSi Services



Use the To-Do List

Throughout your CompuServe 3 session you can create an ongoing To-Do List of tasks you want to 
perform, such as retrieving Forum Message Topics or sending Mail messages.    You can then process the
tasks on your To-Do List all at once (or individually) whenever you like.

You add tasks to your To-Do List by clicking buttons such as Retrieve Later (rather than Retrieve), Send 
Later (rather than Send), and so forth, as appropriate.

To view your To-Do List, click the My Information side button, and then click the To-Do List top tab.

Want to learn more?
Accessing the CompuServe Directory 
Finding CSi Services



Find Services

To set up a search to find CSi services, click the Find side button, and then click the Services top tab.

You can also find CSi services by consulting the CompuServe Directory, an electronic guide to hundreds 
of Forum areas and other services.    (Choose CompuServe Directory from the Access menu.)

Want to learn more?
Finding CSi Services
Finding Internet Services 
Searching for a News Article



Explore CSi

There are many ways to explore CSi's vast collection of services and Forum areas.

The easiest way is to click the Main Menu side button, click the Main Menu top tab, and then click any of 
the round buttons there.    For example, Table of Contents lets you explore CSi services that are grouped 
according to popular category, and What's New lets you explore the latest CSi events and upcoming 
promotions.

You can also choose CompuServe Directory from the Access menu to view descriptions of CSi services.

Want to learn more?
Finding CSi Services
Finding Internet Services 
Searching for a News Article



Explore Forum Communities

Here are some ways to explore and find Forum communities:

Click the Main Menu side button, click the Main Menu top tab, and then click the Forums and 
Communities button.

Choose CompuServe Directory from the Access menu and browse the numerous descriptions 
of the Forum areas on CSi.

Choose Go from the Access menu and enter FORUMS for an up-to-date list.

Click the Find side button, click the Services top tab, and then search on the word FORUM.

Want to learn more?
Internet-Related Forum Areas
Finding CSi Services
Finding Forum Areas 



Find Files

Here are some ways that you can find files on CSi:

Click the Find side button, and then click the Files top tab to set up a search for files anywhere on
CSi using its File Finder.

If you are in a Forum area, click the File Libraries side tab, and then click the Search top tab to 
set up a search for files in that Forum area.

Join a Forum area where you think people might know about the file you are interested in, and 
post a message requesting help finding it.    (You could also participate in a Forum Conference and ask 
someone for assistance.)

Want to learn more?
Searching for a File
Posting a Message



Find a Member

The easiest way to find a CSi member is to set up a member search.    To set up your search, click the 
Find side button, and then click the Members top tab.

If the member frequents a particular Forum area, you can go there and post a private message (to the 
member) on one of the Message Boards.    The member will see the message and respond to you!

Want to learn more?
Adding Member Information to Your Address Book 
Learning About CSi Members 
Posting a Message



Go to a Service or Web Page

Here are some ways to go to a service on CSi or a Web page on the Internet:

You can use the Go feature to go directly to the service or Web page.    Click the Go side button, 
and then click the Go top tab to specify your destination.    (You can also reference recently visited 
services or Web pages from the Go page.)

If you have recently used CompuServe 3 to visit the service or Web page, you can use the Page 
feature to the left of the CompuServe Toolbar to return to that service or Web page.    (Click on a service 
or Web page listed there to return to it.)

If the service or Web page you want to go to is listed in your Favorite Places, you can go directly 
to that service or Web page from the Favorite Places page.    Click the Go side button, and then click the 
Favorite Places top tab to select a service or Web page listed there.

Want to learn more?
Finding CSi Services
Finding Newsgroups 
Finding Web Sites 



 Learn About Internet



Make a Web Page

You can use CompuServe's Home Page Wizard, as well as your own Web page software, to design a 
personal Web page.

You can design your Web page to include pictures, sound files, links to other Web pages, and more.

You can then use the Publishing Wizard to copy your Web page to the Internet, where it can be viewed by
millions. 

Want to learn more?
Overview of the Internet 
Making a Personal Home Page on the Web
What is HTML?



Send Mail via Internet

CSi Mail offers a convenient, easy, and economical way to communicate via the Internet.    

You send Mail to an Internet user just as you would to a CSi member.    Type the complete Internet 
address in the Address box of the Create Mail window.    (People sending to you must also type special 
address information.)

The easiest way to find a person's Internet address is to ask them.    You can also have them send you a 
message, and then add their address to your Address Book.

Want to learn more?
Addressing a Mail Message 
Receiving from the Internet
Sending to the Internet



Subscribe to a USENET Newsgroup

A USENET Newsgroup is the Internet equivalent of a discussion group.

First a message is posted to the newsgroup, and people respond to it with messages of their own.    Then 
messages responding to the responses are posted, and so on.

You can subscribe to a USENET Newsgroup from CSi.    (There is no additional cost involved when 
subscribing to a USENET Newsgroup.)

Want to learn more?
What is a Usenet Newsgroup? 
Finding Newsgroups
Subscribing to Newsgroups



Connect Via Remote Logon

You can connect to CSi through the Internet.

For some people, this feature may save the cost of a long-distance call.    For others, this feature may 
provide easy access from work or school.    

Want to learn more?
How to telnet to CSi
What Can You Do with Telnet? 
Selecting a Site



Use Parental Controls

You can use Parental Controls to limit your child's access to the Internet and CSi.    

To go to the Parental Controls area, click the Go side button, click the Parental Controls top tab, and then 
click the Parental Controls button.

Want to learn more?
Finding CSi Services
Learning About Internet Services



Go to the Internet

Here are just a few of the many ways you can go to the Internet:

Click the Main Menu side button, click the Main Menu top tab, and then click the Internet button.

Click the Go side button, and then click the Go top tab to go directly to a Web page that you have 
visited recently.    (You can also specify a new Web page.)

Choose Internet from the Services menu to start the Internet Web Browser and access the 
CompuServe Interactive Web page.

If a choice on a menu or list of services accesses the Internet and you click it, you will go to the 
Internet.

Want to learn more?
What is a USENET Newsgroup?
What Can You Do with Telnet?
What Can You Do with FTP?



Use the Internet Web Browser

The Internet Web Browser is started automatically whenever you go to a Web page on the Internet.

You can choose Internet from the Services menu to go directly to the CompuServe Interactive Web page.

If you are running Windows 95 and you go to a Web page, the Web page will be displayed within the 
CompuServe 3 window.    However, if you are not running Windows 95 and you go to a Web page, the 
Web page will not be displayed within the CompuServe 3 window, but will be displayed in a second 
window (apart from your CompuServe 3 window.)

Want to learn more?
Internet-Related Forum Areas
Finding Web Sites 
What is the World Wide Web? 



Define a Default Web Browser

If you have a particular Web browser that you prefer to use, you can define it to be the default.

Choose Preferences from the Access menu, click the General top tab, mark the Use external Internet 
browser checkbox, and then click the Select button to open (identify) the preferred browser.

Want to learn more?
Internet-Related Forum Areas
Finding Web Sites 
Using an Internet Browser



Find a Web Page

Finding an Internet Web page is easy.    Click the Find side button, click the Services top tab, and then 
click the Start Internet Search button to set up your search.

You can also click the Main Menu side button, and then click the Internet button to view Web pages 
posted by CSi members.

You can also consult the many Internet-related Forum areas on CSi to learn about the Internet and Web 
sites to visit.

Want to learn more?
Internet-Related Forum Areas
Finding Web Sites 
Making a Personal Home Page on the Web
Overview of the Internet 



Explore the Internet

To explore the Internet, click the Main Menu side button, click the Main Menu top tab, and then click the 
Internet button.

There are also a number of Internet-related Forum areas on CSi to help you learn about the Internet.

Want to learn more?
Internet-Related Forum Areas
Finding Internet Services 
Overview of the Internet 



Find Internet-Related Forum Areas

Here are some ways to find Internet-related Forum areas on CSi:

Click the Main Menu side button, click the Main Menu top tab, click the Internet button, and then 
click Internet Forums.

Choose Go from the Access menu and enter INTERNET.

Click the Find side button, click the Services top tab, and then click the Search button to set up a 
search on words such as INTERNET and WEB.    (Do not click the Start Internet Search button unless you
want to search for sites on the Internet rather than on CSi.) 

Want to learn more?
Internet-Related Forum Areas
Finding Internet Services 
Posting a Message



 Learn About Forum Messages Page Topics 



Map Message Topics

From time to time, while reading Forum messages, you might want to map the Message Topic.

A message map shows the relationships that a message has to other messages in the topic.    You can 
also display messages from a message map.

To map a Message Topic, click the Map button while reading a Forum message or while viewing a list of 
Message Topics.

Want to learn more?
Replying to a Message 
Searching for a Message



Post a Message

To post a message, simply create a message, and then send it to someone in the Forum area.

You can also simply reply to a Forum message.

When you post a Forum message that is not a reply to a Forum message, you actually start a new 
Message Topic!    (You might want to consult the existing Message Topics first to see whether you want to 
do this.) 

You can create a Forum message without being connected to CSi (offline).    At the Home Desktop, 
choose New Forum Message from the File menu.

Want to learn more?
Creating a Message 
Posting a Message
Replying to a Message



Find a Specific Message

There are many ways to find Forum messages.

You can click the Message Boards side button, and then click the Search top tab to set up a 
message search based on a keyword or date range. 

If you prefer not to set up a search, you can simply browse through hundreds of Forum messages
on your own, section by section.

If you can't seem to find the message you want, ask other CSi members!    Post a message in the 
Forum area, or send an informal question while in a Forum conference.

Want to learn more?
Browsing Forum Messages 
Posting a Message
Searching for a Message 
Searching for Items in the Filing Cabinet



View Only Today's Messages

To set up a search for today's messages, click the Message Boards side button, and then click the Search
top tab.    

(Specify using other search method in the Find messages box.    Then click the More button and set the 
date beside Submitted since to today’s date.)

Want to learn more?
Replying to a Message 
Searching for a Message



Reply to a Forum Message

You can send a reply to any Forum message, but only if the message is currently opened.

In the Read Forum Message window, click the Reply button to compose (and send) your reply.

Want to learn more?
Posting a Message 
Replying to a Message



Delete a Forum Message

You may delete a Forum area message only in two instances:

You created the message

The message is addressed to you

To delete such a Forum message, open the message, and then click the Delete button.

Want to learn more?
Browsing Forum Messages
Creating a Message 
Searching for a Message 



Leave a Forum Area

Click the Leave Forum side button to leave a Forum area.

Want to learn more?
Accessing a Service 
Reviewing Recent Destinations 
What is a Forum Area?



Send a Private Message

A private Forum message is visible only to those people to whom you send it.

To assign a private status to a message you want to send, click the Options button in the Create Forum 
Message window (while creating or reviewing your message), and then click the Private Forum Message 
option.

Want to learn more?
Creating a Message 
Posting a Message



Contact the Sysop

Every Forum area has a Forum manager, or sysop.    You can contact the sysop by sending him or her a 
private message.

To send a private message to the sysop, type *SYSOP in the Address box of the Create Forum Message 
window.

If you want other Forum members to see the message along with the sysop, type SYSOP (without the 
asterisk) in the Address box instead.

Want to learn more?
Posting a Message
Creating a Message



Read Waiting Messages

You can read your Waiting Messages (unread messages addressed specifically to you) easily in a Forum 
area.

If you are not at the Welcome page, click the Welcome side button. (You actually see the Welcome page 
each time you access the Forum Desktop.)

If you see a Read Waiting Messages button there, you have Waiting Messages.    (Click it to view your 
Waiting Messages.)

If you do not see a Read Waiting Messages button, you simply do not have any Waiting Messages.

Want to learn more?
Browsing Forum Messages
Replying to a Message 



Learn About Forum Libraries



Contribute (Upload) a File

To contribute (upload) a file from your computer to a Forum Library, click the File Libraries side button, 
click the Create top tab, and then click the New button.    (Click the file, and then click OK.) 

After providing the necessary information about the file, click the Send button (in the Contribute File 
Request window) to actually contribute the file.

Want to learn more?
Contributing a File
Retrieving a File from a Forum Area 
Understanding Naming Conventions 



View New Files

To set up a search for recently contributed files, click the File Libraries side button, and then click the 
Search top tab.    

Click the More button there to specify your desired submission date.    (Set it for a recent date.)

Want to learn more?
Retrieving a File from a Forum Area 
Reviewing a File 
Searching for a File



View a File

Forum files come in various formats that determine whether you can view them online.

You can view most graphics files.    You can also view compressed binary files.    Clicking the 
Open button associated with such files enables you to view them.

For other types of file formats, you must retrieve the file before you can view it.    Clicking the 
Retrieve button associated with such files enables you to retrieve them.

Want to learn more?
Learning About a File 
Searching for a File
Understanding File Types 



Understand File Concepts

There are several file formats that you might encounter while browsing the various File Libraries in a 
Forum area.    Here are just a few examples:

Text (TXT)

Graphics (GIF, JPG, PNG)

Binary (EXE)

Compressed binary (ZIP, SIT)

Want to learn more?
Browsing Forum Libraries
Retrieving a File from a Forum Area 
Understanding File Types 



Print a File

You cannot print binary files.    However, you can print text files and some graphics files.

To print a file, open the file, and then choose Print from the File menu.

If you are unable to print the file, it might be because your printer is not set up correctly.    (You can choose
the Print Setup command from the File menu to review or change your printer settings.)

Want to learn more?
Learning About a File 
Understanding File Types 



Retrieve (Download) a File

To retrieve a file from a list, such as while browsing a File Library, click the file, and then click the Retrieve
button shown there.

You can also retrieve a file that you have opened by clicking the Retrieve button in the opened file 
window.

If you click Retrieve Later, you are in effect marking the file (adding it to your To-Do List) so that it can be 
retrieved later in the session. 

Want to learn more?
Contributing a File 
Retrieving a File
Viewing a File 



Learn About a File

Every file in a Forum area has a brief Description associated with it.    If you are browsing a list of files you
can view a file Description by clicking the file, and then clicking the Description button shown there.

You can also learn about a file simply by examining the information displayed along with the listed file, 
such as its title, size, date submitted to the Forum area, and accesses (number of times the file has been 
retrieved).

You can sort the list by clicking the column headings.

Want to learn more?
Browsing Forum Libraries
Contributing a File 
Understanding File Types 



Find a File

There are many ways to find files in a Forum area.

You can click the File Libraries side button, and then click the Search top tab to set up a file 
search.

If you prefer not to conduct a search for files, you can simply browse through hundreds of Library 
files on your own, section by section.

If you can't seem to find the file you want, ask other CSi members!    Post a message in the 
Forum area, or send an informal question while in a Forum Conference.

Want to learn more?
Posting a Message 
Retrieving a File from a Forum Area 
Searching for a File



Learn About Forum Conferences



Attend a Moderated Conference

A moderated conference is a planned event featuring a guest speaker.    The moderator coordinates the 
conference and handles questions as appropriate.

To see what conferences are scheduled for a Forum area, click the Welcome side button, and then click 
the Announcements top tab.    From there you can learn conference schedules, as well as review other 
Conference announcements.

Want to learn more?
Attending a Moderated Conference
Voting in a Conference



Leave a Conference 

To leave a conference at any time, simply close the Chat window.

(There is no Leave button to leave a conference.) 

Want to learn more?
Participating in a Conference 
What is a Forum Area?



View List of Upcoming Conferences

You can review Forum Conference schedules at the Announcements page in a Forum area.    (To get 
there, click the Welcome side button, and then click the Announcements top tab.)

You can also learn schedule information for other Forum area conferences by visiting the Communicate 
area on CSi.    Choose Go from the Access menu and enter CONVENTION to get there.

Want to learn more?
Attending a Moderated Conference 
What is a Forum Area?



Record a Conference

You might want to make a transcript file of a conference for later use.    

To record a conference you are attending, simply click the Record Text button in the Chat window.    (The 
name and location of the transcript file will appear on the status line at the bottom of the window.)

The Record Text button will change (toggle) to a Stop Recording button, which you can click to conclude 
the recording process.

Want to learn more?
Logging a Public Chat
Participating in a Conference 
Setting Your Forum Area Preferences 



Attend a Moderated Conference

A moderated conference is a planned event featuring a guest speaker.    The moderator coordinates the 
conference and handles questions as appropriate.

To learn schedules of upcoming conferences for a Forum area, click the Welcome side button, and then 
click the Announcements top tab.    From there you can learn conference schedules, as well as review 
other Conference announcements.

Want to learn more?
Attending a Moderated Conference
Setting Your Forum Area Preferences 
Voting in a Conference



Participate in a Conversation

To view a list of Public Rooms in which you can participate, click the Forum Conference side button, and 
then click the Public Rooms top tab.    

To be able to participate in the ongoing conversation (chat) for a particular Public Room, simply click the 
room (from the list), and then click the Participate button.

Want to learn more?
Participating in a Public Chat
Setting Your Forum Area Preferences 



Use the Prohibited List

There may be times when you prefer not to view comments from a particular person.    

You can add such members to your Prohibited List for a temporary or permanent duration.    People in this
list will be blocked from all chats and group invitations, and their comments will not be displayed on your 
screen.

To add someone to your Prohibited List, choose Modify Prohibited List from the Forum menu.

Want to learn more?
Ignoring Invitations



Learn Who's Here

You can easily learn who is in a Forum area.    Click the Forum Conference side button, then click the 
Who's Here top tab.

The people currently in the Forum area will be listed along with their Member ID numbers, whether they 
are in a particular Conference room, and the location from which they are connecting to CSi.

Want to learn more?
Reviewing Your Profile
Setting Your Forum Area Preferences 



Start a Conversation

You can start a public conversation with someone in a Public Room easily.

Click the Forum Conference side button, and then click the Public Rooms top tab to view a list of available
Public Rooms.    (Click the Public Room you want to participate in, and then click Participate.)

Type a comment and then click the Send button (in the Chat window).

Want to learn more?
Attending a Moderated Conference 
Participating in a Conference
Voting in a Conference



Learn About Public Rooms



Learn Who is in the Chat Area

You can easily learn who is in the Chat area.    Click the Chat side button, and then click the Who's Here 
top tab.

The people currently in the Chat area will be listed along with their Member ID numbers, whether they are
in a particular Public Room, and the location from which they are connecting to CSi.

If you have set up a Friends list, you can have just those names listed.    (Mark the Show only Friends 
checkbox.)

Want to learn more?
Finding Out Who's Here
Listing All Available Public Rooms
Participating in a Public Chat
Creating a Friends List
Creating a Prohibited Users List



Record a Conversation

You might want to make a transcript file of a conversation (chat) for later use.    

To record a chat you are participating in, simply click the Record Text button in the lower left-hand corner 
of the Chat window.    (The name and location of the transcript file will appear next to the button.)

The Record Text button will change (toggle) to a Stop Recording button, which you can click to conclude 
the recording process.

Want to learn more?
Logging a Public Chat
Participating in a Private Chat
Observing a Chat without Contributing



Make Friends

Chat is an especially friendly area of CSi.    

You can make friends by joining a conversation (chat) that appeals to you and then introducing 
yourself.    (The more often you visit the Chat area, the sooner you'll be recognized as “one of the gang” 
in your favorite Chat rooms.)    

You can add your new friends to your personalized Friends List so that you can find them quickly 
each time you enter the Chat area. 

Want to learn more?
Creating a Friends List
Adding a Friend to your Friends List
Creating a Prohibited Users List
Ignoring Invitations



Respond to an Invitation

When you are in the Chat area, you may be invited to participate in a Group Chat or Private Chat.    

The invitation will be displayed in a window.    You accept or decline the invitation by clicking the Accept or 
Decline buttons.

Want to learn more?
Concluding a Group Chat
Ignoring Invitations
Selecting Members for a Group Chat



Prevent Invitations

Some days you might not want to be bothered by invitations to participate in Group Chats and Private 
Chats.

To prevent such invitations from appearing on your screen for the current Chat session, choose Ignore all
Invitations from the Chat menu.    

(The next time you visit a Chat area you will be set up to receive invitations again.)

Want to learn more?
Creating a Prohibited Users List
Editing a Prohibited Users List
Ignoring Invitations
Setting Chat Preferences



Just Observe an Ongoing Chat

You can observe an ongoing Chat without having to contribute (participate) anything to the conversation.

To view a list of available Public Rooms, click the Chat side button, and then click the Public Rooms top 
tab.    To just observe an ongoing Chat, click a room from the list, and then click the Observe button.

When you observe a Chat, nobody knows you are there.

Want to learn more?
Finding Who's Here
Setting Chat Preferences



Make Somebody be Quiet

There may be times when you prefer not to view comments from particular people.    

You can create a Prohibited Users List of such people’s nicknames.    People in this list will be blocked 
from all chats and group invites, and their comments will not be displayed on your screen.

To create or edit a Prohibited Users List, choose Modify Prohibited List from the Chat menu.

Want to learn more?
Creating a Prohibited Users List
Editing a Prohibited Users List
Ignoring Invitations
Setting Chat Preferences



Change a Nickname

You can change your nickname as many times as you like in Chat.

To do so, choose Change Nickname from the Chat menu.

If you do not want to have to create a nickname each time you visit Chat, you can request that a particular
nickname be used as your regular nickname.    The next time you type your nickname upon entering the 
Chat area, simply mark the Always use that nickname checkbox.

Want to learn more?
Nickname Rules
Setting Chat Preferences



Learn About Private Chats



Start a Private Chat

If you want to talk to someone without having anyone else hear (see) your conversation, start a private 
Chat.    

To send a private Chat invitation to someone, click the Chat side button, and then click the Who's Here 
top tab.    Once there, click a nickname from the list, and then click the Start Private Chat button.

The person receiving the invitation must agree to participate in a private chat with you before the private 
chat can actually begin.

Want to learn more?
Concluding a Private Chat
Participating in a Private Chat
Starting a Private Chat



Record a Private Chat

You might want to make a transcript file of a chat for later use.    

To record a chat you are participating in, simply click the Record Text button in the lower left-hand corner 
of the Chat window.    (The name and location of the transcript file will appear next to the button.)

The Record Text button will change (toggle) to a Stop Recording button, which you can click to conclude 
the recording process.

Want to learn more?
Creating a Friends List
Finding Who's Here
Setting Chat Preferences



Conduct Simultaneous Chats

You can conduct as many private Chats as you like at the same time.

The nicknames of your current private Chat participants are listed in your Private Chat window.    You click
on a nickname from the list to display that particular conversation (chat).

(Click the Goodbye button to end a private chat.)    

Want to learn more?
Finding Out Who's Here
Participating in a Private Chat
Setting up a Private Chat



Learn About Group Chats



Make a Comment

You make a comment in a Group Chat just as you would in a Public Room.

Type your comment in the box beside the Send button.    Then click the Send button.

Want to learn more?
Finding Out Who's Here
Joining a Group Chat
Logging a Group Chat



Form a Group

You can participate in a Group Chat if you want to converse (chat) with several people privately.

If you are currently in a Public Room, click the Who's Here button in the upper left-hand corner of the 
Chat window to view a list of all people in the room.    For each person you want to include in your Group 
Chat, click his or her nickname, and then click the Group Invitations button.

If you are not in a Public Room room, you can still set up a Group Chat.    Click the Chat side button, and 
then click the Who's Here top tab to view a list of people currently in the Chat area that you can send a 
Group Invitation to.

Want to learn more?
Concluding a Group Chat
Selecting Members for a Group Chat
Setting up a Group Chat



Make a Comment

You make a comment in a Group Chat just as you would in a Public Room.

Type your comment in the box beside the Send button.    Then click the Send button.

Want to learn more?
Concluding a Group Chat
Selecting Members for a Group Chat



Prohibit Chat Invitations

You might find invitations to participate in private or group chats bothersome or distracting, no matter how 
well-intentioned.

You can modify your Chat preferences so that such invitations will not be displayed on your screen.

You can alternatively prevent invitations from appearing on your screen for just the current chat session 
by choosing Ignore all Invitations from the Chat menu.    (The next time you visit a Chat area you will be 
set up to receive invitations again.)

Want to learn more?
Ignoring Invitations
Setting Chat Preferences



Add to Your Friends List

You can make a Friends list of your favorite Chat acquaintances.

To review your Friends List, click the Chat side button, and then click the Friends top tab. 

To add someone to your Friends List, click the New button there.

Only CSi members currently in the Chat area can be added to your Friends List.

Want to learn more?
Creating a Friends List
Adding a Friend to your Friends List
Creating a Prohibited Users List
Editing a Prohibited Users List



Learn About Public Folders



Sort News Articles

When viewing a list of news articles, you might want to sort them in a particular order.

You can sort such lists by clicking the column headings.    The column headings are acutally buttons.

For example, if you click a column heading labeled Date, the list will be redisplayed via oldest to newest 
date.    (You can click the column heading again to sort the list to its original order.)

Want to learn more?
Printing a News Article 
Retrieving an Entire Folder



Save News Articles

To save a news article that you are reading, simply click the File It button shown in the article window.

You can also save a news article that appears in a list without having to open (read) the article.    Click the
listed article, and then click the associated File It button.

Want to learn more?
Reading a News Article 
Saving a News Article 



Search for Articles

To set up a search for specific news articles, click the Articles side button, and then click the Search top 
tab.    

In some news services, such as the Executive News Service, you can create a Personal Folder to search 
for and collect (clip) future articles that match your preferred search interests.    

(To do so, click the Articles side button, and then click the Create Folders top tab.)

Want to learn more?
Reading a News Article 
Saving a News Article 
Searching for Items in the Filing Cabinet



Browse Recent Articles

In some news services, articles are automatically listed in folders that you can browse.    (Click the Articles
side button, and then click the Read page.)    

In other news services, you must set up a search to view a list of recent articles.    (Click the Articles side 
button, and then click the Search page.)

Articles are listed by release date.    The release date, as well as the source (newswire), is displayed 
along with the article's title.

Want to learn more?
Reading a News Article 
Saving a News Article 
Opening a Folder



Delete a Folder

Depending on the news service you are in, you might have access to one or more Public and Personal 
Folders.

You can never delete a Public Folder.    Such folders are created by the particular news service that you 
are using.    You can, however, delete a Personal Folder (because you created it).    

To delete a Personal Folder, click the Articles side button, click the Create Folders top tab, click the 
Personal Folder you want to delete, and then click the Delete button.

Want to learn more?
Clearing a Folder 
Opening a Folder 
Searching for a News Article



Read the Next Article

If you are reading an article at the News Desktop and want to read the next article in the folder, you can 
do so without closing the article window.

To display the next article, simply click the button that looks like: .    

(Unless that button is dimmed, clicking it will display the next article in the folder.)

You can similarly display the previous article by clicking the button that looks like: .

Want to learn more?
Printing a News Article 
Saving a News Article 
Searching for a News Article



Learn About Personal Folders



Change a Folder

If you are in the Executive News Service and have one or more Personal Folders, you might want to 
change them (from time to time) so that they better reflect your ongoing search interests.

To change a Personal Folder, click the Articles side button, and then click the Create Folders top tab.    
(Click the folder to be changed from the list, and then click the Change button.)

Want to learn more?
Deleting a Folder 
Opening a Folder 



Go to Executive News Service

The Executive News Service is a news clipping service that collects news articles according to your 
preferred search interests.

To go to the Executive News Service, choose Go from the Access menu, and then enter ENS.

Want to learn more?
Deleting a Folder 
Opening a Folder 



Make a Personal Folder

The Executive News Service enables you to create up to three Personal Folders that will collect (clip) 
news articles that meet your preferred search guidelines.

To create a Personal folder, click the Articles side button, click the Create Folders top tab and then click 
the New button.

Want to learn more?
Deleting a Folder 
Opening a Folder 



Delete a Personal Folder

If you are using the Executive News Service and want to delete one or more of your Personal Folders, 
you can do so at the Create Folders page.

Click the Articles side button, and then click the Create Folders top tab to get there.    (Click a folder that 
you want to delete, and then click the Delete button.)

You can delete only folders that you create (Personal Folders).

Want to learn more?
Deleting a Folder 
Opening a Folder 



Retrieve an Entire Folder

If you are using the Executive News Service and want to retrieve all articles from a Personal Folder, 
simply retrieve the entire folder.

Click the Articles side button, click the Read top tab, click the Personal Folder you want to retrieve, and 
then click the File It button.

Want to learn more?
Modifying a Folder
Retrieving an Entire Folder



Delete Only Some Articles

If you are using the Executive News Service, you can delete selected news articles from one or more of 
your Personal Folders rather than delete the entire Personal Folder.

If you are reading a news article in a Public Folder, you can delete it by clicking the Delete button 
in the article window.

You can also delete a news article that appears in a list (in an opened Personal Folder) without 
having to read the article.    (Click the listed article, and then click the Delete button associated with the 
list.)

Want to learn more?
Deleting from a Folder
Printing a News Article 
Saving a News Article 



Learn About Conference Center



Learn Conference Schedules

To learn schedules for conferences in the Conference Center or the Customer Service Live area, go to 
the Chat:Conferences area.    

(Choose Go from the Access menu, and then type CONVENTION.)

Once at the Chat:Conferences area, to learn conference schedules, choose Conference Calendar.

Want to learn more?
Attending a Moderated Conference
Participating in a Conference 
Voting in a Conference



Attend a Moderated Conference

A moderated conference is a planned event featuring a guest speaker.    The moderator controls the 
conference and handles questions as appropriate.

To learn schedules of upcoming conferences for a Forum area, click the Welcome side button, and then 
click the Announcements top tab.    From there you can learn conference schedules, as well as review 
other Conference announcements.

Want to learn more?
Attending a Moderated Conference
Setting Your Forum Area Preferences
Voting in a Conference



Leave a Conference

To leave a conference at any time, simply close the Chat window.    (There is no Leave button to leave a 
conference.)

Want to learn more?
Participating in a Conference 
What is a Forum Area?



View List of Upcoming Conferences

You can review Forum conference schedules at the Announcements page in a Forum area.    (To get 
there, click the Welcome side button, and then click the Announcements top tab.)

You can also learn schedule information for other Forum area conferences by visiting the Communicate 
area on CompuServe.    To get there, choose Go from the Access menu and the enter CONVENTION.

Want to learn more?
Attending a Moderated Conference
What is a Forum Area?



Record a Conference

You might want to make a transcript file of a conference for later use.    

To record a conference you are attending, simply click the Record Text button in the Chat window.    (The 
name and location of the transcript file will appear on the status line at the bottom of the Chat window.)

The Record Text button will change (toggle) to a Stop Recording button, which you can click to conclude 
the recording process.

Want to learn more?
Attending a Moderated Conference
Participating in a Conference 
Voting in a Conference



Change a Nickname

You can change your nickname as many times as you like in Chat.

To do so, choose Change Nickname from the Chat menu.

If you do not want to have to create a nickname each time you visit Chat, you can request that a particular
nickname be used as your regular nickname.    The next time you type your nickname as you enter the 
Chat area, simply mark the Always use that nicknmae checkbox.

Want to learn more?
Nickname Rules 
Setting Chat Preferences



Participate in a Conversation

To view a list of public rooms in which you can participate, click the Forum conference side button, and 
the click the Public Rooms top tab.

To be able to participate in the ongoing conversation (chat) in a particular public room, simply click the 
room (from the list), and then click the Participate button.

Want to learn more?
Participating in a Public Chat 
Setting Your Forum Area Preferences



Use the Prohibited List

There may be times when you prefer not to view comments from a particular person.    

You can add such members to your Prohibited List for a temporary or permanent duration.    People in this
list will be blocked from all chats and group invitations, and their comments will not be displayed on your 
screen.

To add someone to your Prohibited List, choose Modify Prohibited List from the Conference menu.

Want to learn more?
Creating a Prohibited Users List
Editing a Prohibited Users List
Ignoring Invitations



Learn Who is in the Conference Center

You can easily learn who is in the Conference Center.    Click the Forum Conference side button, then 
click the Who's Here top tab.

The people currently in the Conference Center will be listed along with their Member ID numbers, whether
they are in a particular Conference room, and the location from which they are connecting to CSi.

Want to learn more?
Attending a Moderated Conference
Finding Out Who's Here
Participating in a Conference 
Voting in a Conference



Start a Conversation

You can easily start a conversation with someone in a public room.

Click the Forum Conference side button, and the click the Public Rooms top tab to view a list of available 
public rooms.    Click the public room that you want to participate in, and then click Participate.

In the Chat window, you converse by typing a comment and then clicking the Send button

Want to learn more?
Attending a Moderated Conference
Participating in a Conference 
Voting in a Conference



Submit a Question

You can submit a question at any time during a moderated conference.

In your Moderated Chat window, click the Ask button, type your question, and then click the Submit button
shown there.

Want to learn more?
Attending a Moderated Conference
Participating in a Conference 
Voting in a Conference



Change a Question

Once you have submitted a question in a moderated conference, you might want to change and resubmit 
it.

In your Moderated Chat window, click the Ask button, edit your question, and then click the Resubmit 
button shown there.

Want to learn more?
Attending a Moderated Conference
Participating in a Conference 
Voting in a Conference



Withdraw a Question

Once you have submitted a question in a moderated conference, you might want to withdraw it.

In your Moderated Chat window, click the Ask button, and then click the Withdraw button shown there.

Want to learn more?
Attending a Moderated Conference
Participating in a Conference 
Voting in a Conference



View Voting Results

To view the current results of a vote, click the Tally button in the Moderated Chat window.

Each time you click the Tally button, the voting results will be updated if new ballots have been cast.

Upon completion of the vote, the conference moderator will post the voting results for all to see.

Want to learn more?
Attending a Moderated Conference
Participating in a Conference 
Voting in a Conference



Vote in a Conference

Sometimes in a conference you will be given the opportunity to vote on particular issues.

If so, a special Vote window will appear on your screen.

Mark the appropriate ballot information, and then click the Cast Vote button shown there.

Want to learn more?
Attending a Moderated Conference
Participating in a Conference 
Voting in a Conference




